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The EnterpriseIQ Quoting module is a powerful tool used to fine tune estimated costs and profit margins. 
The quote structure is similar to creating a Bill of Manufacture (BOM), but allows the user to run 
unlimited “what if” scenarios without affecting the manufacturing side. An approved quote can be 
quickly converted to a BOM. 

The EnterpriseIQ Quoting module can help the user create a bid on a new project (RFQ-Request for 
Quote) or examine costs and profit margins on existing BOMs. 

Before You Begin 

Prior to entry of quotes, it is recommended that the user enter the following information: 

▪ Customer Data 

▪ Raw Materials 

▪ Inserts 

▪ Packaging 

▪ Quote Parameters 

▪ System Configuration Options—Equipment/Work Centers and Labor Rates. 

All of the information shown above can be accessed from the Quote module if the user needs to create 
an entry on the fly. 

There are three steps to building a quote: 

1 General Information - Supplying the general information such as RFQ number, description, customer, 
cycle and setup time, and raw materials. 

2 Item Information - Providing details on the item to be produced and the components and/or 
packaging items to be consumed. 

3 Calculation - Calculating the quote pricing and cost information and providing a Quote Letter. 

NOTE: The user is not required to enter a quote for all BOMs. Functions within EnterpriseIQ will calculate 
the standard costs for manufactured items. Refer to the Inventory section for more details. 
 

Quoting 
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Quotation Parameters 

Before entering a quote, basic configuration information must be entered into the system. The system 
requires general quote parameters (i.e. margin display and gross margin calculation), default value and 
quantities, and markup tables. 

Note: This section should be completed BEFORE creating a quote. 

From within the Quote module: 

➢ Select Miscellaneous->|Rates and Parameters from the main menu bar. The following screen will 

appear. 
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Quote Parameters - General Tab  

General Parameters define several default calculations, as explained below: 

Margin Display 

Gross Profit 
Margin % 

((Total Revenue – Total Cost) / Total Revenue) * 100 

Example: 
Revenue = 300.00   
Total Cost  = 240.00  

((300.00 - 240.00) / 300.00) * 100 = 20% 

Markup % ((Total Revenue – Total Cost) / Total Cost) * 100 

Example: 
Total Revenue = 300.00 
Total Cost = 240.00 

((300.00 - 240.00) / 240.00) * 100 =  25% 

 

Mark-up By 

Percentage The Percentage function takes a certain percentage of the cost, and Adds that value back to 
the original. 

Example: 
Item cost is $1.00 with a 25% percentage markup calculates to $1.25 (1.00 x .25) + 1.00 = 
1.25. 

Points The Points function increases the total cost by the percentage used. This is accomplished by 
dividing the cost by one minus the percentage. 

Example: 
Item cost is $1.00 with a 25% Points markup calculates to $1.3333 (1.00 / .75 = 1.3333). 

 

Commission Calculation 

Price + Commissions can be calculated using the formula 

Price + (price x commission) 

Price/ Commissions can be calculated using this formula: 

Price/(1-commission) 
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Overhead Calculation (family configurations) 

The overhead calculation for quotes for family tools can be changed to one of the following options. The 
default method is based on unique item numbers. 

Based on unique 
item numbers 

This option takes overhead cost and divides by the number of unique items being 
quoted and then takes that number divided by the number of cavities for a specific item. 

For example: 

The quote has two unique items, one with 2 cavities and one with one cavity. 

The total overhead cost = 97.50  

O.H. Cost for the 2 Cavity item = (97.50/2)/2 = 24.38 

O.H. Cost for the 1 Cavity item = (97.50/2)/1 = 48.75 

Based on total 
number of 
cavities  

This option adds all of the cavities together and divides the total overhead by the total 
cavities. 

For example: 

The quote has two unique items, one with 2 cavities and one with one cavity. 

The total overhead cost = 97.50  

O.H. Cost for both items = (97.50/3) = 32.50 

 

Attached Components Scrap Calculation 

This controls how the scrap on components is calculated. There are two options. 

Based on 
(1+Scrap) 

This is the default method.  

Based on (1/1-
Scrap) 

This is the same method that is used in the costing module. 
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Use Master Inventory Std Cost for Component Pricing instead of Price Breaks 

When this option is checked the system will use the standard cost for components rather than the price 
breaks. The materials forms will change to show the standard costs rather than the price breaks. With 
this option checked when converting from a BOM to a Quote, the system will not create a new quote 
inventory record (QINVT) if the quote inventory item already exists. 

Use Scrap % by Quantity Breaks 

If this parameter is checked, a column is added to the 'Rates and Quantities' tab->'Standard Quote 
Quantities' section for 'Scrap %'. Each quantity can have a different scrap percent. On the 'Calculations' 
tab the Scrap % column is added in the quantities grid displaying the scrap percent from 'Standard Quote 
Quantities'. This field can be edited. A Scrap % row is also added to the calculations grid for displaying 
the scrap percent associated to the quote quantity. The quantity scrap rates function the same as the 
scrap percent entered on the General Quote Values tab if this option is not selected. Note: When 
changing this parameter setting users have to leave and come back to the quote to reflect the change. 

Workflow Approval 

Workflow Approval - Check this option to utilize the workflow functionality in the quoting module. When 
this is checked the workflow functionality will become available on the Engineering Quote->General 
Quote Values tab. See Engineering Quote Workflow for details. 

Workflow Mandatory - Workflow Approval can also be marked mandatory by checking the 'Workflow 
Mandatory' box. This will require users to create a workflow for all quotes. Note: If the Workflow 
Approval check box is not checked and the user checks this box, the system will automatically check the 
Workflow Approval box. 
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Default Values in Quotation Parameters 

 

Default Values 

Operator Labor 
Rate 

The default operator rate that will be used for all quotes. Can be overridden for individual 
quotes using different employee levels. 

Quote Valid For The number of days that the quote will be valid for. 
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UOM The unit of measure that the part weights will be calculated in. Select from the arrow down list. 
The options are: GR, LBS, OZ, FT, IN, M, KM, YD, KG, and CM.  

The UOM will be converted to the nearest Imperial/Metric version of the UOM depending on 
the setting in System Parameters->Regional tab or EPlant Parameters (Enterprise-
>Miscellaneous tab) for Imperial or Metric UOM.  

 

Note: The system also uses this for new BOMs. 

Follow-Up 
Interval 

The number of days from the Date Out field to follow up on the quote. Once the Date Out field 
is populated on the quote the Follow-Up Date will fill in based on the number of days entered 
in this field from the Date Out date. For example, if the follow-up interval is 10 days, and the 
date out is 6/9/08 the Follow-Up date will populate with 6/19/08.  

Efficiency 
Factor 

The efficiency factor accounts for time that the machine operates. It affects the assumed 
production time (Net Cycles/hr) and therefore the overhead cost for the produced item. An 
efficiency factor of 100% assumes that the machine will run 60 minutes per hour and an 
efficiency factor of 90% assumes the machine will run 54 minutes per hour. 

Exclude 
Efficiency 
Factor from 
Cost Calc 

If this is checked the system will exclude the efficiency factor when calculating overhead costs. 
The system will use an efficiency factor of 100 rather than the Quotes efficiency factor.  

Material Markup 
Not Compound 

Controls whether a manufactured sub-component is marked up again when it is used as a 
component in a higher level BOM. If checked, the lower level manufactured materials that 
make up the subassembly will NOT be marked up again. 
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Check Available 
Regrind% 

If this is selected, when the program calculates the lbs/K, the calculation checks to see available 
regrind (Runner Weight / Shot Weight) * 100) and will give a warning if the allowable regrind 
entered exceeds the calculated available regrind. The warning will display the maximum 
available regrind percent and ask if the user would like to Replace the regrind value or Ignore it. 
The pop up form also has a check box. ‘Continue checking available RG %..’, if Replace is 
selected the user can un-select this option and the system will no longer check for available 
regrind. If ignore is selected, the system also ignores any changes made to this check box. 

 

This setting is global for all new quotes. It can be overridden on the Current RFQ# tab in Rates 
and Parameters (see below). 

Refresh Sub-
Components 
Price/Break 

With this option selected the system will refresh the price breaks on manufactured sub 
components before calculating a quote. 

Quote Due Date 
is Mandatory 

Select this option to force the user to enter a quote due date. 

Calculate All 
Levels 

Check this option to calculate the costs for each item associated to the 'top' level item with one 
click. For example, Item C consumes Item B, which consumes Item A. With this option checked 
when calculating the quote for Item C, the system will automatically calculate Item B and A. If 
this is not checked in order to get the correct cost for Item C you must open the quote for Item 
A and calculate, then open the quote for Item B and calculate, then open the quote for C and 
calculate.  

This value can be overridden on the Calculation tab for an individual quote. 

Note: The automatic calculations will only affect the actual items that are part of the current 
"tree" and not other quotes they may be attached to. 

Note: In order for this to work,  'Refresh Subcomponent Price Breaks' must be checked on the 
Default Values tab of Quote Parameters, and 'Use Master Inventory Std Cost for Component 
Pricing Instead of Price Breaks' must be unchecked on the General tab of Quote Parameters. 
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Rates and Quantities in Quotation Parameters 

 

Direct Labor Rates 

Schedule of labor rates for operations. This list is visible in the drop down list when adding labor costs to 
an RMA or when toggling an item from Non-Conform to conforming. 

Default Standard Quote Quantities 

An unlimited number of quote quantities may be entered and the system will calculate price and cost 
information for each of the quantities entered. These are defaults which can be changed at the 
individual quote level. 

If the 'Use Scrap % by Quantity Breaks' parameter is checked in the Miscellaneous menu->Rate and 
Parameters, a column is added to the 'Rates and Quantities' tab in the 'Standard Quote Quantities' 
section for 'Scrap %'. Each quantity can have a different scrap percent. Enter the scrap percent in the 
Scrap % field for each quote quantity if desired. 

On the Calculations tab a Scrap % column is added in the quantities grid displaying the scrap percent 
from Standard Quote Quantities. These values can be edited. A Scrap % row is added to the calculations 
grid for displaying the scrap percent associated to the quote quantity. The quantity scrap rates function 
the same as the scrap percent entered on the General Quote Values tab if this option is not selected. 

The user can Add, Delete, post, cancel, or refresh changes made by selecting these functions from the 
Navigator bar. 
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Markup Tables 

EnterpriseIQ allows productions costs and material costs to be marked up separately using the 
Production markup and Material markup defaults. 

To set up the default Production and Material markup tables: 

➢ Select the “Markup Tables” tab from within the General Quote Parameters screen. The 

following screen will appear: 
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EnterpriseIQ will use the default values when initially calculating a quote. However, these values may be 
modified once a quote has been calculated. 

Production Markup Table 

Production mark-up rates are based on Production Hours per Quote Quantity. The system matches the 
generated production hours (based on cycle time, set up, etc.) with the Hours column in this table, and 
finds the corresponding markup rate. If the calculated production hours fall between two hour entries, it 
will take the rate for the lowest of the two values. For example, a job that will run 7 hours will be marked 
up 30% using the above schedule. 

Note: The Production markup table shown above is a sample only and should not be assumed to be 
accurate or valid for your environment. 

➢ Adding Hourly Values 

The user may enter an unlimited number of Production markup values. 

To 'Add' an hourly value: 

➢ Click on the Add [+] key from the Navigator Bar under the Production Markup Table. This 

will create a new entry line. 

➢ Enter in the number of Hours and the Rate %. 

➢ Press the Add [+] key or use the arrow down key to Add Additional entries. 

➢ Select [Save] on the Navigator bar. 

To Edit the Production Markup table, highlight the field to be changed and enter the new value. 

To Delete entries, click on the line to be removed and press the Delete [-] key on the Navigator bar. A 
confirmation box will appear asking to confirm the action. 

Material Mark-up Table 

Material markups are based on Material Costs per Quote Quantity. Like production hours, the Dollars 
column is calculated based on the total material costs to run the individual Quote Quantity. The 
calculation is therefore based on the total dollar volume being processed, NOT the number of pounds 
being processed. If the calculated material value falls between two entries, it will take the rate for the 
lower of the two values. 

The total dollar volume includes costs for all raw materials, including plastics, additives, inserts, and 
packaging attached to the item. 

➢ Adding Dollar Values - The user may enter an unlimited number of dollar values. 

To Add a new value: 

➢ Click on the Add [+] key on the Navigator Bar (under the Material Markup Table.) This will 

create a new entry line. 
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➢ Enter in the Dollars and the Rate %. 

➢ Press the Add [+] key or use the arrow down key to Add Additional entries. 

➢ Select [Save] on the Navigator bar. 

To Edit the Material Markup table, highlight the field to be changed and enter the new value. 

To Delete entries, click on the line to be removed and press the Delete [-] key on the Navigator bar. A 
confirmation box will appear asking to confirm the action. 
 

Current RFQ# 

This tab shows the current quote number and has a quote specific check box to check the available 
regrind percent in LBS/K calculation. The default to check available regrind is on the General Parameters 
tab but the user can specify something other than the default for each individual quote. 

 

To return to the main Quote entry screen, click on [Close]. For Additional information on the Markup 
table functions, please see Calculation Parameters. 
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Extra Charges in Quotation Parameters 

This tab allows the user to enter a list of extra charges. The user can then select from this pick list when 
adding extra charges to a quote rather than having to manually entering them each time.  For more 
information on Extra Charges please see the Extra Charges and Commissions section below. 
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Creating Quotes - General Quote Values 

Manufacturing quotes are used to quote individual items or multiple items made from the same tool 
(family tools). Before entering a new quote, the basic configuration information covered above must be 
entered into the system. If re-quoting an item, follow the first two steps below and Edit the quote from 
there. 

Multi-Level Quoting 

A quote will need to be created for each step in the process required for manufacturing the final 
product. For example, a part may first be injected molded (Injection Quote) then sonic welded (Generic 
Quote), and may be sent out for outside processing (Outsource Quote) then come back in for additional 
assembly (Generic Quote). Just as in creating BOM’s, a quote will need to be created for each of those 
steps. 

To create a quote for an item that moves through multiple processes the user can start by creating the 
quote for the first step then create a quote for the second step attaching the item created in the first, 
and so on. Or the quoting process can be started at the top level (final step) and the user can work their 
way down. Attached components can be marked ‘RFQ Required’ which creates a place holder for the 
item. See Creating a Quote from the Top Level down for more information. 

Creating a New Quote 

To create a NEW quote: 

➢ From the EIQ Launcher Bar, select the Estimating Tab and click on the 'Quoting' button. The 
Select from RFQ pick list will appear. 

➢ To create a new quote, click on the ‘New’ button located in the bottom right corner of the 
pick list. A new quote can also be created by selecting an existing quote from the pick list 
and selecting either the Add [+] key, or Quote|New from the main menu bar. 

Note: The information and examples in the following pages are based on creating an Injection Molding 
quote. The Injection quote is used as it illustrates the basic steps for most types of quotes, such as Blow 
Molding and Rotational molding. For information on other MFG Types such as Generic (Generic 
Manufacturing Type Quotes), Extrusion (Extrusion Manufacturing Type Quotes), and Thermoform 
(Thermoform and TFORM2 Manufacturing Type Quotes), and Outsource (Outsource Manufacturing Type 
Quotes), see those sections below. For ASSY MFG Types please refer to the Assembly Manufacturing 
help file. 

EnterpriseIQ supports multiple manufacturing definitions, such as Injection, Extrusion, Generic, Blow 
Molding, Outsourcing, as well as user defined manufacturing types. Each definition contains unique 
elements that complement the manufacturing method. For example, the Injection type supports the 
concept of cycle times, regrind and includes a direct attachment of a material specification that is 
consumed during production. The Extrusion definition handles continuous manufacturing processes, 
while Generic types are used to perform manufacturing processes other than molding. 
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➢ Select a Manufacturing Type from the Selection Criteria box and click on 'OK'. The General 

Quote Values entry screen will appear. This screen contains the general information required 
when creating a quote. All fields will be blank except for the defaults specified under Rates 
and Parameters (i.e. UOM, Date, Expires, Efficiency Factor, and Operator Labor Rate) as 

shown in the screen below. 
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Note: If the quote you are viewing was received from Marketplace, the quote screen will display a blue 
banner at the top of the screen: "This quote was received from Dassault Systemes Marketplace." 

Below lists the field description for the General Quote form: 

ID ID is the system generated ID number for this quote and cannot be changed. This field is also 
included in the pick list. 

RFQ # (required) The RFQ # is the quote tracking number for this quote. The combination of RFQ # and Revision 
must be unique or an error message will appear 

NOTE: RFQ numbers can be set to increment automatically each time a quote is entered. This 
feature is located in System Setup/System Parameters/Sequential Numbering. If the enable 
check box is marked with a black check mark, the system will automatically increment the RFQ 
numbers 

Rev This field is used to enter the Quote revision number (defaults to 1). This field is used to keep 
track of how many times the quote has been changed. The revision is user defined so it does not 
update automatically after each calculation. 

A quote can be cloned as a new revision, using the Clone option from the File menu. 

Description This field is used to enter a description of what is being manufactured in this Quote. 

Customer Select from the drop down list or select the pick list button next to this field to select a Customer 
to associate to the quote. This pick list is comprised of existing customers, if you want to include 
CRM ‘prospect’ customers also, check the ‘Do Not Filter Out CRM Customers’ under the Options 
menu. 

Note: If this option is not checked a quote for a prospect will appear in the pick list but 
cannot be opened. 

Contact Select the ellipsis button to access the pick list of contacts associated to the customer. Select the 
contact to be assigned to the quote from the pick list. 
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If the customer is not in the pick list, create the customer by selecting ‘New’. The new customer will be 
added to the existing pick list of customers in the AR section with a status of quote. Selecting New will 
bring up the following screen: 
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➢ Assign a unique customer number and complete the remaining information. Note: The State 

drop down list will only appear for selected countries where States apply, such as the United 
States and Canada. 

Note: The Quick Add function does not provide the ability to enter all customer information. Remaining 
information is entered in the Customer Maintenance screen under Accounts Receivable or System Setup. 

➢ Press 'OK' to return to the General Quote Values screen. 

Quote Date The date field fills in automatically with the date the quote was created. This can be 
changed by choosing a different date from the drop down calendar. 

Select the + button next to the field to expand the view to show the additional date fields: 

▪ Expires - This is the date that the quote will expire. The expiration date is calculated from 
the date the quote is generated and the ‘Quote Valid For’ in General Quote Parameters. 

▪ Due Date - This is the date the quote is due to the customer. This is entered manually using 
the drop down calendar from the RFQ module or the RFQ Log. 

▪ Date Out - This is the date the quote was sent out. This is entered manually using the drop 
down calendar from the RFQ module or the RFQ Log. 

▪ Follow Up Date - If a 'Follow-Up Interval' is entered in rates and parameters, this date will 
populate once the Date Out has been entered. Or it can be manually entered using the 
drop down calendar from the RFQ module or the RFQ Log. 

▪ Won Date - The date the quote was won. 

▪ Pricing Effective Date - If a date is populated in this field, when converting the quote to a 
BOM the system will populate the FG Inventory and AKA Inventory price breaks with the 
Effective date.  It will also use the Quote's Effective Date to populate the Inactive Date for 
any current price breaks with the same Quantity as the Quotes Price Break Quantities. 

Created By The Created By field is populated with the login name of the person who created the quote. 

Select the + button next to the field to expand the view to show the Sales Engineer field. 

Enter the 'Sales Engineer' by clicking on the button in the field and choosing ‘Assign to me’ 
or ‘Select User’. The Assign to me option will populate this field with the Login Name of the 
user who is logged in. To choose a different person select an employee from the pick list. 
(The available user list is made up of employees that have the employee name associated to 
the user name in security inspector). 

Type Select the + button to expand the Type field to display Tool Type and Part Type. Select from 
the drop down list next to each field and select the appropriate type: 

▪ New 

▪ Existing 

▪ Requote 

These fields can also be entered from the RFQ Log module. 
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Status Select the + button to expand the Status field to display Tool, Component, Packaging, and 
Primary Material Status fields. Select from the drop down list next to each field and select 
the appropriate status: 

▪ OK 

▪ Purchasing 

▪ Estimating 

▪ Sales - For Component, Packaging, and Primary Material Status’ 

▪ Engineering - For Tool Status 

These fields can also be entered from the RFQ Log module. 

Quote Status The status of the quote in regards to acceptance by the customer. Select the quote status 
from the drop down list: 

▪ Pending 

▪ Won 

▪ Lost 

This field can also be entered from the RFQ Log module. 

User Quote Status This is an additional user defined status field. Right click on the field and select 'Define Label 
Text' to change the label. This field also has a user definable drop down list accessed by 
right clicking on the blue drop down arrow and selecting 'Edit User Defined List'.  This field 
is also visible in the RFQ Log. 

Currency If Multi-currency is enabled the currency field will be present. This will automatically 
populate with the currency associated to the customer. Click on the arrow down button to 
select a different currency. This is informational only, as the currency on a quote is always in 
the native currency associated to the EPlant or the native in System Parameters for non-
EPlant users.. 

UOM This is the unit of measure associated to the part weight and runner/sprue. 

Calculated On This is the last date the quote pricing was calculated. This will fill in automatically when the 
quote pricing is first calculated and updated if the quote is recalculated. 

RFQ Control # The control # records the user name, date and time that the quote was last revised. This will 
fill in automatically when the quote is saved. 

Note: The format of the Control # can be set in System Parameters->Company File 
Information->Application tab. If this field is blank it will default to MM-DD-RRRR-
HH24:MI:SS (e.g. Username 03-16-2010-16:56:35). The user name is always the prefix. 

The format must start with a dash (-). But the order of the 'RRRR', 'MM', 'DD', HH24, MI or 
SS can be changed. 

Converted This field displays the number of times the quote has been converted to a BOM. Click on the 
ellipsis button to view the list of BOM’s it has been converted to. The user can jump to the 
actual BOM from this list. 

EPlant This will show which plant the quote is being created in. This will only be filled in if EPlant is 
being used.  
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CRM Opportunity # A CRM Opportunity record can be linked to a quote. Select the ellipsis button in this field 
and select Link CRM Opportunity. A pick list of existing opportunities will display. Choose 
the desired record from the list. Once a CRM Opportunity is linked the user can select Jump 
To CRM Opportunity to view the record. Select Clear CRM Opportunity to remove the link to 
the quote. 

Workflow If the Workflow Approval' parameter is checked these fields will be visible on the General 
Quote tab: 

▪ Quote Type - When using the Quote workflow functionality users will select the Quote Type 
from the pick list accessed by clicking the ellipsis button. Once a Quote Type is selected a 
workflow is created automatically with the template associated to the Quote Type. If the 
'Workflow Mandatory' parameter is checked users are required to select a Quote Type. If 
the user attempts to save a quote without selecting a Quote Type an error will display 
stating, "The quote type is required". If the user selected a Quote Type that does not have a 
template assigned, a message will display stating, "No workflow exists for the quote type. 
Select YES to create a template; NO to cancel your changes". When YES is selected the 
workflow template pick list will appear. Select New to create a new template to associate 
to the Quote Type (refer to the Engineering Quote Workflow topic for details). If NO is 
selected the user will be returned to the quote for editing. 

▪ Workflow # - This field displays the Workflow number. Click the ellipsis button and select 
'Jump to Workflow' to access the associated workflow. 

▪ Status - This field displays the status of the Workflow. This can be Inactive (not started), 
Pending (in process), Not Approved, (rejected), Approved (workflow is complete). 

See the Engineering Quote Workflow section for more details. 

Note This Note field allows for 4,000 characters. To enter text select the button next to the field 
to bring up the Note form. This field can be used for additional information on the screen or 
added to a report. 

Text can also be entered from a boiler plate. Right click in the Note field, the following 
options will be available: 

▪ Load Boiler Plate: Allows you to select a message from an existing boiler plate. 

▪ View/Edit Boiler Plate: Allows the user to view and or edit existing boiler plates. 

▪ Save as Boiler Plate: Allows the user to type a new comment and save it as a boiler plate for 
future use 

The table and field are Quote.Note1. This field will print on the RFQ report and can be added 
to other reports. 

This note field is also visible from the RFQ Log and can be edited from there as well. 

Additional Note This is an additional note field that functions the same as the Note field described above. 
The table and field are Quote.Note2. 

Manufacturing Type This is the manufacturing type that the quote is being created for. (i.e. Injection, Generic, 
etc.). 

Cell Select the cell in which the item will be manufactured. The Cell field is optional and may be 
left blank if cells are not being used. To select a cell, click on the arrow down button to 
make a selection 
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Operators This is the labor required at the work center to run this operation.  

Click on the ellipsis button in the labor field to enter the required labor. The following form 
will appear. (Note: The quote must be saved prior to entering this information). 

 

From this screen click on the ADD (+) button, enter in the quantity of operators required 
(this does not have to be a whole number) then select the Employee Level Code from the 
drop down list. The Labor Rate will fill in with the Quote Rate associated with the code 
(Quote Rates are entered in the Employee Level form accessed from the Lists menu in 
System Parameters). 

The user can select multiple labor codes and associate fractions of operators per code or 
multiple operators per code. 

EnterpriseIQ supports a range of 0.00 to 999 operators per job. A number less than 1 can be 
used for jobs running automatically and an operator is not always at the press. For these 
tools, a partial number such as 0.5 is entered depending upon the number of machines the 
operator is tending. 

The Employee Levels list is created in Sys Setup->System Parameters->Lists. An unlimited 
number of employee levels may be created for use in the BOM and RFQ modules. The 
system comes with a Default labor code. 

If the Default labor code is selected the system will use the default Operator Labor Rate 
from Rates and Parameters. 

Labor Rate Hierarchy - Below describes the hierarchy of how the system will determine the 
quote standard labor rate: 

1 Employee level quote rate 

2 Quote/Miscellaneous/Rates and Parameters/Default Values/Operator Labor Rate 

3 Mfg Cell 

4 Mfg Type 

Note: When using employee levels, in order to have Setup hours included in the quote users 
must have an employee level with a labor type of Setup associated to the quote also. This 
designates the setup labor cost. 

The 'Last Used' column is useful to see the labor rate that was used when the quote was last 
calculated. 
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Cycle Time This is the time that it takes to make one unit (i.e., one shot, one assembly unit, etc.). This is 
based on the Cycle Time set on the Manufacturing Type, i.e. seconds. 

Units/Cycle 
(required) 

This is the number of units manufactured during the cycle time. This is not necessarily the 
number of cavities per cycle. EnterpriseIQ uses this value to determine how many shots are 
required on a production run. The calculation is simply the number of Items Required / 
Units per cycle.  

This value is used in the calculation for: Net Value/Hr, Prod Hrs, and Lbs Req. 

Essentially, for a tool that produces one item, the units per cycle will equal the number of 
cavities. 

For a family tool, the units per cycle will equal the lowest cavitation for any part. 

The following examples demonstrate the Units/Cycle concept: 

Examples: 

One item, 4 cavities, sold individually. Units/Cycle is 4 because each cavity is sold separately. 
Requirement is for 1000 pieces, the shots required would be 250 (1000/4 = 250). 

Two item numbers, 2 cavities each, sold as a set or as each. Units/Cycle is 2. The quote will calculate 
the price for a set as well as the individual item prices. The requirement is for 1000 pieces of each, 
the shots required is 500 (1000 / 2 = 500). 

Two item numbers (Item A and Item B), 1 cavity for Item A and 3 cavities for Item B, sold individually 
or as a set (1 of Item A and 1 of Item B). This is a ONE unit per cycle configuration because you only 
get one set per shot. The quote will calculate the price for a set as well as the individual item prices. 
The requirement is for 1000 pieces of each, the shots required is 1000 in order to produce 1000 pcs 
of Item A (1000 / 1). If you put the units per cycle as 3. The system would calculate shots required at 
334 (1000/3) and you would only produce 334 Item A’s. 

EnterpriseIQ will allow less than 1 unit per cycle for situations when one shot is not enough to produce a 
set. In this case, divide the Unit/Cycle by the number of shots needed to produce one set. 

Work Center 
(required) 

This is the type of work center that the item will be manufactured on. Select from the drop 
down list or select the pick list button next to this field. Both lists include the center #, 
description, type, rate, setup hours, and startup shots. After selecting a Work Center, a prompt 
will ask "Paste SetUp Hours, StartUp Shots & Rate from Selected Work Center?" If “Yes” is 
selected, the Setup Hours, Startup Shots, and Center Rate (defined under Work Centers) will 
automatically populate the appropriate fields. The entries can be changed for a particular 
quote without changing the default for the work center. Selecting “No” will leave the fields 
blank. 
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Scrap% This is the estimated amount of scrap that the production process will generate. This amount 
is used in calculating the extra production time and raw material necessary to make the 
correct number of good parts.  

This scrap rate does not affect any attached components. A separate scrap rate can be 
associated to an attached component in the Attached Materials section of the Item Details tab. 

Note: This field will not be present on this tab if the 'Use Scrap % by Quantity Breaks' 
parameter is checked in the Miscellaneous menu->Rate and Parameters. When 
checked a column is added to the 'Rates and Quantities' tab 'Standard Quote 
Quantities' section for 'Scrap %'. Each quantity can have a different scrap percent. On 
the 'Calculations' tab a 'Scrap %' column is added in the quantities grid displaying the 
scrap percent from 'Standard Quote Quantities'. This field can be edited. A 'Scrap %' 
row is added to the calculations grid for displaying the scrap percent associated to 
the quote quantity. The quantity scrap rates function the same as the scrap percent 
entered on the General Quote Values tab if this option is not selected. 

Efficiency Factor The efficiency factor accounts for time that the machine operates. It affects the assumed 
production time (Net Cycles/hr) and therefore the overhead cost for the produced item. This 
field will show the default value from Rates and Parameters, but can be edited for a particular 
quote. 

Note: If the 'Exclude Efficiency Factor from Cost Calc' option is checked in Rates and 
Parameters->Default Values tab (Miscellaneous menu), the system will exclude the efficiency 
factor when calculating overhead costs. The system will use an efficiency factor of 100 rather 
than the Quotes efficiency factor.  

Center Rate This is the rate that will be used in calculating the production cost. 

The value can be ‘pasted’ from the Center Rate associated to the selected work center or a 
value may be entered in manually. 

This rate can be a rate used for quoting or the user can use an actual cost. 

Fixed Machine 
Rate 

This value comes from the Fixed Machine Rate associated to the selected work center or a 
value may be entered in manually.  

The system uses this value to calculate the variable gross margin percent on the calculations 
tab. (See the VGM% calculation in the Calculation Display Box section). 

Start Cycles Start Cycles are the number of shots required before a good part is produced. They affect the 
start-up costs calculated in the quote, with the number of Startup Shots being added to the 
number of cycles required to produce the quote quantity. 

Setup Hrs Setup hours are the number of hours required to set up the machine. The Set Up hours affect 
the length of the production run and the production cost. 

When using employee levels in the Operators field, in order to have Setup hours included in 
the quote users must have an employee level with a labor type of Setup associated to the 
quote also. This designates the setup labor cost 

 Material The material to be used in the quote. Clicking on the pick list will access the following screen. 

For MFG Types with a primary material this field must be populated. If it is not, when the user 
attempts to calculate the quote an error will appear stating, 'RFQ # XXX - primary material 
required for quote calculation.' 
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This screen shows the raw material assigned to the current quote, the Quote Inventory List, and the 
Master Inventory List. EnterpriseIQ maintains an inventory of quote items separate from the Master 
Inventory to allow for the use of items not from the Master Inventory in quotes and modification of 
pricing for particular quotes. 

Adding Items to the Quote Inventory from Master Inventory 

To Add items to the Quote Inventory from the Master Inventory, find the material in the Master 
Inventory and drag and drop it into the Quote Inventory List. The Quote Inventory can have the same 
items from the Master Inventory with cost breaks different from those in the Master Inventory. 

Notes: Under Options select 'Include Prices w/ Transfer' if you want the prices to transfer from the 
master inventory. Pricing comes from the buying price section for purchased items and the selling price 
section for manufactured items by default; or the standard cost if the ‘Use Std Cost in Engineering 
Quote’ option is checked in Master Inventory->Additional tab). If the ‘Include Prices w/ Transfer’ option 
is not checked, the user must enter in the pricing information for the quote inventory. 

Both active and inactive pricing from the Buy/Sell tab in inventory will appear in the Master Inventory 
section, however, only active pricing will be carried over when dragging material from Master Inventory 
to the Quote Inventory List or to the Currently Assigned Material. To only see active pricing in the Master 

Inventory section select the Hide/Show Inactive button . The Hide/Show Inactive button is also 
available in the Quote Inventory section to hide quote pricing that has been marked inactive. 

If the 'Use Master Inventory Std Cost for Component Pricing instead of Price Breaks' quote parameter is 
checked the standard cost will be displayed instead of the price breaks. 

In Quote inventory you can have the same item number with a different description, but in Master 
Inventory the item number must be unique. Therefore, if the item is added via the ‘drag’ method from 
the Master Inventory list, the record chosen will be the first matching Item # in the Quote Inventory List. 
This can lead to the wrong item being added if multiple Quotes were made for the same item number 
with different descriptions or pricing. 

Searching for Inventory Items 

To search for items in the Quote Inventory, use the pick list speed button in the Quote Inventory section. 
Or click once in the Quote Inventory List section so the caption next to the field at the top of the screen 
reads 'Search Quote Inventory'. To search, begin typing in the Class and the Item Number of the item (do 
not leave a space between the Class and the Item Number) and the Quote Inventory List will 
hyperbrowse to the item. 

Use the pick list or hyperbrowse method, in the same manner as described above, to search for items in 
the master inventory list. 

Right Click Options - From the Master Inventory section users can right click and Jump to Inventory. If the 
item is a blend, users can select Jump to Blend to access the Blend Operations form. The Jump to Blend 
option is also available in the Quote Inventory List section. From the Quote Inventory List section right 
click and select Where Used to see a list of RFQs that the material is associated to as a primary material 
or a component. 
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Vendor RFQ 

From the Quote Inventory section the user can create a Vendor RFQ for items by selecting the Vendor 

RFQ speed button . Please see Vendor RFQ for details. 

Adding New Material to the Quote Inventory 

If the item does not exist in either the Quote or Master Inventory, click on any item within the Quote 
Inventory list. 

➢ Next, click on File->Add Material or click on the 'Add' [+] button. The following screen will 
appear: 
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➢ The Class of the item will default to PL, but can be modified. 

➢ Next, enter the Item #. 

➢ Enter a Rev number, if applicable. 

➢ Enter the Description of the item. 

➢ Enter an Extended Description if desired. 

➢ Select the Unit (i.e. LBS, KG). 

➢ Enter the SPG (Specific Gravity), if applicable. 

➢ Click on 'OK' to return to the Quote Inventory screen. The item that you created will be 
added to the Quote Inventory list only. 

Note: When the quote is converted to a standard, the item will be added to the Master Inventory list. 
During the conversion process, the item may be reviewed and edited. 

➢ Enter Qty / Price break for the material in the fields to the right. 

Attaching the Material to a Quote 

To attach a material to the quote 

Highlight the item within the Master or Quote Inventory List. 

➢ Double click on the item that is highlighted, or hold down the left mouse button and drag 
the item to the Quote Inventory list or directly to the Currently Assigned Material field. 

➢ Options Menu: Three options are available in the add material form. 

▪ Confirm Every Transfer - with this checked every time material is moved from one section to another 
a form will appear asking the user to confirm the move. 

▪ Include Prices with Transfer - with this checked when material is moved from one section to another 
the pricing will also transfer. (Does not apply to the AKA Pricing option, see below). 

▪ Reset Screen sets the screen to the original size. 

Changes can be made to the Qty / Price break field in the Quote Inventory before adding the material 
item to the Currently Assigned Material field or after the material has been assigned to the quote. 

Note: Changes cannot be made to the Qty / Price break fields shown in the Master Inventory List. 

Attaching the Material to a Quote Using AKA Pricing 

The default quantity price breaks listed for the master Inventory items comes from the Buying section of 
the Buy/Sell Pricing tab in inventory. However, users can select the 'Propagate AKA Vendor/price breaks' 
button in the Quantity Price Breaks section to assign AKA pricing to the quote inventory and the 

Currently Assigned Material . To use AKA pricing: 
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➢ Highlight the item to be associated to this quote in the Master Inventory section.  

➢ Select the AKA button and a form will appear listing the vendors and price breaks. 

 

➢ Highlight the desired record and select OK. 

➢ This will populate the Currently Assigned Material section with the selected item and its AKA 
price breaks. If the selected item already exists in the Quote Inventory the pricing will be 

updated with the AKA pricing. If it does not exist in the Quote Inventory, the system will add 
a new record with the AKA pricing.  

Note: AKA pricing will populate both sections regardless of the 'Include Prices w/ transfer Option.  

➢ To clear the currently assigned material and add a different one, select the red clear (X) 

button. 

➢ To exit, click on File->Exit or click on the [X] in the upper right hand corner of the screen. 
The selected material should now be displayed in the Material field. 

Runner/Sprue This is the combined weight of the runner and sprue. The runner and sprue information is used 
to calculate the material required for production. 

Note: Material requirements are calculated based on the total shot weight, which 
includes all cavities plus the runner and sprue. 
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Dry Time This is the amount of time required to dry the raw material prior to production. If material is 
being dried away from the press or within the set up time, leave this field at zero (0) as the dry 
time will affect the production hours. 

This information does not transfer to the BOM upon conversion. The dry time is on the raw 
material item in inventory and is used for informational purposes only. 

Regrind% This is the anticipated amount of regrind that will be used in the production. EnterpriseIQ will 
assume regrind consumption up to this amount and calculate pricing based on the value of the 
regrind material. The Regrind% affects material required and also the material cost. 

 After all entries have been made, save the information and click on the 'Item Info' tab to continue 
building the quote. 
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Quote Item Information 

The next step in completing the quote is to enter in the item information. 

Upon selecting the 'Item Details' tab the following screen will be displayed: 
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The first time this screen is accessed, it will not contain any data. The illustration above shows the Item 
Details screen after all entries have been made. The upper right portion of the screen provides 
information on the items to be produced and the lower right hand portion provides information on items 
to be consumed in the production process. 

Note: If the quote you are viewing was received from Marketplace, the quote screen will display a blue 
banner at the top of the screen: "This quote was received from Dassault Systemes Marketplace." 

To begin making entries click on the Add (+) button and fill in the fields: 

Class Select the Inventory Class for the item using the drop down list. 

Item # This is the item that will be produced (required field). The item number is an alphanumeric field 
up to 50 characters in length. A new item created here will exist only in the Quote Inventory 
until the quote is converted to a BOM. 

Revision The revision number for the item.  

Weight The weight of a single item (required field). If the weight of the item is not known, please see 
Weight Work Sheet for more information. DO NOT multiply the item weight by the number of 
cavities or include the runner and sprue weight. This information is collected on the main page 
of the quoting form. Also, DO NOT include any additional weight that an insert might add.  

Std Cav 

Standard 
Multiplier 

This is the standard cavities or multiplier, or the number of items produced per cycle (required 
field). 

Description The description or common name of the item (required field). This field can be up to 36 
characters in length. 

Ext Description This provides an additional field of 100 characters in length for an extended description 
(optional field). 

➢ Save your entries and the information will populate the left side of the screen. 

Quoting a Family Tool 

To add multiple items and create a quote for a family tool, click on the 'Add' [+] button and enter 
information on the other items to be produced. Each of these items will be displayed on the left hand 
side of the screen when the input is saved. 
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Attached Materials Specification 

The Quote module supports unlimited components per individual item such as purchased components, 
other finished goods, or packaging. Any item that is maintained in the Quote or Master Inventory files 
may be attached. 

Attaching Components 

Attaching a component(s) is accomplished as follows: 

➢ Select the item that the component will be attached to in the items tree (left side of screen). 

➢ “Right click” and select Add Component, or click on the Add Component button at the top of this 

screen. The following screen will appear: 
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➢ Select the item from either the Master Inventory list or the Quote Inventory list. 

➢ “Double click” or “drag” the new item from the Quote Inventory List up to the Currently Attached 

Components list.  

Note: In Quote inventory you can have the same item number with a different description, but in Master 
Inventory the item number must be unique. Therefore, if the item is added via the ‘drag’ method from 
the Master Inventory list, the record chosen will be the first matching Item # in the Quote Inventory List. 
This can lead to the wrong item being added if multiple Quotes were made for the same item number 
with different descriptions or pricing.  
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➢ Next, enter the Quantity per Item. The Quantity per Item is how many pieces will be consumed 
for each of the selected items manufactured. Press [OK] to return to the Quote Inventory 

screen. 

➢ If the component is a manufactured item that will need to be quoted the user can select the 

RFQ Required box. The item will be marked in red indicating an RFQ is required. Once the 

RFQ for the item is created the item will be marked in black. This feature is used in the top 
down quoting method. This option will be grayed out on the 'Modify Quote Inventory Item' 
form. This is the form you use to add an item to the quote inventory. Once you drag the 

newly created item to the Currently Attached Materials section the box will be enabled on 
the 'Edit Attached Material' form. This will indicate that the item needs to be quoted, in other 
words it is something you manufacture that does not have a quote created for it yet. 

➢ Modify the Quantity and Price Break information for the component, if necessary. 

➢ Add Additional components, as necessary. 

➢ To exit, click on File|Exit or click on the [X] in the upper right hand corner of the screen. The 

selected components will now be displayed in the visual view to the left under the item they 
are attached to and the details for the selected component will be displayed in the lower 
right hand portion of the screen. 
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➢ Each added component can have a Scrap percentage associated with it. Enter a value in the 

Scrap field for the attached item. The system will use this value to calculate the component 
cost. For example, if the Attached Component Scrap Calculation in Quotation parameters is 

set to 'Based on (1+Scrap)', and the quantity required per item is one and the scrap value is 
10%, for a quote quantity of 10000, the system will calculate the component requirement as 
11000 (10000 * 1.10). If the parameter is set to 1/1-Scrap, the component requirement 

would be 11111.11. Where if the scrap value is zero the component requirement would be 
10000. Then the cost is determined by multiplying the corresponding price break times the 
calculated component quantity.  

➢ User Fields - This tab includes the same user fields that are seen in the Attached Materials 

section of the BOM. (User Text 1-3 and User Numeric 1-3). When a quote is converted to a 
BOM, these user fields will be transferred over to the BOM's user fields as well.  

➢ Inventory User Fields - This tab will surface all Inventory user fields for attached materials that 

were brought in from master inventory. This will be read only and will only be available for 
items in master inventory. 

Note: Under Options select Include Prices w/ Transfer if you want the prices to transfer from the master 
inventory. By default, the pricing comes from the buying price section for purchased items and the 
selling price section for manufactured items; or the standard cost if the ‘Use Std Cost in Engineering 
Quote’ option is checked in Master Inventory->Additional tab). If the ‘Include Prices w/ Transfer’ option 
is not checked, the user must enter in the pricing information for the quote inventory. 

Note: Both active and inactive pricing from the Buy/Sell tab in inventory will appear in the Master 
Inventory section, however, only active pricing will be carried over when dragging material from Master 
Inventory to the Quote Inventory List or to the Currently Assigned Material. To only see active pricing in 

the Master Inventory section select the Hide/Show Inactive button . The Hide/Show Inactive button 
is also available in the Quote Inventory section to hide quote pricing that has been marked inactive. 

Note: If the 'Use Master Inventory Std Cost for Component Pricing instead of Price Breaks' quote 
parameter is checked the standard cost will be displayed instead of the price breaks. 

Searching for Inventory Items 

To search for items in the Quote Inventory, use the pick list speed button in the Quote Inventory section. 
Or click once in the Quote Inventory List section so the caption next to the field at the top of the screen 
reads 'Search Quote Inventory'. To search, begin typing in the Class and the Item Number of the item (do 
not leave a space between the Class and the Item Number) and the Quote Inventory List will 
hyperbrowse to the item. 

From the Quote Inventory List section right click and select Where Used to see a list of RFQs that the 
material is associated to. 
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Vendor RFQ 

The user can create a Vendor RFQ from the Quote Inventory section for items by selecting the Vendor 
RFQ speed button. Please see Vendor RFQ for details. 

Attaching Components to a Quote Using AKA Pricing 

The default quantity price breaks listed for the master Inventory items comes from the Buying section of 
the Buy/Sell Pricing tab in inventory. However, users can select the 'Propagate AKA Vendor/price breaks' 

button  in the Quantity Price Breaks section to assign AKA pricing to the quote inventory and the 
Currently Attached Materials. To use AKA pricing: 

➢ Highlight the item to be associated to this quote in the Master Inventory section.  

➢ Select the AKA button and a form will appear listing the vendors and price breaks. This form 
also includes a Unit column so users can easily see the unit of measure associated to the 
AKA record and the price breaks. 
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➢ Highlight the desired record and select OK. 

➢ This will populate the Currently Attached Materials section with the selected item and its AKA 
price breaks. If the selected item already exists in the Quote Inventory the pricing will be 
updated with the AKA pricing. If it does not exist in the Quote Inventory, the system will add 

a new record with the AKA pricing.  

Note: AKA pricing will populate both sections regardless of the 'Include Prices w/ transfer Option.  

Adding Quote Inventory on the Fly 

If the item does not exist in the Quote Inventory or Master Inventory, click on any item within the Quote 
Inventory list. 

➢ Next, click on File|Add Material. The following screen will appear: 
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➢ Select the Class of the item (i.e. IN, PL, FG, or PK). 

➢ Next, enter the Item #. 

➢ Enter a Rev number. 

➢ Enter the Description of the item. 

➢ Enter an Extended Description if desired. 

➢ Select the Unit (i.e. EACH, LBS, KG, GAL, ROLL, FT). 

➢ Click on [OK] to return to the Quote Inventory screen. The item that you created will be 

Added to the Quote Inventory list only. To Add the newly created item to the quote drag it 
up to the ‘Currently Attached Materials’ section. If the item is manufactured by the user, the 
RFQ Required option can be selected. Only select this option if the item will require a quote 

to be created. 

Note When the quote is converted to a BOM, the item will be added to the Master Inventory list. During 
the conversion process, the item may be reviewed and edited. 

➢ Enter Qty / Price break information for the item in the fields to the right. 

Attaching Packaging 

The Quote module supports unlimited packaging items per individual item. To attach a packaging item, 
complete the following steps: 

➢ Select the item that the packaging will be attached to in the items tree (left side of screen). 

➢ Right click and choose Add Packaging from the menu, or select the Add Pack button at the 
top of the screen. The following screen will appear: 
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➢ Select the item from either the Master Inventory list or the Quote Inventory list. 

➢ Double click or drag the new item from the Quote Inventory List up to the Currently 
Attached Packaging list. 
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➢ Enter the Items/Pack. The Items/Pack is how many of the manufactured items will be put 

into each packaging item. 

Note: If entering a zero for items/pack (i.e. for a Non Material PK item), the user will receive a warning 
when calculating the quote stating, 'Attached Packaging Items per Part is zero.', with an Ignore and 
Cancel button. Select Ignore to continue calculating the quote, or Cancel to not calculate. 

➢ Enter the Weight and Label FMT. (Optional). 

➢ If the item is manufactured by the user, the RFQ Required option can be selected. Only 
select this option if the item will require a quote to be created. 

➢ Press [OK] to return to the Attached Packaging screen. 

➢ Enter the Quantity and Price Break information for the packaging item. 

➢ Add Additional packaging, as necessary. 

Note: When adding multiple packaging items, keep in mind when the RFQ is converted to a BOM the 
packaging sequence will populate based on the order they are attached to the quote. Sequence numbers 
can be edited in the BOM. 

➢ To exit, click on File|Exit or click on the [X] in the upper right hand corner of the screen. The 
selected packaging items will now be displayed in the visual view to the left and the details 
for the selected packaging will be displayed in the lower right hand portion of the screen. 

➢ Each added packaging item can have a Scrap percentage associated with it. Enter a value in 

the Scrap field for the attached packaging item. The system will use this value to calculate 
the packaging cost. For example, if the parts per packaging item is 500 item and the scrap 
value is 10%, for a quote quantity of 10000, the system will calculate the packaging 

requirement as 22 (10000/500 * 1.10). Where if the scrap value is zero the packaging 
requirement would be 20. Then the cost is determined by multiplying the corresponding 
price break times the calculated packaging quantity. 

Searching for Inventory Items 

Use the pick list or hyperbrowse method, in the same manner as described above, to search for items in 
the master inventory list. 

Users can right click from the Master Inventory section to jump to inventory. 

Attaching Packaging to a Quote Using AKA Pricing 

The default quantity price breaks listed for the master inventory items comes from the Buying section of 
the Buy/Sell Pricing tab in inventory. However, users can select the 'Propagate AKA Vendor/price breaks' 

button  in the Quantity Price Breaks section to assign AKA pricing to the quote inventory and the 
Currently Attached Materials. To use AKA pricing: 

➢ Highlight the item to be associated to this quote in the Master Inventory section.  
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➢ Select the AKA button and a form will appear listing the vendors and price breaks. 
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➢ Highlight the desired record and select OK. 

➢ This will populate the Currently Attached Materials section with the selected item and its AKA 
price breaks. If the selected item already exists in the Quote Inventory the pricing will be 
updated with the AKA pricing. If it does not exist in the Quote Inventory, the system will add 

a new record with the AKA pricing.  

Note: AKA pricing will populate both sections regardless of the 'Include Prices w/ transfer Option.  

Adding Packaging Inventory on the Fly 

If the item does not exist in the Quote Inventory or the Master Inventory, click on any item within the 
Quote Inventory list. 

➢ Next, click on Inventory|Add Material. The following screen will appear: 

 



Quoting Page 48 of 220 

 

➢ The Class will default to (PK). 

➢ Next, enter the Item #. 

➢ Enter a Rev number. 

➢ Enter the Description of the item. 

➢ Enter an Extended Description if desired. 

➢ Select the Unit (i.e. EACH, FT). 

➢ Click on [OK] to return to the Quote Inventory screen. The item that you created will be 

Added to the Quote Inventory list only. To Add the newly created item to the quote drag it 
up to the ‘Currently Attached Materials’ section. If the item is manufactured by the user the 
RFQ Required option can be selected. Only select this option if the item will require a quote 

to be created. 

Note: When the quote is converted to a BOM, the item will be added to the Master Inventory list. During 
the conversion process, the item may be reviewed and edited. 

➢ Enter Qty / Price break information for the item in the fields to the right. 

Editing a Packaging Item or Component 

To Edit an attached packaging item or component: 

➢ Highlight the attached component or packaging item. 

➢ Under 'Attached Material Specifications' (lower right portion of the screen), change the 
Quantity and/or Quantity and Price breaks. 

The user can also Edit the item by highlighting the item/component and selecting Change Material from 
the submenu that will appear. 

➢ Make sure to SAVE the changes when finished. 

Attaching Operations 

Attaching operations is accomplished in a similar manner as attaching components or packaging items. 
This feature is used to attach operations to the quote versus creating a generic quote. By adding the 
operation here the assumption is made that it will be done within the cycle time and the operation does 
not change the part number. If the part number changes due to the operation (i.e. hot stamping a logo) 
or the operation time needs to be scheduled a generic quote should be created with the manufactured 
item attached as a component. 

To attach an operation, complete the following steps: 

➢ Select the item that the operation will be attached to. 
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➢ “Right Click” and choose Add Operation from the menu or click on the Add Oper button at the 

top of the screen. 

➢ The Select from Std Oper/ Routing pick list will appear. Use the Search or Sort function to locate 

an existing Operation number within the pick list or create a new operation “on the fly”. If 
you click on new the following screen will appear: 

 

Use the field listing below for assistance in filling in each of the fields on this screen. 

Operation # This number is automatically populated by the system. It can be edited but if this number is 
manually changed users could potentially end up receiving a unique constraint error if the 
number is already used. 

Class Defaults to OP and cannot be changed. 

Description 25 alpha-numeric description of the operation. 

Operation Info Std Rate: The rate used for calculating the labor or overhead costs associated with the 
operation. 

Materials Attach materials from inventory associated with the operation by clicking in the item # field 
to get an inventory drop down menu. Specify the number of parts per item and verify the 
price break information. 

Documents Add any Internal or External documents related to the specific operation. 
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Operation Details 

From the Operation Details tab on the Item Details tab in Quoting establish the cost of the operation. 
Select the UOM (Sec, Min, Hour, Day) from the drop down and then enter the cycle time. The system will 
multiply the Std Rate defined on the operation times the Hours/Item to calculate the standard cost per 
item. For example, if the time required is 15 seconds at a rate per hour of 25, the system will calculate 
the cost as 15/3600 * 25 = 0.104167. This information will flow to the Operation Cost row on the 
Calculations tab. 

Deleting a Packaging Item, Component or Operation 

To Delete a packaging item or component from the list: 

➢ Highlight the item to delete and “right click.” 

➢ Select Delete Item from the submenu. The item will then be removed. If there are any other 

packaging items underneath the one deleted, they should move up in place of the one that 
was removed. 

➢ To delete an operation, select Delete Operation from the submenu. 

Note: Make sure that the cursor is sitting on the operation that is to be deleted. Failure to do this could 
result in deletion of the wrong item. 

Qty / Price Break 

The Quantity and Price Breaks are the prices the system will use to calculate the cost and price of the 
quoted item. These price breaks are only used in the Quote module. 

 

The user can change the price breaks before calculating the quote. 

➢ To change the quantity, place the cursor in the Qty field. 

➢ Type in the quantity and use the [Tab] key to move to the next column. Enter in each Price 
Break. The default Qty / Price break information may be loaded by selecting that function on 

the Navigator bar at the bottom of this section. 

➢ To view the price breaks in another currency, click on the FX Rates button and choose the 

currency from the drop down list on the pop up form. 

➢ Save your changes. 
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Extra Charges 

To enter extra charges relating to the item being quoted on: 

➢ Select the Extra Charges, Commission tab at the bottom of the screen. The following screen 

will appear: 
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There are unlimited fields for any additional charges not accounted for in the normal quote input 
screens. Examples of additional charges may be Tool Maintenance, Tool Amortization, Special Setups, 
Color Changes, Freight Charges, etc.  

The extra charges can be entered manually from this screen or defaults can be set up in Rates and 
Parameters for users to select from. To select a default extra charge click on the Description field and 
then select the ellipsis button. This will open the pick list of Extra Charges created in Rates and 
Parameters. To enter an extra charge manually type the information in the fields described below. 

Note: A sequence # is required. If the sequence number is left null, the user will be prompted with a pop-
up warning. 

These charges can be controlled in three different ways: 

Amortize Cost Over 
Each Quantity 

Divides the Total by each quoted quantity and applies the cost directly to the per item 
price. 

Example: 
Total = $500, Per set at zero, and Cost Break at N.  
Applies a $500 charge to each price break and divides the $500 by the Quote Quantity and 
adds that to the item price. 

  For 5000 items, charge is $0.10 per item 

  For 125000 items, charge is $.004 per item. 

Add a Cost for 
Every X Number of 
Items Produced, 
Pro-rated 

Divides the Total Amount by the Per Quantity and adds that amount to the per item price. 

Example: 
Total = $250, Per set at 10000, and Cost Break at N.  
Applies a $0.025 charge to the item price. (250/10000) 
    For 5000 items, charge is $125 
    For 125000 items, charge is $3,125 

Add a Cost for 
Every X Number of 
Items, Not Pro-rated 

Divides the Quote Quantity by the Per quantity, rounds the number UP to the next whole 
number, multiplies that whole number by the Total Amount, divides this number by the 
Quote Quantity, and adds that amount to the per item price. 

Examples: 
Total = $250, Per set at 10000, and Cost Break at Y.  
    For 5000 items, total additional charge is $250, per 
     item charge is $0.05 
    For 125000 items, total additional charge is $3250, 
      per item charge is $0.026 

 

NOTE: The Total field may be entered up to a four decimal precision. 
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Commissions 

Adding Commissions 

Sales commissions will be added into the final item price on either the Total Price or the Gross Margin. 

➢ Select Total Price or Gross Margin by clicking on the radio button next to the field. 

➢ Choose how the commission should be calculated:  price + (price x commission) or price/(1-
commission). 

➢ Type in a Commission percentage. The value entered can be up to a two decimal precision. 

➢ To save any entries made within this screen, click on the check mark located on the 
Navigator bar. 

Commission Examples 

The chart below displays examples of the commission options using the following information: 

TOTAL  = 5000 

COMMISSION % = 5% 

QUOTE QTY - 1000 

TOTAL PROFIT = 4000 

OPTION CALCULATION COMMISSION 

       per part 

TOTAL PRICE & 

PRICE + (PRICE  X 
COMM %) 

(TOTAL /QUOTE QTY) X COMMISSION % 

(5000/1000) x .05 

5 x .05 

.250 

TOTAL PRICE & 

PRICE / (1-
COMMISSION) 

(TOTAL  / 1 - COMMISSION %) - TOTAL  / 
QUOTE QTY 

((5000/.95) - 5000)/1000 

(5263.159 - 5000)/1000 

263.159/1000 

.263 

GROSS MARGIN & 

PRICE + (PRICE  X 
COMM %). 

(TOTAL  PROFIT / QUOTE QTY) x COMMISSION 
% 

4000/1000 X .05 

4 X .05 

.200 
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OPTION CALCULATION COMMISSION 

       per part 

GROSS MARGIN & 

PRICE / (1-
COMMISSION) 

 

((TOTAL  PROFIT/(1 - COMMISSION %)) - 
TOTAL  PROFIT) / QUOTE QTY 

(4000 / 1-.05) - 4000)) / 1000 

(4210.526 - 4000)/1000 

210.526/1000 

.2105 

 
 

Assigning Auxiliary Equipment 

Adding auxiliary equipment to a quote can affect the hourly machine rate and thus the production cost. 
Access the Auxiliary Equipment screen by clicking on the tab labeled Auxiliary Equipment on the bottom 
of the screen. 

Create Auxiliary Equipment 

Prior to assigning Auxiliary Equipment to a quote, the equipment must be added to the Auxiliary 
Equipment list. To add equipment to the list: 

➢ Select the Auxiliary Equipment tab. Click on the Add (+) button in the middle right of the form 

and enter the information in the fields. The auxiliary equipment is EPlant specific. 

Description The description of the auxiliary equipment 

Rate The hourly charge rate for the equipment. This rate will be added to the machine rate and 
included in production costs. 

How Many How many of these particular items are available on the floor. If the quote is converted to a 
BOM, this information is used to determine scheduling conflicts. 
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Assigning Auxiliary Equipment 

To assign auxiliary equipment to a quote: 

➢ At the bottom of the General Quote Values screen, select the Auxiliary Equipment tab. The 

following screen will appear: 
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The items entered in the Auxiliary Equipment table will be shown on the right side of the screen. This 
equipment is filtered based on the EPlant you are logged into. The equipment list can be sorted by 
Description or EPlant by clicking on the header for the field to sort on. 

The equipment assigned to the specific quote will be shown on the left side of the screen. 

➢ To assign equipment to the Quote, highlight the desired piece of equipment and click on the 

arrow over key  or drag and drop the equipment. Type in how many of each item 
should be used in the quote. 

NOTE: The cost(s) for the Auxiliary Equipment assigned to the quote are added to the Total Center Rate 
displayed at the bottom of the Auxiliary Equipment screen. 

Deleting Items from the Auxiliary Pick list 

To delete an item, highlight it on the left side and click the arrow back key . This will delete the item 
from the list. When finished editing, Save the changes before returning to the main quote entry screen. 
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Quote Documents 

An unlimited number of documents can be attached to the quote. Each quote may have its own set of 
documents. EnterpriseIQ supports a basic word processor to create these documents (notes) or the user 
can link existing documents. There are two sections to this screen which are discussed briefly on the 
following pages. 

NOTE: Both Internal and External documents can be printed with the Request for Quote (RFQ). 

Select the Documents tab at the bottom of the screen. The following screen will appear: 
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Internal Documents 

This option allows an unlimited amount of miscellaneous notes to be attached to the quote. The notes 
are stored in the Oracle database and can be accessed at all times from the program. The internal 
documents section acts like a word processor--the user can add, edit, delete or print documents from 
this screen. 

Creating Internal Documents 

To create an internal document: 

➢ Access the documents screen and click on the Add button. The following screen will appear: 
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➢ Select the Create New Doc radio button, and fill in the document description. 

➢ Select whether to print the document with the RFQ by selecting from the arrow down list 
next to the Print with field. 

➢ Click on [OK] and the following screen will appear. 
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This screen is a word processor and document text may be entered by typing the information in or may 
be copied and pasted in from other sources. Images may be imported by selecting File|Insert File from 
the menu. All changes must be saved prior to exiting from the word processor. To exit, click on the [X] in 
the upper right hand corner. 

Linking Existing Internal Documents 

To link an existing internal document to the quote select the Pick Existing Doc radio button. 

➢ Click on OK and a pick list of the existing internal documents linked to the quote module will 
appear. Select the document to be linked and click OK. The document will show in the list of 

internal documents. 

Editing Internal Documents 

To edit an existing internal document, access the documents screen and select the Edit Doc Contents 
radio button. 

➢ Click on OK and the word processor will open. The internal document can then be edited. All 

quotes that have the specific document linked to them will then reflect the changes made 

here. 

External Documents 

This section allows the user to link or open documents created in different applications such as 
spreadsheet, word processing, CAD, etc. and map the path to these documents so that anyone can 
access them. To open an external document, the program used to create the external document must be 
installed on the work station. 

To CREATE a new external document link: 

➢ Click on the Add [+] key from the Navigator bar. 

➢ Locate the document on the computer or the network, and click on [Open] when finished. 

The File Name field will now contain the path or location of the document that is being 
attached. If the user has the EnterpriseIQ Document Control module the user will first select 

the Library and then the specific document in that library to be attached rather than the 
path. 

➢ If this document is to be printed with the Request for Quote (RFQ), select RFQ from the 
arrow down list under the Print with column. The attached external document will print when 

the RFQ is printed using the speed button, but will not print when the RFQ is selected from 
the Reports menu. 

Additional Options: 

▪ Search - The External Documents tab in all modules includes the Search button to access the pick list 
for easier navigation through multiple documents. 

▪ Filter Dataset - Each External Documents tab within the modules will have a Filter Dataset button to 
enable users to filter the attached external documents by a field within the library, including the user 
defined fields. Select the filter speed button and enter the filter criteria in the pop up form. 
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▪ Launch Document Control - This will open the document control module to the library and document 
for the highlighted record. 

▪ Print - This option will open and print the document. 

▪ Scan - A document can be scanned to a library by selecting the Scan button on the External 
Documents tab. The Scan Document form will appear. Select the Library from the drop down list and 
enter the additional details such as file name, color and source. 

To OPEN the document: 

➢ Double-click on the file name, or select the document and right click and select [Execute] 

from the submenu. The program will open both the application the document was created in 

as well as the document itself. When finished viewing the document, click on [Exit]. 

➢ When finished viewing the document, click on [Exit]. 

Email Correspondence 

➢ In addition to documents there is an Email Correspondence tab. From this tab users can to 
attach Email correspondence related to the RFQ. To add an Email simply drag and drop it 
from Outlook or other email programs into the form. The Received Date will fill in based on 

the email’s received date and time. A Received Date box surfaces if the system is unable to 
determine the date (such as: the Received and Sent dates differ, unclear binary data, or 
older data, etc.). Users are asked to provide the Received Date by selecting the correct date 

from the calendar. The From and Subject fields will also automatically populate with the 
information from the email. The date, from, and subject fields cannot be edited. A comment 
can be entered by double clicking the field. Enter the comment in the pop up box to further 

describe the email correspondence.  

➢ There are three ways to access the Email once associated to the RFQ:  

▪ Double click on either the Received, From, or Subject fields.  

▪ Right click and select View email.  

▪ Or select the View email button.  

➢ Note: If the email has attachments, or multiple attachments, the total attachment size 

cannot be more than 4GB. The size allowance might further be limited by the chosen email 
program used. In order to view emails that have attachments, special formatting (e.g. 
stationary), or images embedded in the body of the email, the user must go into BDE 
Administrator and set the BLOB SIZE to 1000 for the database they are using (i.e. IQORA). 

See the Documents section for more information. 
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User Defined Form in Quotations 

 

The User Defined Form allows the user to add new fields to a blank, user defined table. A maximum of 64 
new descriptive fields can be established. These fields can then be used in customized reports and can 
be useful when creating a quote letter as it allows for different verbiage for different situations. The user 
fields will hold up to 250 characters. This is also available from the Options menu. For more information 
on setting up the user defined form please see User Defined Forms in the Setup manual. 

Note: Security for this User Defined Form can be granted from the User Defined Form accessed from the 
Options menu in the quote or from the User Defined Form tab. 
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Generic Manufacturing Type Quotes 

The Generic manufacturing type is used to quote product that is not done using a molding process such 
as injection or extrusion. Examples of generic manufacturing are sonic welding, assembly, pad printing, 
etc. Quoting a product using the Generic Manufacturing type is basically identical to creating an Injection 
quote. The main difference is there is no raw material required, the work center used is a generic type, 
and on the items detail tab it is Standard Multiplier instead of cavities. 

Below is an example of the General Quote Values Tab for a Generic Quote: 
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All of the fields are the same as on an injection quote except there is no material field and the fields 
associated with material such as dry time. 

Assembly Mfg Type 

The Assembly manufacturing type (not ASSY types) also use a similar form as above.  

Note: The Cycle time for the Assembly Mfg Type in the estimating module is in seconds where in BOMs it 
is in hours. When converting an Assembly manufacturing type quote to a BOM the system will convert 
the cycle time to hours. 
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Outsource Manufacturing Type Quotes 

Outsource manufacturing quotes are used to quote a process that is not done in house. These quotes 
use the vendor's costs in the Quantity Breaks table on the Item Details screen. Below is an example of an 
Outsource Quote form: 
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Most of the fields are the same as on a Generic quote with the exception of cycles. Instead of cycles the 
system uses days per thousand or a flat number of days. 

▪ Days/K -  The rate of production for an outsource operation is handled with the Days per 1000 parts 
field entry unless the Flat Ratio is checked. This field is used to generate the approximate time the 
operation will consume. 

▪ Flat Ratio -  Check this box if the rate of production is based on the number of days and not days 
per 1000 parts. Once checked, enter the number of production days in the preceding Days field to 
complete this operation. 

An outsource quote utilizes a vendor set up as a work center and the costs come from the Quantity Price 

Breaks set up on the Item Details tab. Click on the  and the following form will appear. 

 

To enter in price breaks click on the ADD (+) button and enter as many price breaks as desired. 

Note: For the Outsource MFG Type (or a user defined MFG Type that defaults to Outsource), if the 
Variable rate is filled in with 'Labor Based Rate' option selected (MFG Types->Labor/Overhead tab), this 
will be included in the calculation of production costs in Outsource quotes.  
 

Extrusion Manufacturing Type Quotes 

There are three extrusion manufacturing types available in the system: Extrusion, Extrusion2, and 
Extrusion3. Quoting a product using one of the Extrusion Manufacturing types is basically identical to 
creating an Injection quote. The fields will vary slightly based on the type. The chart below describes 
some of the differences: 

Type Item BOM Info. Wor
k 
Cen
ter 

Typical 
UOM 

EXT Part Length Feet/Lb and Lbs/Hr; 
RT Signal Rate 
recommended 

Line 
Size 

Feet 
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EXT2 Part Weight Lbs/Hr; RT Signal Rate 
required 

Cen
ter 
Typ
e 

Lbs. 

EXT3 Part Weight Lbs/Hr; No RT Signal 
rate 

Cen
ter 
Typ
e 

Eaches 

Pipe Extrusion Worksheet 

For the EXT MFG Type there is an option on the general tab of the quote called Pipe Extrusion 
Worksheet. Select the button next to the Feet/Lb field and enter in the diameter and linespeed details in 
the pop up form. 

 

If a material is attached the system will populate the SPG field with the SPG associated to the material in 
inventory, or it can be entered manually. 

Calculations:   

Ft / Lb (Sets_disp) =  1000/((OD * OD - ID * ID) * 3.14159 / 4 * SPG)  

Lbs / Hr (Cycletm_disp) = (OD * OD - ID * ID ) * 3.14159 / 4 * SPG * line_speed * 60/1000 
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Thermoform and TFORM2 Manufacturing Type Quotes 

Creating a quote for a Thermoforming manufacturing type is essentially the same process as for all 
quotes. The differences mostly lie in the material information. The fields that differ from an Injection 
quote are discussed below: 

Material/Regrind 

Material This field is used for selecting the material that will be used for this job. This section has two 
fields, one will list the material item number and the other will fill in with the description. The 
user can modify the quote inventory item by selecting the Edit Material button next to the 
material description field this will pop up a form to edit fields such as SPG and Gauge. 

Gauge The gauge of the raw material. This will fill in based on the gauge associated to the attached 
material. 

This field can be changed for the specific quote without affecting the default gauge associated 
to the raw material. 

SPG The specific gravity of the raw material. This populates automatically based on the SPG 
associated to the selected item. 

Tool Width The width of the tool. This is entered on the General tab for THERMOFORM. 

For TFORM2 this value comes from the specified material. If a material has been brought over 
from master inventory it will bring the information over that was entered in the UOM 
Conversion Factors form in Master Inventory. If creating a new material or editing an existing 
one, the width field will display on the add and edit forms in the Materials Used in Quote 
screen. This field can also be edited by selecting the Edit Material button next to the material 
description field. 

(Note: This field is not available from Quote Inventory (Miscellaneous menu). 

Rail Optional. The rail material on the sides used to align the sheet to the tool. 

(Not applicable to TFORM2). 

Tool Length The length of the tool. This is entered on the General tab for THERMOFORM. 

For TFORM2 this value comes from the specified material. If a material has been brought over 
from master inventory it will bring the information over that was entered in the UOM 
Conversion Factors form in Master Inventory. If creating a new material or editing an existing 
one, the length field will display on the add and edit forms in the Materials Used in Quote 
screen. This field can also be edited by selecting the Edit Material button next to the material 
description field. 

(Note: This field is not available from Quote Inventory (Miscellaneous menu). 

Clamp Optional. The clamp material on the end used to align the sheet to the tool. 

(Not applicable to TFORM2). 
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Sheet Weight Thermoform: Sheet Weight = (Width +Rail) x (Length + Clamp) x SPG x Gauge x .0361. 

(Multiplied by 453.59237 if the UOM is in grams). 

TFORM2: Sheet Weight = Width x Length x SPG x Gauge x .0361. 

(Multiplied by 453.59237 if the UOM is in grams). 

 

Item Details Tab->Part Information 

 Standard Up The Standard Up is the number of items produced during the cycle. 
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Weight Enter the weight for a single item. The weight will be shown in either pounds, grams or 
ounces. Do not multiply the weight by the number of ups. 

The weight can be calculated using the Thermoform Weight Worksheet. Select the Weight 
Worksheet button next to the Weight field and the following form will appear: 

 

Enter the SPG, Gauge, Length, Width and other applicable information. The volume can be 
calculated by the system by clicking on the calculate button next to the volume field. It is 
calculated as follows:  

          Volume =  Length x width x Gauge. 

Once the volume is calculated and the SPG is entered the system can determine the weight in 
grams of the part. The calculation is: 

          Weight = (Volume x SPG x .0361) x 453.59 

The Results in the lower section of the worksheet are calculated using the entered 
dimensions. 

For one Up: 

Length = Length + (Space at Edges x 2)  

Width = Width + (Space at Edges x 2) 

For additional Ups: 

Length = (Length x No. Ups) + (Space Trim to Trim x (No. Ups -1)) + (Space at Edges x 2)  

Width = Width  x No. Ups) + (Space Trim to Trim x (No. Ups -1)) + (Space at Edges x 2 



Quoting Page 72 of 220 

 

Highlight the length and width to be used for the quote. The information will display in blue in 
the white box. Press OK and the system will update the Tool Length and Tool Width on the 
General Quote Values tab and the Std Up value in the Part Information section on the Item 
Details tab. 

Costing Weight By default the costing weight equals the Weight + By-product. If the ‘Exclude By-product’ 
option on the Calculations tab is checked then the Sheet Weight = Weight.  

Costing Weight is used to determine material costs. 

Sheet Weight The calculated Sheet Weight from the General Quote Values tab. 
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Skeleton Weight Skeleton Weight = Sheet Weight - (Part Weight * Up) 

Attached Materials 

By Product To add a By Product select the speed button next to the Skeleton Weight field. The Assign By 
Product form will appear to choose from or select File->Add to create a new By Product quote 
inventory item. The Modify Quote Inventory form will appear to enter the By Product Item 
Number, Description, Rev, unit of measure, etc. The Class defaults to PL.  

If a By Product item is created based on the Skeleton Weight the By Product box will be 
checked. It cannot be manually checked or unchecked. 

Note: The value of the skeleton (By Product) does not impact the cost/price of the 
manufactured item. However, if the quote is converted to a BOM, during Production 
Reporting both items will be dispositioned into inventory. 

Parts Per The parts per for the By Product is the skeleton weight divided by the number of standard ups 
converted to the selected unit of measure. This will be a negative value so that it is put into 
inventory during dispositions. 
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Creating a Quote from the Top Level down 

To create a quote starting at the top level manufactured item the user will create the highest level quote 
then work their way down to the lowest level. First determine the last step the item will go through and 
create a quote for that item selecting the correct manufacturing type. 

For example: An item is produced that first is injection molded then it is assembled with another item, 
and finally it is pad printed as the finished good. In this scenario we have three steps, molding, assembly, 
and pad printing. The first quote created will be for the Pad Printing operation. 

Create the quote for the pad printed item. On the Item Details tab select Add Component and create a 
new item in the quote inventory for the assembled item by selecting the Add (+) button and entering the 
item details on the ‘Modify Quote Inventory Item’ form: 
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This item will now exist in the Quote Inventory. Next, select the newly created item and drag it to the 
‘Currently Attached Materials’ section and the ‘Edit Attached Material’ box will display: 
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Enter the 'Qty per Item' and be sure to check the 'RFQ Required' box. This will mark the item in red 
indicating a quote must be created for the item. Add any additional requirements such as packaging. 
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Next, right click on the Attached Component (assembled part in our example), and select Jump to RFQ. 
The manufacturing type selection criteria screen will appear because the system will recognize that a 
quote needs to be created for the item. Select the correct manufacturing type/cell and press OK. 

A new quote form will appear with the same RFQ # with a dash 1. In our example the pad printed quote 
created was number 109, the assembled part quote is number 109-1. The Description will fill in 
automatically with the description from the first quote but can be modified. Also, the item information 
will fill in automatically on the Item Details tab. 

From the Item Details tab select the ‘Add Component’ button and follow the steps above to create the 
manufactured item. Right click on the manufactured item and select Jump to RFQ. The system will again 
ask for a manufacturing type/cell to create the new quote for the manufactured item. 

Calculating the Quotes 

Now that all of the quotes are created they can be calculated. If the 'Calculate All Levels' option is not 
checked for all of the quotes, start with the lowest level quote. Once the highest level is reached all of 
the steps will have been quoted and will be included in the final prices for the finished good. 

If the 'Calculate All Levels' option is checked on all related quotes the system will calculate the costs for 
each item associated to the 'top' level item with one click. For example, Item C consumes Item B, which 
consumes Item A. With this option checked when calculating the quote for Item C, the system will 
automatically calculate Item B and A.  

Note: The automatic calculations will only affect the actual items that are part of the current "tree" and 
not other quotes they may be attached to. 

Note: In order for this to work, 'Refresh Subcomponent Price Breaks' must be checked on the Default 
Values tab of Quote Parameters, and 'Use Master Inventory Std Cost for Component Pricing Instead of 
Price Breaks' must be unchecked on the General tab of Quote Parameters. 

Note: If the Workflow Approval Quote parameter is checked, the system will apply the same Quote Type 
to the RFQs created from the place holders. 
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Calculating the Quote 

The last step in building the quote is calculating. Before calculating, make sure that the required 
information has been entered. 

If any required information is missing, an error message will appear and the user will not be able to 
continue with the calculation of the quote. 

To calculate the quote, follow the steps below. 

➢ Select the 'Calculations' tab. The following screen will appear: 
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This calculation screen is divided into two sections, the Calculation Parameters on the left and the 
Calculation Display box on the right. If you right click within the Calculation Display box, the you can 
choose to Display the Production Data, Display the Calculation Parameters or Optimize the quote. 

The Calculation Display box contains several columns of information. For a detailed analysis of how these 
fields are calculated, please see the Calculation Display Box at the end of this section. 

Note: If the quote you are viewing was received from Marketplace, the quote screen will display a blue 
banner at the top of the screen: "This quote was received from the Dassault Systemes Marketplace." 

Calculating the Quote 

To Calculate the quote, click on the Calculate button . 

Note: Certain manufacturing types (such as Injection, Blowmold, and Thermoform) require a valid cycle 
time in order to calculate the quote. If a cycle time is not entered or scrap is set to 100% the user will 
receive a warning: "Either cycle time is too low or scrap is too high.  Calculations aborted." 

Quote Calculations and Standard Cost Calculations 

In order for Quote costing to match Standard Costing, the following conditions must apply: 

▪ Quotation Parameters 

▪ The 'Use Master Inventory Std Cost for Component Pricing instead of Price Breaks' must be 
checked. 

▪ The 'Based on (1/1-Scrap)' Attached Components Scrap Calculation option must be selected. 

▪ Inventory 

▪ 'Use Std Cost in Engineering Quote' (Inventory->Additional tab) must be checked for consumed 
material, components, and packaging. 

The following are calculated differently in Quote costing and therefore will not match standard costing: 

▪ Fixed Machine Rate 

▪ Setup Labor 

▪ Setup Hours 
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Calculation Parameters on Calculations Tab 

Fixed Material and/or Fixed Production Markup Tables 

EnterpriseIQ allows markups on both production and material costs. The user may choose from two 
methods to tell the system how to markup the calculated values. The markups may be calculated using 
the markup tables set up in the Rates and Parameters, or the user may create fixed markup tables for 
the individual quote on the calculation tab. The default Material Markup Table and/or Production 
Markup Table data entered in the Rates and Parameters as defaults may be overridden for an individual 
quote by using either one of the fixed table options on the Calculations tab. Entries in this section are 
entered as whole numbers, not decimals (to set the markup to 5%, type 5, 15%, type 15, etc.). 

Default Markup 
Tables 

(Misc->Rates and 
Parameters 

If both the Fixed Material and/or Fixed Production Markup check boxes are left unchecked, 
the system will use the default markup table information set up under Misc->Rates and 
Parameters. The markup values stored here are based on the total number of hours the job 
will run and the total dollar amount of material used. 

Fixed Markup 
Tables 

(Calculations tab for 
individual quote) 

Click on either one of these boxes to override the default mark-up table for this quote only. 
Where the Default option uses the pre-defined tables based on various values, the fixed 
option matches a percentage with the quantity to be quoted based on user input. 

To use a Fixed Markup Table (production or material) instead of the default tables, click on 
the check box next to either the Fixed Material Markup Table or Fixed Production Markup 
Table. When the box is checked, the Prod MU% or Matr MU% column will become white to 
allow data entry. 

If either Markup % Table is left at zero, the quote will not receive a markup. 

Using one of the Fixed options allows you to change any and/or all Quote Quantity 
production markups within that particular table. 

After running the calculate function, the corresponding markups will be placed in the table 
available for viewing. If you wish to create a quote with NO markups in either the Fixed 
Material Markup Table or Fixed Production Markup Table, you may do so by using both the 
fixed options and setting all quantities to zero. This is used for calculating pure cost. 
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Additional Calculation Parameters 

Calculate All Levels The default value for this option is set in Quotation Parameters->Default Values tab. This 
value can be overridden on the Calculation tab for an individual quote. Check this option to 
calculate the costs for each item associated to the 'top' level item with one click. For 
example, Item C consumes Item B, which consumes Item A. With this option checked when 
calculating the quote for Item C, the system will automatically calculate Item B and A. If this 
is not checked in order to get the correct cost for Item C you must open the quote for Item 
A and calculate, then open the quote for Item B and calculate, then open the quote for C 
and calculate. 

Note: The automatic calculations will only affect the actual items that are part of 
the current "tree" and not other quotes they may be attached to. 

Note: In order for this to work, 'Refresh Subcomponent Price Breaks' must be 
checked on the Default Values tab of Quote Parameters, and 'Use Master 
Inventory Std Cost for Component Pricing Instead of Price Breaks' must be 
unchecked on the General tab of Quote Parameters. 

Note: If the 'Calculate All Levels' parameter is not checked as the default in Rates 
and Parameters, for multiple levels to be calculated each higher level quote that is 
part of the tree will need to have the 'Calculate All Levels' option is set to Yes.  For 
example, Item C consumes Item B, which consumes Item A; if the 'Calculate All 
Levels' option is set to Yes on C, but not B, then the system will only calculate C and 
B, but not A.  

Include Machine 
Startup in VGM/Hr & 
Net Value/Hr 

By default, Machine Start Up Hours will be excluded from the VGM/Hr and Net 
Value/Hr calculations. To include Machine Start Up in those calculations check this box.  

The calculation for Net Value/Hr with Machine Start Hours included is:  

▪ Net Value/Hr = [(((Total Revenue - (Extra Charges + Material Cost + Prod Labor + Setup 
Labor)) / Quote Qty) * (3600/Cycle Time) * (1-Scrap Rate) * (Eff Factor %) * Units per Cycle] 
+ (Machine Startup Hours) 

The calculation for VGM/Hr with Machine Start Hours included is: 

▪   VGM/Hr = (((Total Revenue - Commissions) - Prod Cost - Operation Cost - Material Cost) + 
(Fixed Machine Rate * Prod Hrs)) / (Total Amount - Commissions) / (Prod Hrs + Machine 
Startup Hours) 

Include Machine 
Setup in VGM/Hr & 
Net Value/Hr 

By default, Machine Setup Hours will be excluded from the VGM/Hr and Net Value/Hr 
calculations. Check this box to include Machine Setup Up in those calculations.  

The calculation for Net Value/Hr with Machine Setup Hours included is:  

▪ Net Value/Hr =  (((Total Revenue - Commissions) - Prod Cost - Operation Cost - Material 
Cost) + (Fixed Machine Rate * Prod Hrs)) / (Total Amount - Commissions) / Prod Hrs + 
(Machine Setup Hours) 

The calculation for VGM/Hr with Machine Setup Hours included is: 

▪  VGM/Hr = (((Total Revenue - Commissions) - Prod Cost - Operation Cost - Material Cost) + 
(Fixed Machine Rate * Prod Hrs)) / (Total Amount - Commissions) / (Prod Hrs + Machine 
Setup Hours) 
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Both Options 
checked 

If both options are checked both the Machine Startup Hours and Machine Setup Hours will 
be added to the calculations: 

▪ Net Value/Hr = [(((Total Revenue - (Extra Charges + Material Cost + Prod Labor + Setup 
Labor)) / Quote Qty) * (3600/Cycle Time) * (1-Scrap Rate) * (Eff Factor %) * Units per Cycle] 
+ (Machine Setup Hours + Machine Startup Hours ) 

▪ VGM/Hr =  (((Total Revenue - Commissions) - Prod Cost - Operation Cost - Material Cost) + 
(Fixed Machine Rate * Prod Hrs)) / (Total Amount - Commissions) / (Prod Hrs + Machine 
Setup Hours + Machine Startup Hours) 

Adding and Deleting 
Quote Quantities 

To add additional quote quantities to the table, click on the Add [+] key on the Navigator bar 
directly above the table. Enter in the new quantity (and markup percentages if fixed) and 
Save the change. 

To edit, select the appropriate markup percentage table and click on the field to edit. 

Quantities and percentages can be deleted from this section by highlighting the quantity to 
be deleted and clicking on the Delete [-] key on the Navigator bar directly above the table. 

Material Markup Not 
Compounded 

This check box controls whether a manufactured sub-component is marked up again when 
it is used as a component in a higher level BOM. If checked, the lower level materials that 
make up the subassembly will NOT be marked up again. If you wish to use this option, place 
a check mark in the box in front of the Material Markup Not Compounded field. 

Optimized If the quote has been optimized in the past, a check mark will be present in the 'Optimized?' 
box. If the box is blank, the quote has not been optimized. See Optimizing the Quote for 
more information. 

Decimal To change the precision of the decimal display (the system defaults to two decimal places), 
enter the number of decimal places to display and save the change. The new values will be 
displayed automatically. The maximum number of decimals is six. 

Margin Display The user has the option of being able to calculate the quote using either Markup % or Gross 
Profit Margin %. (Refer to the General Tab for more information). 

Markup By EnterpriseIQ allows the user to calculate production and material markup rates by 
percentage or points. When creating a quote, the user can accept the default as setup 
under 'Rates and Parameters' or override the default for each individual quote by selecting 
one of these two options. 

▪ Percentage - Takes a percentage of the cost, and adds that value back to the original. 

Example: 
A 25% markup on a Prod Cost of $1.00 
Total Prod = [($1.00 x .25) + $1.00] = $1.25 
Prod Markup = ($1.25 - $1.00) = $0.25 

▪ Points - Increases the total cost by the percentage used by dividing the cost by the inverse 
of the percentage listed. 

Example: 
A 25% markup on a Prod Cost of $1.00 
Total Prod = [1.00 / (1 - 0.25)] =  $1.333 
Prod Markup = ($1.333 - $1.00) = $0.333 
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Markup Examples 

Use the examples below to help understand the calculations. The information displayed in both 
examples are limited to a Quote Quantity of 500 units. 

EXAMPLE 1 - Using Percentages 

For this example, the 'Fixed Production Markup Table' was selected. 
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The markup on a Quote Quantity of 500 is as follows: 

      Prod Markup = (Prod Cost * (FixPtsMarkup / 100) = (172.71 * 0.6) 
      Prod Markup = 103.63 
      Total Prod Cost = Prod Cost + Prod Markup = (172.71 + 103.63) 
      Total Prod Cost = 276.34 

 EXAMPLE 2 -Using Points 

Again, the 'Fixed Production Markup Table' was selected. 

 

The markup on a Quote Quantity of 500 is as follows: 

      Total Prod Cost  = Prod Cost / (1 - (FixPtsMarkup / 100)) = (172.71 / 0.4) 
      Total Prod Cost = 431.78 
      Prod Markup = Total Prod Cost - Prod Cost = (431.78 - 172.71) 
      Prod Markup = 259.07 

Note: If the Production Markup table percentage shows 60%, the inverse of the cost percentage would 
be 40%. 

Note: If calculating markup is by points, and the user enters a MU% of 100 the system will present an 
error that the system is attempting to divide by zero.  By definition, markup calculated by points would 
not allow for a markup of 100%.  The error that will appear is: 'Markup by points, Invalid Prod MU% 
and/or Mat. MU% for Quote Qty ### - Operation aborted'. 
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Optimizing the Quote 

The system allows quotes to be optimized by Price, Percent, Margin, Yield/Hr, VGM Amount, VGM/Hr, 
and Net Value/Hr. The optimization process allows the user to input values for each of these criteria and 
then calculate the markups and prices and fine tune the final price for the item. 

Once the quote is optimized, the optimized percentage is displayed at the top of the calculations screen. 
The optimized percentage is the percent of change between the original calculated unit price and the 
new optimized unit price. 

To optimize a quote: 

➢ On the Calculations screen, right click within the Calculations Display screen (right side) and 
select Optimize... from the submenu, or click on the Optimize button at the top of the 

screen. The system will remember the last option that was used when exiting and going 
back into the optimization screen.  

Seven methods of optimization are available: 

▪ Price -  Directly inputs the quote price. Note: if the quote is for a family tool the price for the 
individual items can be optimized by selecting the individual pricing option. (See Individual Pricing in 
the Other Calculation Options section for more details). 

▪ Percent - Raises or lowers the quote price by the percentage input. 

▪ Margin - Changes the Total Margin or Sales Margin directly which also changes the quote price. 

▪ Yield/Hr - Optimize the quote price by yield/hr. 

▪ VGM Amount - Optimizes the quote calculations based on the VGM Amount. 

▪ VGM/Hour- Optimizes the quote calculations based on the VGM/Hour. 

▪ Net Value/Hr - Optimizes the quote calculations based on the Net Value/Hr. 
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Any combination of optimization methods may be used. For example, one Quote Quantity can be 
optimized by Price and then a second quantity can be optimized by the Margin and any others by 
Percent. 

As you optimize, the optimization percentage is recalculated and displayed under the Optm % Markup 
column. 

Note: When performing the optimization calculations, the system applies the commission value after the 
optimization is calculated for price per unit. Refer to the Calculation Example section for details on the 
calculations. 

After optimizing the quote, the changes are saved to the quote database and the Optimize? box will 
contain a check mark showing that the quote has been optimized. If the user attempts to recalculate, a 
warning message will appear as follows: 

 

If 'Yes' is selected, it will remove the optimization and recalculate the pricing. Any changes made to the 
quote will be reflected in the new calculation. 
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Advanced Optimization 

Advanced Optimization is a customizable optimization tool that provides users with the ability to quickly 
evaluate profitability and competitive pricing by choosing the calculations and variables to include in the 
optimization process. To access this module, right click on the Quote->Calculations tab or select the 
'Advanced Optimization' option from the drop down list next to the 'Optimize speed button on the 

Calculation tab.  

When the form is first accessed the Calculation grid will display the current calculations from the 
Engineering Quote->Calculation Tab. The system uses the same decimal precision setup in Engineering 
Quotes -> Calculation tab. The Optimization fields will be null. When the form is accessed again the 
system will remember the values in the editable fields.  
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Note: Users cannot access the Advanced Optimization form if another user is in the form on the same 
quote. A 'Failed to acquire exclusive lock' message will display to the user who has locked the record. 

Select Fields 

Multiple 'Fields Sets' can be created that will determine the fields that display in the grid. Click the 'Select 
Fields' button next to the 'Field Set' field to access the 'Select Fields' form. 

 

1 Select the + button to create a new 'Field Set' and enter the name of the set in the field.  

2 Choose the desired fields to be included from the 'Available Fields' list and arrow them over to the 
'Selected Fields' list using the single right arrow button. The Shift/Ctrl keyboard buttons can be used 
to select multiple fields at once. All fields can be added using the double right arrow button.  

3 All fields or individual fields can be removed from the 'Selected Fields' section by using the left arrow 
buttons.  
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4 If the user is highlighted on a field in the 'Available Fields' section that may change based on EPlant, 
MFG Type or Calculations Parameters, a hint will display on the bottom of the 'Select Fields' form, 
"The Field Set label may change based on EPlant Login, Manufacturing Type and Calculations 
Parameters." 

5 The order of the fields can be changed by dragging and dropping a field into the desired place. The 
fields will display on the Advanced Optimization screen in the order they have been established here. 

6 Once all of the 'Selected Fields have been chosen click the 'Select Field Set' button. The Advanced 
Optimization grid will populate with the selected fields and their values. 

Follow the steps above to create additional 'Field Sets', or use the 'Clone' option to clone a field set and 
modify it. 

Clone - Fields Sets can be cloned by highlighting a 'Field Set', right clicking and selecting 'Clone'. A new 
'Field Set' will be created with the same name as the highlighted one. The name can be changed, and the 
fields associated to the 'Field Set' can be modified. 

Note: If a user later changes a calculation parameter or radio button that could affect the Advanced 
Optimization form field set labels, the system will automatically change the field set labels. For example, 
the Margin Display field will change based on the parameter that is checked. It will be either 'Gross Profit 
Margin %' or 'Markup %'. 

Note: Another example is if the Calculation Parameters for 'Fixed Production Markup' is checked, the 
field will change from 'Tbl % Markup' to 'Fix % Markup'. If these fields are part of the field set it is 
recommended to include the 'Material Cost' and 'Prod Cost' fields so you know how they are being 
marked up (Fixed or Table). 

Field Set Selection 

From the Advanced Optimization form select the field set to view from the drop down list in the Field Set 
field. If a field set is selected that does not have any fields, the calculation grid in the Advanced 
Optimization screen will not display any fields. 

Optimizing the Quote  

To optimize the quote enter values in the fields below: 

Quote Quantity This is a drop down menu based on the Quote Quantities assigned to the quote in the 
Markup Table on the Engineering Quotes -> Calculations tab. (The Quote Qty can only be 
whole numbers,  no decimals). 

Optimization By This is a drop down list that includes all of the optimization methods: Price, Percent, 
Margin, Yield/Hour, VGM Amount, VGM/Hour, and Net Value/Hour.  

Starting Value This is a free form field to define which value you want to optimize by. This will set the 
'middle' ground from which the system will increment by based on the values entered in 
he 'Increment Type' and 'Increment Value' fields. 

Increment Type This is a drop down list with Percentage or Flat Amount. This is used to define how to 
increment in both directions.  
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Increment Value This is a free form field that defines how much to increment in either direction based on 
the starting value.  

Number of 
Increments (+/-) 

This is the number of increments in either direction. The max is 4 and must be a whole 
number. 

Populate the fields above and select the 'Calculate' button. The form will display the advanced 
optimization calculations based on the values in the optimization fields. The starting value column will be 
highlighted in yellow. The 'Optimize By' field will be highlighted in blue. The Quote Quantity field cannot 
be edited. 

Note: The user will receive an error stating, "Field set and all optimization values must be selected" if all 
of the fields are not populated or there is not a field set. 
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If the values in the optimization fields are changed, select the 'Calculate' button to update the 
calculations. 

After optimizing the quote, users can decide which column they would like to commit to the Calculation 
screen by clicking the 'Select' button for the column to commit. A confirm message with 'Yes' and 'No' 
buttons will display stating, "Apply the calculated Advanced Optimization?" Selecting 'Yes' will close the 
Advanced Optimization form and update the calculations screen to display the optimized values for the 
quote quantity that was optimized. This will check the 'Optimized?' check box on Engineering Quotes-
>Calculation tab. Selecting 'No' on the message will return the user to the Advanced Optimization form 
with no changes made to the Quote Calculations tab. 

Export 

Users can export the optimized calculations by selecting the 'Export' menu option. This is similar to the 
'Print RFQ' button on the Calculations tab. This will print a report of the general quote information 
including labor, material, blend details, part information, and the calculation information from the 
Advanced Optimization form currently open. This report is hard coded into the system, it is not a Crystal 
Report and therefore cannot be edited. However, it will also create an Excel spreadsheet which by 
default is saved in the local home folder in a sub-folder named rfq_print. The location where these are 
saved can be changed by setting the location from the RFQ Print -.xls Destination option available from 
the Miscellaneous menu. Once this option is selected the user will see the spreadsheet briefly appear 
then a Print box will come up to choose the printer to send the report to or cancel if a hard copy is not 
desired. 

Note: This feature requires that Microsoft Excel is installed on the computer. If it is not installed, when 
selecting the Export menu, a message will appear stating"Microsoft Excel is required". 
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Calculation Example 

After a quote has been calculated, the data is displayed in the right hand portion of the Calculations 
screen, referred to as the ‘Calculation Display’ screen. The calculation process goes through a series of 
operations to arrive at a quote price. EnterpriseIQ uses the price breaks on the manufactured 
components, includes the costs for inserts and packaging, and includes markups and commissions. The 
table below shows how EnterpriseIQ calculates each of the fields in the ‘Calculation Display’ screen. 

Calculation Display example 
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Calculation Samples 

The calculation samples provided below are based on both the Calculation Display information and the 
Production Summary screen (shown above) and are limited to a Quote Quantity of 1000 units only. All 
percentages or amounts shown in the calculated fields have been rounded off.  

To help understand how the calculations were reached in the Calculation Display screen, use the 
information shown in the two screen shots above, plus the following details: 

▪ The 'Markup By' is set to Percentage 

▪ Operators: One non setup operator ($15) and one setup operator ($20) 

▪ Dry Hours = 0 

▪ No Auxiliary Equipment attached 

The field listing below outlines and shows the calculations for each field: 
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Optm % MarkUp If a quote is Optimized, the resulting percent change is displayed here. The optimized 
percentage is the percent of change between the original calculated unit price and the new 
optimized unit price. The column will be blank if the quote has not been optimized. 

Example: 
The price is optimized from $1.00 to $1.25. The Opt % Markup field displays 25 indicating 
that the quoted price is 25% higher than the calculated price. 

All percentages are based on the calculated price. 

Unit Cost The cost to make the product per unit. 

Calculation: 

a.  Total Cost / Quote Quantity 
b.  320.96 / 1000 
Unit Cost = $0.3210 

Unit Price Suggested sales price per unit. 

Calculation: 

a. (Total Revenue / Quote Quantity) + Commission 
b. (480.10 / 1000) + 0.0240 
Unit Price = $0.5041 

Price/1000 The price for 1000 units of product. 

Calculation: 

a. Unit Price * 1000 

b. 0.5041 * 1000 
Price/1000 = $504.10 

Profit/Total Margin This will display either the Markup % or the Gross Profit Margin % depending on which 
option is selected in the Margin Display section on the Calculations Parameters screen. The 
default is set in Rates and Parameters.  

Calculation if Markup % is selected: 

a.  ((Total Revenue – Total Cost) / Total Cost) * 100 
b.  (480.10 - 320.96) / 320.96) * 100 

c.  (159.14 / 320.96) * 100 

Markup % = 49.58 

 

Calculation if Gross Profit Margin is selected: 

a.  ((Total Revenue – Total Cost) / Total Revenue) * 100 
b.  (480.10 - 320.96) / 480.10) * 100 

c.   (159.14 / 480.10) * 100 

Gross Profit Margin = 33.15 
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Cost % Total cost as a percent of the Unit Price. 

Calculation: 

a.  Total Cost / Total Revenue 
b.  320.96 / 480.10 * 100 

Cost % = 66.85 

Prod % The production costs as a percentage of the total price. 

Calculation: 

a.  Prod Cost / Total Revenue x 100 
b.  (194.65 / 480.10) * 100 
Prod % = 40.54 

Material % The material costs as shown as a percentage of the total price. 

Calculation: 

a.  Material Cost / Total Revenue * 100 
b.  (26.31 / 480.10) * 100 
Total Material % = 5.48 
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Net Value/Hr This is the effective hourly press rate, after removing extra charges, materials and labor. It 
is calculated by taking the Total Revenue less Extra Charges, Material Cost, Production 
labor and Setup labor then dividing by the quote quantity, and multiplying by the net 
cycles per hour [which is calculated: (3600 / (cycle Time)) * (1-Scrap Rate percentage) * 
(Efficiency Factor)] times the units per cycle. 

Calculation: 

a.  (((Total Revenue - (Extra Charges + Material Cost + Prod Labor + Setup Labor)) / Quote 
Qty) *                          (3600/Cycle Time) * (1-Scrap Rate) * (Eff Factor %) 
* Units per Cycle 
b. (((480.10 - (100 + 26.31 + 36.90+ 40.00) / 1000) * ((3600/16) (1 - 0.05) (0.95)) * 2 

c.  ((276.89 / 1000) * (225 * 0.95 * 0.95) * 2) 

d.   (0.27689 * 203.06) * 2 

Net Value/Hr = 112.44 

If the Calculation Parameters 'Include Machine Startup in VGM/Hr & Net Value/Hr' and 
'Include Machine Setup in VGM/Hr & Net Value/Hr' are checked the calculations will 
include those values. 

Calculation: 

a.  (((Total Revenue - (Extra Charges + Material Cost + Prod Labor + Setup Labor)) / Quote 
Qty) *                          (3600/Cycle Time) * (1-Scrap Rate) * (Eff Factor %) 
* Units per Cycle  + (Machine Setup Hours + Machine Startup Hours) 
b. (((480.10 - (100 + 26.31 + 36.90+ 40.00) / 1000) * ((3600/16) (1 - 0.05) (0.95)) * 2 + 2 + 
0.25 

c.  ((276.89 / 1000) * (225 * 0.95 * 0.95) * 2) + 2.25 

d.   (0.27689 * 203.06) * 2 + 2.25 

Net Value/Hr = 114.70 

Note: If the 'Exclude Efficiency Factor from Cost Calc' setting is checked (Rates and 
Parameters->Default Values tab) the system will exclude the quote efficiency 
factor in the calculation. The system will use an efficiency factor of 100 rather 
than the Quotes efficiency factor.  

Yield/Hr The total yield per hour for the Quote Quantity. Essentially the amount made per hour 
after material costs (raw material, components, and packaging) and commissions, but 
before labor costs. 

Calculation: 

a.  (Total Revenue - Material Cost - Commissions) / Prod Hours 
b.  (480.10 - 26.31 - 0.024) / 2.46 
Yield/Hr = 184.47 
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Prod Hrs Production Hours required for the Quote Quantity. 

Calculation: 

a.  (Qty / (3600 / Cycle Time)) / (1 - Scrap %) / (Eff Factor %) / (Units per Cycle) 
b.  (1000 / (3600 / 16)) / (1 - 0.05) / (0.95) / 2 

c.  (1000 / 225) / (0.95) / (0.95) / 2 
d.  (4.44 / 0.95 / 0.95) / 2 
e.  4.924 / 2 
Prod Hrs = 2.46 

Note: If the 'Exclude Efficiency Factor from Cost Calc' setting is checked (Rates and 
Parameters->Default Values tab) the system will exclude the quote efficiency 
factor in the calculation. The system will use an efficiency factor of 100 rather 
than the Quotes efficiency factor.   

Extrusion MFG Type Calculations: 

For Extrusion manufacturing types the calculation for Prod Hrs differs slightly.  

EXT MFG Type:  

(Quote Qty * Part Length) / ((Ft. Lb * Lbs/Hr)  x (1 - Scrap %) x Eff Factor %) 

EXT2 MFG Type: 

Quote Qty / Lbs/Hr / (1 - Scrap %) / Eff Factor % 

EXT3 MFG Type: 

Quote Qty * Part Weight / Lbs/Hr / (1 - Scrap %) / Eff Factor % 

Oper Hrs Total number of operator hours required for production. 

Calculation: 

a.  Production Hours * [sum(non setup operators) + Setup Hours * sum(setup operators)] 
b.  (2.46 * 1) + (2 * 1) 
Oper Hrs = 4.46 

Prod Labor Total Production Labor 

a.  Production Hours * sum(non setup operators) * Labor Rate 

b.  (2.46 * 1) * 15 

Prod Labor =  36.90 

Setup Labor Total cost for setup labor. 

Setup Hours * sum(setup operators) * Labor Rate 

(2 * 1) * 20 = 40.00 
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Overhead The total overhead costs.  

(Production Hrs + Start Hrs + Dry Hrs + Setup Hrs) * (Work Center Rate + Auxiliary 
Equipment Rate) 

(2.46 + .25 + 0 + 2) * (25 + 0) = 117.75 

MFG Type Overhead set to Labor: If the Overhead calculation option for the Manufacturing 
Type is set to ‘Labor’ the calculation will use the Labor Rate setup on the Manufacturing 
Type screen to calculate the Prod Cost instead of the Total Center Rate. It also considers 
the number of non set up type operators.  It will still use the Center Rate for Setup Hours.  

Example: Labor Based rate = 50; Non Setup operators = 1 

(((2.46 + .25 + 0) *1) *50) + (2 * (25 + 0)) = 185.50 

Dry Hrs Total number of hours needed for drying this item. 

Note: Dry Time is included in the calculation for Total Production Hours (TPH). 

Calculation: 

a.  Weekly Dry Hours * Production weeks 
b.  0 * 1 
Dry Hrs = 0 

Start Hrs The number hours required to “dial in” a tool based on the Start/Cycles. This value will 
effect the amount of material required as well as the Total Production Hours. Each week of 
production will include the start up hours. For example, when the production hours 
exceeds 168 (24 * 7) the start up hours will be doubled. 

Calculation: 

a.  (Start Cycles / (3600 / Cycle Time)) / (Eff Factor%) / (1-Scrap %) 
b.  (50 / (3600 / 16)) / (0.95) / (1 - 0.05) 
c.  (50 / 225) / (0.95 / (0.95) 
d.  0.2222 / 0.95 / 0.95 
Start Hours = 0.25 

Note: If the 'Exclude Efficiency Factor from Cost Calc' setting is checked (Rates and 
Parameters->Default Values tab) the system will exclude the quote efficiency 
factor in the calculation. The system will use an efficiency factor of 100 rather 
than the Quotes efficiency factor. 
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Prod Cost The total production cost for the Quote Quantity. Based on the Total Production Hours 
(TPH) for the job.  

This calculation used for Prod Cost depends on whether the quote has operators (labor) 
associated with it. 

Calculation with Labor: 

a.  (TPH * Total Center Rate) + (Prod Hrs * Prod Labor Rate) + (((Setup Operator Quantity 
* Labor Rate) * Setup Hours)  +  (Total Center Rate * Setup Hours)) 

b.  (2.71 * 25) + (2.46 * 15.00) + (((1 x 20) * 2) + (25 * 2)) 

c.  (67.75) + (36.90) + (40 + 50) 

Prod Cost = 194.65 

With Labor the calculation for TPH = Prod Hrs + Dry Hrs + Start Hrs 

           2.46+ 0.00 + 0.25 = 2.71 

Total Center Rate = Work Center Rate + Auxiliary Equipment Rates. (25 + 0) = 25 

 

Calculation without Labor: 

a.  (TPH * Total Center Rate) 

b.  (4.71 * 25) 

Prod Cost = 117.75 

Without Labor the calculation for TPH = Prod Hrs + Dry Hrs + Start Hrs + Setup Hrs 

           2.46+ 0.00 + 0.25 + 2 = 4.71 

 

Notes:  

▪ MFG Type Overhead set to Labor: If the Overhead calculation option for the 
Manufacturing Type is set to ‘Labor’ the calculation will use the Labor Rate setup 
on the Manufacturing Type screen to calculate the Prod Cost instead of the Total 
Center Rate. 

▪ When adding labor, in order to have Setup hours included in the quote users must 
have an employee level with a labor type of Setup associated to the quote also. 
This designates the setup labor cost. 

▪ Quotes that existed before the addition of employee levels will calculate the old 
way: (TPH x Total Center Rate) + (Oper Hrs x Labor Rate), unless a change is made 
to employee levels. 

▪ Labor Based Rate Fixed rate entered on the Labor/Overhead tab of the 
Manufacturing type is not currently used in an Engineering Quote calculation for 
Prod Cost.  Variable rate can be used. 

▪ If the 'Exclude Overhead from Setup Cost Calculation' is checked (in System 
Parameters->Inventory Setup tab) the system will not add the work center rate 
times the setup hours to the calculation. In the example with labor the calculation 
would be:   
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a.  (TPH * Total Center Rate) + (Prod Hrs * Prod Labor Rate) + (((Setup Operator Quantity 
* Labor Rate) * Setup Hours) 

b.  (2.71 * 25) + (2.46 * 15.00) + (((1 * 20) * 2) 

c.  67.75 + 36.90 + 40 

Prod Cost = 144.65 

Operation Cost The cost of attached operations. Operation Details (Item Details tab)->Calc Cost. 

a. Operation calc cost * Qty 

Example: 

Cycle Time of operation = 20 seconds 

Rate = 10 

Calc Cost = (20/3600) * 10 = .055556  

Prod MarkUp The amount the production is being marked up. 

Percentage Calculation: 

a.  Prod Cost * (% Markup/100) 
b.  (194.65) * (0.75) 
Prod MarkUp = 145.99 

Total Prod Cost The total production amount, including markup. 

Calculation: 

a.  Prod Cost + Operation Cost + Prod MarkUp 
b.  (194.65 + 0 + 145.99) 
Tot Prod Cost = 340.64 

Tbl % MarkUp or 
Fixed MarkUp 

The production markup percentage as specified in the Calculation Parameters section. 



Quoting Page 102 of 220 

 

Lbs Req The total pounds of raw material required to produce the Quote Quantity. 

Please see Calculations for LBS/K Cycles at the end of this field listing to see details on how 
to calculate this figure. 

The 'LBS/K-cycles' and 'Shot Wt(lbs)' are displayed on the Production Data Summary form 
(right click and select 'Display Production Data'). 

Calculation: 

a.  ((LBS/K-cycles / units per cycle) / 1000) * Qty + ((Start/Cycles * Lbs. per shot ) * unit 
per cycle) 
b.  ((15.26 / 2) / 1000) * 1000) + ((50 * .015256) * 2) 
c.  7.63 + 0.7628 
Lbs Req = 8.39   

Note: Start Cycles are added to the Lbs Required calculation for every 168 hours 
(24 hours x 7 days) of Prod Hrs. 

Note: For Thermoform and TFORM2 MFG Types: The Lbs Req. is based on the 
Costing weight. The costing weight includes the By-product unless the 'Exclude By-
product' options is checked on the Calculations tab. 

Cost/Lb Total cost per pound is taken from the price break information for the attached material. 
The price break used is based on the quantity of material required. 

Plastic Cost Total cost of plastic for the Quote Quantity. 

Calculation: 

a.  Lbs. Req * Cost per Lb. 
b.  8.39 * 2.45 
Plastic Cost = 20.56 

Note: For Stamping and Diecast Mfg Types this field will be called Main Material 
Cost. 
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Comp. Cost Total Cost of components needed for this quoted quantity. Pricing is based on default price 
breaks and number of units required. The units required takes into consideration the scrap 
percentage associated to the component if any. 

The example calculation above does not have a component attached. 

Additional Example: 

Quantity required per item = 1, Scrap value =10%, Component price break = 0.50 quote 
quantity of 1000 

Calculation: 

a. (Quote Qty * 1 + Scrap Percentage) * component cost 

b. (1000 * 1.10) * 0.50 

Comp. Cost = 550.00 

If the Attached Components Scrap Calculation in Rates and Parameters is set to 'Based on 
(1/1-Scrap)', the calculation would be: 

a. (1000 * (1/1-0.10)) * 0.50 

b. 1000 * 1.11111 * 0.50 

Comp. Cost = 555.5556 

Pkg Cost Total Packaging cost for the quoted quantity. Pricing is based on default price breaks and 
number of units. The items required takes into consideration the scrap percentage 
associated to the packaging item if any. The system will round up to the nearest whole 
packaging item required and multiply times the cost to determine total Pkg Cost. 

For the calculation display example above parts per carton = 1000 and parts per divider = 
100: 

1 carton at 0.75 = 0.75 

10 dividers at .50 = 5.00 

Pkg Cost  = 5.75 

Additional Example: 

Parts per packaging item = 580, Scrap % = 10, quote qty = 10000, cost = 0.25 

((Quote Qty/parts per) * 1+ Scrap %) * pkg cost 

((10000/580) * 1.1) * 0.25 = 19 * 0.25 = 4.75 

Note the pkg req’s are rounded up to a whole pkg item. In this example 18.97 is rounded 
up to 19. 

Outsource Cost This is the outsource cost calculated from the Quantity Price Breaks entered in the 'Part 
Information' section for outsource items. 

Calculation: 

Quote Qty * Associated price break's price. 
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Material Cost Total cost of material for this quoted quantity. 

Calculation: 

a.  Plastic Cost + Comp Cost + Pkg Cost 
b.  20.56 + 0 + 5.75 
Material Cost = 26.31 

Note: For Stamping and Diecast Mfg Types the calculation is: Main Material Cost + 
Comp Cost + Pkg Cost 

Material MarkUp The amount the materials are being marked up. 

Calculation: 

a. Material Cost * (% Markup / 100) 
b.  26.31 * (0.50) 
Material MarkUp = 13.15 

Total Matrl Cost The total material amount, including markup. 

Calculation: 

a.  Material Cost + Material MarkUp 
b.  26.31 + 13.15 
Total Matrl Cost = 39.46 

Fix or Tbl % MarkUp The material markup percentage as specified in the Calculation Parameters section. 

Extra Charges Additional charges not accounted for in the normal quote input screen such as extra 
shipping charges, mold maintenance, color changes, etc. See the section on Extra Charges 
for more information. 

Extra charges = 100.00 

Commissions Sales commissions will be added into the item price based on Total Price or Gross Margin 
and one of two calculations. (See the Commissions section for more details). 

Calculation: 

a.  Total Price: Total Revenue / Qty * Commission%/100 
b.   480.10 / 1000 * 0.05 
c.   0.02400 

Total Revenue Total Revenue for the Quote Quantity including the Optm % MarkUp (top row). 

Calculation: 

a.  (Total Prod Cost + Total Matrl Cost + Extra Charges) * 
     (1 + (Optm % MarkUp / 100)) 
b.  (340.64 + 39.46 + 100.00) * (1 + (0/ 100)) 
c.  480.10 * 1 
Total Revenue = 480.10 
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Total Cost The Total Cost to produce the Quote Quantity (break-even). 

Calculation: 

a.  Prod Cost + Material Cost + Extra Charges 
b.  194.65 + 26.31 + 100 
Total Cost = 320.96 

Total Profit Total Profit that will be made on the Quote Quantity. 

Calculation: 

a.  Total Revenue - Total Cost 
b.  480.10 - 320.96 
Total Profit = 159.14 

VAP% Value Added percentage. 

Calculation: 

a. Total Profit / (((Unit Price - Commissions) * Qty) - Material Cost) 

b. 159.14 / (((0.5041 - 0.0240) * 1000 pcs.) - 26.31) 

c. 159.14 / 453.79 

VAP% = 35.07% 

VGM% Variable Gross Margin percent. 

Calculation: 

a. (((Total Revenue - Commissions) - Prod Cost - Operation Cost - Material Cost) + (Fixed 
Machine Rate * Prod Hrs)) / (Total Revenue - Commissions) * 100 

b. ((480.10 - 0.0240) - 194.65 - 0 - 26.31) + (10 * 2.46) / (480.10 - 0.0240)  

c. 259.11 + 24.60 / 480.07 

VGM% = 59.10% 

Note: The VGM% field is not calculated for ASSY1, ASSY2, ASSY3, and OUTSOURCE 
MFG Types. 

VGM Amount Variable Gross Margin amount. 

Calculation: 

a.  (((((Total Revenue - Commissions) - Prod Cost - Operation Cost - Material Cost) + (Fixed 
Machine Rate * Prod Hrs)) / (Total Revenue - Commissions) * 100) / 100) * Unit Price * Qty. 

b. ((480.10 - 0.0240) - 194.65 - 0 - 26.31) + (10 * 2.46) / (480.10 - 0.0240) * 0.504103 * 
1000 

c. (259.116 + 24.60 / 480.07) * 0.504103 * 1000 

VGM Amount = 297.9177 

Note: The VGM Amount field is not calculated for ASSY1, ASSY2, ASSY3, and 
OUTSOURCE MFG Types. 
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VGM/Hr Default calculation for Variable Gross Margin per Hour 

Calculation: 

a. (((Total Revenue - Commissions) - Prod Cost - Operation Cost - Material Cost) + (Fixed 
Machine Rate * Prod Hrs)) / (Total Revenue - Commissions) * (Unit Price * Qty) / Prod Hrs 

b. ((480.10 - 0.0240) - 194.65 - 0 - 26.31) + (10 * 2.46) / (480.10 - 0.0240) * (0.504103 * 
1000)  / 2.46 

c. (((259.116 + 24.60) / 480.07) * 504.103)  / 2.46 

VGM/Hr = 121.10 

If the Calculation Parameters 'Include Machine Startup in VGM/Hr & Net Value/Hr' and 
'Include Machine Setup in VGM/Hr & Net Value/Hr' are checked the calculations will 
include those values. 

(((Total Revenue - Commissions) - Prod Cost - Operation Cost - Material Cost) + (Fixed 
Machine Rate * Prod Hrs)) / (Total Amount - Commissions) / Prod Hrs + (Machine Setup 
Hours + Machine Startup Hours) 

b. ((480.10 - 0.0240) - 194.65 - 0 - 26.31) + (10 * 2.46) / (480.10 - 0.0240) * (0.504103 * 
1000) / (2.46 + 2 + 0.25) 

c. (((259.116 + 24.60) / 480.07) * 504.103) / 4.71 

VGM/Hr = 63.252 

Note: The VGM/Hr field is not calculated for ASSY1, ASSY2, ASSY3, and 
OUTSOURCE MFG Types. 

By-product Qty For Thermoform and TFORM2 MFG Types only:  

By-product quantity * Quote Qty 

Skeleton Cost For Thermoform and TFORM2 MFG Types only:  

Skeleton Weight * Cost/Lb 

 
 

Calculations for LBS/K 

The following chart explains the calculations used by EnterpriseIQ in figuring the pounds of material 
required per thousand cycles (LBS/K). 

 

Runner & Sprue = 2 gr. 

Scrap % = 5% 

Yield = (100 - Scrap) / 100 

Cav. Weight = 3 gr. NOTE, if you have a quote with more 
than one item attached, each item will need to 
be summed up separately (individually). 
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Regrind % = 20% (See below for the formula that includes 
zero regrind %) 

AB = AA x (Regrind % / 100) 

Units per Cycle = 4 

Cavities = 4 

AA = (Cav x Part Weight + (Runner/Sprue)) / Yield 

 

If Regrind = 0% then the following formula would apply: 

((Cav x Part Weight) + Runner & Sprue) / Yield x 1000 / 453.6 

Regrind generated per 1000 item run 

(AA - (Cav. x Cav. Weight)) x 1000 / 453.59 

If Regrind is >0% then one of the following formulas would apply depending on the comparison of shot 
weight less the shot weight times the regrind % to the cavity times part weight: 

If (AA - AB) < (Cav x Part Weight) then BB = (Cav x Part Weight) + (Sprue x defined percent of runner and 
sprue*) 

or 
If (AA - AB) > (Cav x Part Weight) then BB = AA - AB 

* The Defined percentage of runner and sprue can be set up for Injection and Diecast MFG Types, and for 
Custom MFG Types that default to Injection and Diecast, from Mfg Types->File menu->Alter LBS/K 
Calculation. (See Alter LBS/K Calculation in the Manufacturing Types section). The default is 10%. 

The first calculation checks to see if the Shot Weight less the Shot Weight times the Regrind Percentage 
is LESS than the Cavity weight total. If so, then the new Shot Weight (BB) will be equal to the total cavity 
weight plus the runner/sprue weight times defined percent of runner and sprue*. If not, then the second 
formula is invoked. 

BB X 1000 / 453.6 / Units 
 

Regrind generated per 1000 item run 

(BB - (Cav x Part Weight)) x 1000 / 453.59 
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Individual Pricing 

For a quote with more than one item number, this allows viewing and optimizing of the price and 
viewing of cost information for each item produced in the process, as shown below: 
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To access this option select the Individual button  near the top of the calculations tab. 

The individual prices and costs will display. The user can Optimize the price for an individual item by 
typing over the calculated price. The new pricing will be summed up to the total unit price. The 
optimized individual pricing will be carried over to inventory when the RFQ is converted to a BOM. 

Select the item number from the upper display grid to display the price and cost information on a per 
item basis. 

The calculation used depends on the Quotation Parameter 'Overhead Calculation (Family 
Configurations)' (Quotation Parameters->General tab). 

The Quotation Parameter 'Overhead Calculation (Family Configurations)' is set to:  'Based on total 

number of cavities'  
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Unit Cost The cost to make the product per individual item. 

Example scenario: 

▪ Family tool with two items 

▪ Item A has 2 std cavities 

▪ Item B has 3 std cavities 

▪ Units/Cycle = 2 

Calculation when 'Based on total number of cavities' is checked: 

Unit Cost = (((Prod Cost  + Raw Material Cost + Extra Charges + Operation Cost) - Prod 
Cost) / (Std Cav/Units per Cycle) + Prod Cost / Quote Quantity 

Example Item B for Quote Qty of 100: 

a. ((((63 + 167.365 + 50 + 0) - 63) / (3/2)) + 63) / 100 

b. (((280.365 - 63) / 1.5) + 63) / 100 

c.  ((217.365 / 1.5) + 63) / 100 

d.  207.91 / 100  

e.  2.0791 

Raw Material Cost per item = ((Total Lbs Req *  (Std Cav for item/Total Cavities)) * 
Cost/LB) + Components and Packaging assigned to item 

Raw Material Calculation for Item B:  

a. ((374.99 * (3/5)) * 0.6672) + 17 + 0.25 

b. ((374.99 * 0.60) * 0.6672) + 17 + 0.25 

c. 224.994 + 17 + 0.25 

d. 150.115 + 17 + 0.25 

e. 167.365 

Prod Cost per item = Total Prod Cost * (Units per Cycle/Total Cavities) 

Prod Cost Calculation for Item B: 

a. 157.50 * (2/5) 

b. 157.50 * 0.4 

c. 63 

Note:  

Total Lbs Req = Lbs Req from Calculations tab per quote quantity 

Total Prod Cost = Prod Cost from Calculations tab per quote quantity 
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Unit Price Suggested sales price per individual item. This value includes markup for production and 
materials if applicable. In this example the markup percent for both production and 
materials is 10% 

Calculation when 'Based on total number of cavities' is checked: 

Unit Price = (((Prod Cost  + Raw Material Cost + Extra Charges + Operation Cost) - Prod 
Cost) / (Std Cav/Units per Cycle) + Prod Cost / Quote Quantity 

Example Item B for Quote Qty of 100: 

a. ((((69.3 + 184.1015 + 50 + 0) - 69.3) / (3/2)) + 69.3) / 100 

b. (((303.4015 - 69.3) / 1.5) + 69.3) / 100 

c.  ((234.1015 / 1.5) + 69.3) / 100 

d.  225.3676 / 100  

e.  2.2537 

 

Raw Material Cost per item = ((Total Lbs Req *  (Std Cav for item/Total Cavities)) * 
Cost/LB) + Components and Packaging assigned to item + material mark up 

Raw Material Calculation for Item B:  

a. ((374.99 * (3/5)) * 0.6672) + 17 + 0.25) * 1.1 

b. ((374.99 * 0.60) * 0.6672) + 17 + 0.25 * 1.1 

c. 224.994 + 17 + 0.25 * 1.1 

d. 150.115 + 17 + 0.25 * 1.1 

e. 167.365 * 1.1 

f. 184.1015 

Prod Cost per item = Total Prod Cost * (Units per Cycle/Total Cavities) * 1+ production 
mark up 

Prod Cost Calculation for Item B: 

a. (157.50 * (2/5)) *  1.1 

b. (157.50 * 0.4) * 1.1 

c. 63 * 1.1 

d. 69.3 

 

Price/LBS The Price/Lbs field is calculated by taking the Unit Price and dividing by the weight of the 
individual part in pounds (no runner and sprue). 

a. 2.2537 / 1 

b. 2.2537 
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The Quotation Parameter 'Overhead Calculation (Family Configurations)' is set to: 'Based on unique item 

numbers' 
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Unit Cost The cost to make the product per individual item. 

Example scenario: 

▪ Family tool with two items 

▪ Item A has 2 std cavities 

▪ Item B has 3 std cavities 

▪ Units/Cycle = 2 

Calculation when 'Based on unique item numbers' is checked: 

Unit Cost = (((Prod Cost  + Raw Material Cost + Extra Charges + Operation Cost) / (Std 
Cav/Units per Cycle) / Quote Quantity 

Example Item B for Quote Qty of 100: 

a. ((78.75 + 167.365 + 50 + 0) / (3/2) / 100 

b. ((296.115 / 1.5) / 100 

c.  197.41 / 100  

d.  1.9741 

Raw Material Cost per item = ((Total Lbs Req *  (Std Cav for item/Total Cavities)) * 
Cost/LB) + Components and Packaging assigned to item 

Raw Material Calculation for Item B:  

a. ((374.99 * (3/5)) * 0.6672) + 17 + 0.25 

b. ((374.99 * 0.60) * 0.6672) + 17 + 0.25 

c. 224.994 + 17 + 0.25 

d. 150.115 + 17 + 0.25 

e. 167.365 

Prod Cost per item = Total Prod Cost /(# of unique items made/Std Cav) * Std Cav 

Prod Cost Calculation for Item B: 

a. (157.50 / 2) / 3 * 3 

b. 78.75 / 3 * 3 

c. 78.75 

Note:  

Total Lbs Req = Lbs Req from Calculations tab per quote quantity 

Total Prod Cost = Prod Cost from Calculations tab per quote quantity 
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Unit Price Suggested sales price per individual item. This value includes markup for production and 
materials if applicable. In this example the markup percent for both production and 
materials is 10% 

Calculation when 'Based on unique item numbers' is checked: 

Unit Price = (((Prod Cost  + Raw Material Cost + Extra Charges + Operation Cost) / (Std 
Cav/Units per Cycle) / Quote Quantity 

Example Item B for Quote Qty of 100: 

a. ((86.625 + 184.1015 + 50 + 0) / (3/2)) / 100 

b. (320.7265 / 1.5) / 100 

c.  213.818 / 100 

d.  2.1382 

Raw Material Cost per item = ((Total Lbs Req *  (Std Cav for item/Total Cavities)) * 
Cost/LB) + Components and Packaging assigned to item + material mark up 

Raw Material Calculation for Item B:  

a. ((374.99 * (3/5)) * 0.6672) + 17 + 0.25) * 1.1 

b. ((374.99 * 0.60) * 0.6672) + 17 + 0.25 * 1.1 

c. 224.994 + 17 + 0.25 * 1.1 

d. 150.115 + 17 + 0.25 * 1.1 

e. 167.365 * 1.1 

f. 184.1015 

Prod Cost per item = Total Prod Cost /(# of unique items made/Std Cav) * Std Cav * 1 + 
production mark up 

Prod Cost Calculation for Item B: 

a. ((157.50 / 2) / 3 * 3) * 1.1 

b. ((78.75 / 3) * 3) * 1.1 

c. 78.75 * 1.1 

d. 86.625 

Price/LBS The Price/Lbs field is calculated by taking the Unit Price and dividing by the weight of the 
individual part in pounds (no runner and sprue). 

a. 2.1382 / 1 

b. 2.1382 

Note: Quote Costs will match Standard Costs when the 'Use Master Inventory Std Cost for Component 
Pricing instead of Price Breaks' Quote Parameter is checked, the 'Attached Components Scrap 
Calculation' Quote Parameter is set to 'Based on (1/1-Scrap)', and the 'Use Std Cost in Engineering Quote' 
Inventory parameter (Inventory->Additional tab) must be checked for inventory items associated to the 
quote. 
 



Quoting Page 116 of 220 

 

Printing the Quote Letter 

You can create a new document using Word and save it as a template with a .dot extension. A bookmark 
is needed in the Word template if you want the *.rpt file (Crystal report) to be inserted in a particular 
place in the letter. The bookmark is created in the Word template (using the Insert/Bookmark function). 
It does not matter what it is named, the system knows to put the data output of the .rpt file into the 
location of the bookmark.  If the user chooses to omit the bookmark, then the *.rpt file will be inserted 
at the top of the quote letter. 

You can create your own Word templates and use the SETUP button (within the Quote Letter screen) to 
let the program know what template to use for letter generation. 

Note: In order to use this feature, Microsoft Word must be installed on the workstation. If it is not 
installed this option will not be available. 

Creating/Printing a Quote Letter 

To print a Quote Letter, complete the following steps: 

➢ Creating the Quote Letter can be accessed from the main menu bar (within Quoting) under 
Reports, or from the Calculations screen by selecting the Print Letter button at the top of the 

screen. In either case, the following screen will appear: 
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➢ Make sure that both options shown under 'New Letter Options' are checked. If a template 

does not exist, a prompt will appear at the bottom of the screen next to the 'Generate 
from...' field. 

➢ Click on 'Setup' to select the correct paths for the Crystal Report and MS Word template. The 
following screen will appear: 
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The Crystal Report that populates is based on a hierarchy. The system will first check if the Customer 
assigned to the quote has a specific Engineering Quote Letter report assigned (Customer Maintenance-
>Forms/Reports tab). If not, it will use the default Quote Letter report assigned in System Parameters-
>Reports and Forms tab. 

Select the ellipsis button in each field and select the location where the report and template reside. If 
you are selecting a Crystal Report, the following screen will appear: 
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➢ Select the correct report and click on 'Open'. You will be returned to the New Quote Letter 

settings screen. 

➢ Click on [OK] when both paths are correct. 

➢ Quote Letter File Path - This allows the user to set a default location to save quote letters 

when the Default Library is used. A UNC path is recommended.  When a quote is printed 
the user will still have the option to edit this file path temporarily for individual quote letters.  

If this field is not filled in, the system defaults to save the quote letter in the IQWin32 local 
home or the previous path user selected. 

Quote Letter Library - By default the quote letters are added to the Default Library. A different library can 
be selected by clicking the ellipsis button in this field to access the list of document libraries. This list is 
soft filtered to display libraries from the EPlant the user is logged into as well as those not associated to 
an EPlant. The library selected is remembered in the registry for the Windows user. When the quote 
letter is created the UNC path associated to the library will display when entering the quote letter name. 
This location should not be changed. If it is the document will be highlighted red indicating the file does 
not exist in the library path. 

Note: Currently the quote letter is added to the library without the Owner field populated. If the selected 
library is a Secure or Approval type library an owner will need to be added to the document before it can 
be checked out.   

Creating a New Quote Letter 

To CREATE a new quote letter: 

➢ From the Quote Letter screen, click on 'New' to create the letter using Microsoft® Word. The 
following screen will appear: 
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➢ The file name defaults to the RFQ# _# (the number of the letter, 1 for the first time a letter 

is created). You may override the default name and enter a new name for the quote letter 
(in the File Name field) followed by the extension. Select the location where the letter should 
be saved. Make sure to save the quote letter to a location on the network that other users 
would have access to. Press [Save] to continue. The system will create an entry in the Quote 

Entry screen and also bring up the Quote Template in Word in the background. Using Word, 

you can make any adjustments necessary prior to printing the letter. 

Modifying an Existing Quote Letter 

To MODIFY an existing Quote Letter: 

➢ From the Quote Letter screen, select the letter to modify and click on 'Edit'. The document 
will appear for Editing. 

➢ Make sure to save the document after Editing. 

Deleting a Quote Letter 

To Delete a quote letter: 

➢ From within the Quote Letter screen, select the letter to delete and click on the 'Delete' [-] 

key. The following prompt will appear: 
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➢ Click on the box next to ‘Delete physical file’ and click on [OK]. This deletes the letter from 

the selection list. 

➢ To exit from the Quote Letter screen, click on the [X] located in the upper right corner of this 

screen. 

Printing the Quote Letter 

To Print a quote letter: 

➢ From the Quote Letter screen, click on the 'Print' button. This will output the letter directly to 

the printer without reviewing. 

➢ To review the letter before printing, click on 'Edit' from the Quote Letter screen. This will 
bring up the letter in Microsoft® Word where changes can be made. 

➢ Select the print option from the main menu bar within the Word screen, or select 
File_>Print. This will output the letter to the printer. 

Printing When Workflow is Enabled for Quotes 

Printing the quote letter for an engineering quote with an associated workflow that is not approved is 
not allowed without security to select 'Continue'.   

A Quote letter cannot be printed under following conditions:  

▪ If workflow mandatory is checked and workflow has not been approved.  

▪ If workflow mandatory is checked and active workflow. 

▪ If workflow mandatory is unchecked and active workflow. 

If the quote letter cannot be printed a form will appear showing the items with unapproved workflows, 
or ones that require a workflow be created. This form will state the status of the workflow which will be 
'Inactive', 'Pending', or 'Required'. If it is 'Required' the Workflow # and the Workflow Status columns will 
display in red. Users can right click and jump to the Engineering Quote or the Workflow associated to the 
highlighted record. Security is available on this form for the Jump To options and the Continue button. If 
security is not enabled on the Continue button users will not be able to perform the action. This button 
can also be made not visible so users will only see the Cancel button. The quote letter will print if 
Continue is selected. 
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Quote letter can be printed under following conditions:  

▪ If workflow mandatory is unchecked and no active workflow 

▪ If workflow mandatory is checked and workflow is approved  
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Converting a Quote to a BOM 

To convert a quote to a BOM, follow the steps below. 

➢ Select the quote to convert from the quote pick list. 

➢ Click on the Calculation tab and then click on the 'Convert' button at the top of the screen, 

or select File->Convert to BOM from the main menu. The following screen will appear. 
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➢ To review the information on all items and attached packaging/components, click on the Full 

Expand button. This allows the user to identify all items that are not currently in Master 

Inventory prior to converting the quote and to make any changes to the item number or 

description of new items prior to conversion. 

Note: Items that exist only in the quote inventory and not master inventory will be displayed with an 
orange star on the folder. 

➢ Enter the new Manufacturing Number 

➢ Enter the BOM Labor information (note this will not apply to quotes for the Outsource MFG 

Type). Click on the ellipsis button to bring up the BOM Labor form. Enter in the number of 
operators and a code (employee level) for each labor type required. Users can access the 
Employee Level list to add or edit the records by clicking the icon in the top left corner of the 

form . (Security is available on this button). 

➢ Scrap % - If the 'Use Scrap % by Quantity Breaks' parameter is checked in the Miscellaneous 

menu->Rate and Parameters, a Scrap % field will display on the Convert Quote form to 
enter the scrap % to apply to the BOM.  

➢ Click on each item attached, make any changes as necessary and click on the 'Apply' button 
after each change. A red check mark will appear in each folder that is reviewed. Note: A 

description must be entered for each item or the quote cannot be converted to a BOM, 

because the description field is mandatory in BOMs. 

➢ For manufactured items there is an option to also enter the AKA Item information (number, 
revision, and description) and have the pricing populate AKA Selling in inventory. The AKA 

pricing will populate in inventory if an AKA Item # is entered and the 'Update Inventory AKA 
Price Breaks' option is checked. When the quote is converted to a BOM the pricing will 
populate both the Selling section of the Buy/Sell pricing tab as well as the AKA Selling tab. 

The customer listed will be the one associated to the quote. 
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➢ Update User-Defined Form - Select this option to have the fields from the user-defined form in 

the quote module copy over to matching BOM user-defined fields. Note: The structure of the 
fields in the BOM user-defined form must match the structure of the fields in the Quote 

user-defined form in order for the information to be copied over. This is Mfg Type specific. 
For example, the user-defined form for Generic Mfg Type quotes must be identical (Field 
Type, Field Kind, Label, etc.) to the user-defined form for Generic Mfg Type BOMs. 

➢ Click on 'Convert' to proceed with the conversion process. The system will create the new 
configuration and automatically add any new item(s) to the Master Inventory along with the 
quantity and price break information. The packaging items’ sequence numbers in the BOM 
will be based on the order they are attached to the quote. 

Converting to an Existing BOM - When converting to a BOM or converting to BOM/Sales Order, all levels 
of the quote can also be converted to existing BOMs. Instead of creating a new BOM number type in an 
existing BOM number. When selecting the Convert or Convert//Sales Order buttons a confirm message 
will appear stating, "The manufacturing number 'xyz' already exists. This configuration will be replaced. 
Do you want to continue?". This message will appear for all levels of a multi-level quote when the same 
configuration number is entered. The pop up message includes a Yes and No button as well as the 'Do 
not show next time check box. Security can be placed on this form. If the user has security to select Yes, 
the configurations will be replaced. All of the settings that are not available in the Quote will be 
preserved as it was on the BOM before the conversion. For example, the Dispo by Cycles check box on 
attached components will stay as it was on the original BOM before the conversion from the quote. If No 
is selected the user will be taken back to the Convert Quote screen and no level of the quote will be 
converted to a BOM. Note: If there is more than one BOM with the same exact MFG #, but just a 
different routing sequence, the system will only update the first MFG # it finds.  

Notes:  

More than one manufacturing number may be required if the quote has manufactured sub-components 
attached that exist only as quoted items. 

When converting a quote to a BOM or BOMs (for multi-level quotes), any attached components 
(including manufactured components) that are created during the convert will have the prices breaks 
written to the “Buy” pricing in inventory. However, if the item is associated to a Vendor RFQ the AKA 
Buying tab will be automatically populated with the vendor(s) and price break(s) from its Vendor RFQ. 

When converting a WIP item to a BOM, the center type populates based on the quote, if this is changed 
on the BOM and that WIP item is attached to a new quote as a consumed item, if the ‘New Mfg #’ field is 
not changed when converting the new quote to a BOM, the WIP item’s BOM's center type field will 
revert back to what it was in the quote module (the BOM control # is updated).  If the ‘New Mfg #’ field 
is modified for the WIP item, then the original WIP BOM retains the updated work center type and the 
new WIP BOM has the quote work center type. Essentially the dependent manufactured items are re-
converted based on the quote. 

If the MFG Type has a default 'Shift Backflush Rule' (MFG Types->General tab) the default Shift Backflush 
Rule will be used when converting a quote to BOM for the designated MFG Type. 



Quoting Page 128 of 220 

 

When converting a quote to a BOM, the system allows users to convert an archived Quote if it has never 
been converted before, or if the user enters a new MFG number every time they convert (new 
Manufacturing# is not found in the STANDARD table). 

When converting a quote to a BOM the system will truncate the Quote description to 50 characters as 
that is the maximum allowed on the BOM Description field. 

The Internal and External Documents attached to the quote will carry over to the BOM with the 'Print 
With' set to None. 

If there are two quote inventory items with the same item name and are consumed as components in 
the same BOM, an error will display stating, "Engineering quote has the same Quote Inventory record 
added multiple times. Quote Item # xxx Quote ID = xxx and Quote Item xxx Quote ID = yyy. Please correct 
by removing one or more of the same quote inventory items before converting to a BOM." 

If the ‘System-Generated Inventory#’ option is enabled in System Parameters->Sequential Numbering 
tab the system will populate the Item # with the next sequential number. The value can be overwritten if 
desired. There will also be an additional field on the 'Convert Quote' form displaying the 'Quote Item' # 
for reference. This field is grayed out and cannot be edited. 

The following message may appear if some of the items were not reviewed: 
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When the quote has been converted the user will receive a prompt that the conversion was completed 
successfully. 

➢ Click on 'OK' to return to the main screen. 

Customer Status 

When a customer is assigned to a quote that has a status other than Active, when converting the quote 
to a BOM, the customer's status will not change to Active if the customer's current status is Cr Hold, Ship 
Hold, or Mfg Hold. The system will change the status to ‘Active’ if the customer's current status is 
Inactive, Quote, or Obsolete. 

Convert to BOM and Create a Sales Order 

To convert a quote to a BOM and create a Sales Order at the same time, follow the steps above until all 
items have been reviewed and you are ready to convert to the BOM. Instead of clicking on the 'Convert' 
button, click on the 'Convert/Order' button to proceed with the conversion process and create the BOM 
and the Sales Order. If a customer is not associated to the quote the user will receive a warning and will 
not be able to continue creating the sales order, however the quote will still be converted to a BOM. 

When the quote has been converted the user will receive a prompt that the conversion was completed 
successfully and the Sales Order form for the quoted item will be shown on the screen. If a Sales Order 
Note is associated with the customer (Customer Maintenance->Misc tab) it will appear on the screen 
with the sales order. 

Engineering Quote Workflow Limitations 

When using the workflow functionality for Engineering Quotes the system will prevent users converting 
to a BOM when a workflow is not approved for an item or its component quotes (this includes quotes for 
attached main materials). The system will restrict actions if the same level or lower level quote workflow 
is not approved. 

A Quote Item cannot be converted to BOM or BOM/Sales Order under following conditions:  

▪ If workflow mandatory is checked and workflow has not been approved.  

▪ If workflow mandatory is checked and active workflow. 

▪ If workflow mandatory is unchecked and active workflow. 

If the quote cannot be converted to a BOM, or BOM/Sales Order a form will appear showing the items 
with unapproved workflows, or ones that require a workflow be created. Users can right click and jump 
to the Engineering Quote or the Workflow associated to the highlighted record.  
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Quote Item can be converted to BOM or BOM/Sales Order under following conditions:  

▪ If workflow mandatory is unchecked and no active workflow 

▪ If workflow mandatory is checked and workflow is approved  
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Converting a BOM to a Quote from the Engineering 
Quote Module 

A single level BOM or multiple level BOMs can be converted to a Quote. This process will always make a 
new quote even if a quote exists for the exact BOM. 

From the File menu in Quoting select New->Convert from BOM. There are two options: 'Convert to 
Quote (Single Level' and 'Convert to Quote (Multi Level)'. 

Convert to Quote (Single Level) 

After selecting this option, a pick list of BOMs associated to the EPlant the user is logged into will appear. 
Select a BOM from the list.  A pop up form will appear with a field to enter the New RFQ # that will be 
created and a Revision.  

▪ Enter New RFQ # - If the 'Enabled' checkbox is checked for the System-Generated RFQ # in System 
Parameters->Sequential Numbering tab, this field will be populated with the next sequential number. 
If the enabled option is not checked thisi field will be blank for the user to enter a value manually. 

▪ Enter New Version - The revision field defaults to 1.  

If the RFQ # and Revision already exist a warning will appear stating this. 
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▪ Select the Update Component Pricing box to have the system update the quote inventory price breaks 
and currently assigned price breaks with the Master Inventory price breaks from the Buying section 
(Buy/Sell tab). If the Update Component Pricing option is not selected, the pricing for purchased 
materials will come from the Buying section of the Buy/Sell tab in inventory for the item (never the 
AKA Buying section) unless the raw material is already in the Quote Inventory list. If it is in the Quote 
Inventory list, the system will use that pricing even if it is null.  If the 'Update component pricing' is 
checked but the item has the 'Use Standard Cost in Engineering Quote' option checked (Additional 
tab in Inventory) then the system will not update the price breaks in the quote module. 

▪ If the Update Standard Cost option is checked, items (primary material or attached materials) that 
have the 'Use Standard Cost in Engineering Quote' option checked will have the standard cost update 
in the price breaks in the quote module. If the item does not have the use standard cost option 
checked the system will update the price breaks based on the Buying section based on the Update 
Component Pricing check box. 

▪ If the ‘Quote Due Date is Mandatory’ default value (in Quotation Parameters) is checked the user must 
enter a due date for the new quote. 

Select OK and a message will appear stating: 'Mfg # [BOM #] has been successfully converted to RFQ # 
[RFQ#]/ Rev #'. Select OK on the message and the new quote will open. All of the values from the fields 
in the BOM will populate into the quote such as Cell, Operators, Labor Rate, Cycle Time, Scrap, etc. 

Note: The Units/Cycle field on the RFQ will default to one and should be updated to reflect the correct 
value. 

Note: Since a specific Work Center # is not associated to a BOM, when converting a BOM to a Quote 
using a Work Center with a Center Type that is also assigned to other Work Centers, the system will use 
the Center Rate, Fixed Center Rate, Setup Hours, and Startup Shots from the first Work Center created 
with that center type. To populate the fields for a specific work center, the user must select one by 
clicking the drop down or search button in the Work Center field on the quote and select Yes to the 
Confirm message to paste the values, then the rates associated to that work center will populate. 

If the BOM is a Generic with attached items that are manufactured the system will first look in the quote 
database and if the item is found the system will use the quote prices. If the attached manufactured item 
cannot be found in the quote database, the system will use the pricing from the selling prices on the 
Buy/Sell Pricing tab in Inventory. 

Convert to Quote (Multi Level) 

If the BOMs to be converted include several levels, select the 'Convert to Quote (Multi Level)' option 
from the File menu then select a BOM from the pick list. The following form will appear to enter the New 
RFQ # and Revision for all associated BOMs.  If the 'Enabled' checkbox is checked for the System-
Generated RFQ # in System Parameters->Sequential Numbering tab, the Enter New RFQ # field will be 
populated with the next sequential number for each BOM being converted. 

Note: If the same BOM is listed multiple times (same BOM attached to multiple different sub-BOMs), a 
new RFQ # is needed for each instance. 
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Highlight each BOM in the tree and enter the information in the fields. The check box options function 
the same as when converting to a single Quote. 
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Other Functions Available in Quoting 

Component Quantity Information 

Select the 'Component Quantity Information' button  on the Calculations tab to view the 
components associated to the quote and their required quantity, Min Order Qty and calculated excess 
quantity. 

 

The top of the form by default displays the first quantity on the quote. A different quantity can be 
selected from the drop down list. The Qty Required field will populate with the quantity required based 
on the selected Quote Qty. The Min Order Qty field populates with the master inventory item's 'Min 
Order Qty' value on the General tab in Master Inventory. The Excess value is calculated as the Qty 
Required minus the Min Order Qty. 

The bottom of the form shows the Ext Description, Class and Rev of the component along with the 
current On Hand Qty and Non-Committed Qty. If the item exists in master inventory users can right click 
and select 'Jump to Inventory' and 'Jump to Locations and Transactions'. 

Note: The Min Order Qty and Excess quantity will not be populated if the component item is not in 
Master Inventory. 
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Engineering Quote Workflow 

Workflow is a commonly used term that describes the automation of internal business operations and 
tasks to simplify and streamline current business processes. The Engineering Quote Workflow module is 
used to automate business processes relevant to quotes. This can lead to improved efficiency by helping 
the user to establish a template of tasks and assign the tasks to the right person with the right skills. 

The Engineering Quote Workflow module allows you to create user-defined templates of the tasks 
(Elements and Checklists) that are required to complete the workflow for any type of quoting process. 
Emails are sent through a workflow process evaluation to the individuals responsible for the tasks, 
allowing for an emailed response back into the system. All of this information is maintained in a single 
form for reference. It is optional to utilize workflows in quoting. If it is being used it can be marked 
mandatory, which requires that workflows be performed for all quotes. 

The information below outlines the steps in creating a Workflow in EnterpriseIQ as well as the details of 
the various sections of the Workflow form. 

Steps for Using Workflows in Engineering Quotes: 

▪ Activate Workflow Approval 

▪ Create Quote Types 

▪ Create an Approvers team 

▪ Create templates 

▪ Assign a template to the Workflow 

▪ Enter in the general information 

▪ Evaluate Workflow (email responsible team members) 

▪ Perform items in checklists associated with the Workflow elements and mark the status of each 
checklist item 

▪ Accept or Reject element 

Activate Workflow Approval in Quotation Parameters 

The Engineering Quote Workflow module is an optional feature. In Quotation Parameters there are two 
settings relevant to Engineering Quote Workflow: 

▪ Workflow Approval - The workflow approval functionality is activated from the Quotation Parameters 
form accessed from the Miscellaneous menu ->Rates and Parameters by clicking the 'Workflow 
Approval' box. Once this is checked the workflow functionality will become available on the 
Engineering Quote->General Quote Values tab. 

▪ Workflow Mandatory - Workflow Approval can also be marked mandatory by checking the 'Workflow 
Mandatory' box. This will require users to create a workflow for all quotes. The Workflow Mandatory 
cannot be checked if Workflow Approval is not checked. Note: If the Workflow Approval check box is 
not checked and the user checks this box, the system will automatically check the Workflow Approval 
box. 
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Engineering Quote Types 

This is a user-defined list of quote types. Quote Types are associated to workflow approval templates, 
and are required to be entered on a quote when using the workflow approval functionality. This enables 
the system to automatically create a workflow for the correct template. Having a quote type associated 
to a specific template provides functionality to apply specific business logic to specific quotes, such as 
situations where different approvers are required for certain business lines, or specific templates may be 
needed based upon the estimator preparing the quote. 

To access the Quote Types list select 'Engineering Quote Types' from the Options menu in Engineering 
Quotes. This list can also be accessed from System Parameters->List menu by selecting 'Engineering 
Quote Types'. 
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Select the insert record (+) button to add new quote types. Enter the Name and Description in the 
corresponding fields.  

Approvers Team 

The Approvers Team can be accessed from the File menu the Engineering Quote module. This will access 
the same Team Member module available on the Quality tab of the Launcher Bar, and include all of the 
same functionality.  
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Select the 'EQ' check box for the Team Members that will be available in the Engineering Quote 
Workflows. 

Note: Before a person can be added as team member, they must first be a user in the EnterpriseIQ 
system. See the Security and EnterpriseIQ Manual https://my.iqms.com/cfs-
file.ashx/__key/HelpFile/15.3/security_2D00_and_2D00_enterpriseiq.pdf for more information on 
creating users for EnterpriseIQ. The users must have the WebDirect attribute checked. 

Creating Approval Templates 

Create templates with tasks for any type of Engineering Quote functionality that you would like to track 
through the workflow process. 

From the File menu select 'Approval Templates', then select 'New' on the pick list and the following form 
will appear: 

 

https://my.iqms.com/cfs-file.ashx/__key/HelpFile/15.3/security_2D00_and_2D00_enterpriseiq.pdf
https://my.iqms.com/cfs-file.ashx/__key/HelpFile/15.3/security_2D00_and_2D00_enterpriseiq.pdf
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The Template form is divided into three sections: 

▪ Name - The Name and Description of the template 

▪ Elements - The elements (or steps) used when performing a Workflow that utilizes this template 

▪ Response - Includes the Lookup List, CheckList, and Team Members 

Top Section: 

Enter the values in the template form to create an Engineering Quote Approval Template. 

Name 

Description 

Enter a Name and Description of the template. 

Kind The Kind will be ENGQUOTE since it is used in the Engineering Quote module. 

Quote Type Select the Quote Type associated to the template from the drop down list. This is a 
required field which enables the system to automatically create a workflow for the 
correct template.  

Workflow Type Select a Workflow type from the drop down. The options are Sequential or 
Broadcast. The workflow type selected in the header section refers to the Elements. 
When using IQAlert to evaluate workflows, the information will be sent either for one 
element at a time Sequential or for all elements Broadcast. 

▪ Sequential Workflow - An email will be sent to all team members in the first element. 
Workflow cannot continue until the team members have responded to the element.  

▪ Broadcast - This option will send an email notification to all team members for all 
elements. 

Inactive A template can be marked Inactive which hides it from pick lists. 

Exclude Weekends When the Exclude Weekends option is checked the calculation for Required Date will 
exclude weekend days. If it is not checked it will include all days when calculating the 
Required Date. For example, if the Duration of an element is 7 days and the workflow 
is marked active on a Wednesday, with this option checked the Required Date will be 
the following Friday. If it is not checked the Required Date will be the following 
Wednesday. Note: If this option is not checked but weekends have been marked off 
in the Workflow Calendar then the system will exclude weekends (see the Workflow 
Calendar in Team Members for information on setting days off for workflows). 

EPlant The EPlant is assigned based on the plant logged into when the template is created, 
or it will be null if logged into View All. To manually assign an EPlant select the ellipsis 
button in the field and select an EPlant from the pick list. The template pick list is soft 
filtered on EPlant so when creating new records users will see templates associated 
to the EPlant they are logged into or those without an EPlant assigned. 
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Elements: 

The middle section is where the elements are entered. The elements are the steps that will be taken for 
the Workflow. To create the elements, click on the 'Add' (+) button in the Elements section and type in 
the description of the element.   

Duration The amount of time in days the Element is expected to take can be entered in the 
Duration field. This value will be used to calculate the Required Dates for each 
element.  Continue this process until all elements have been entered.  

Note: The Required Date is calculated based off of midnight of the activation date. If, 
for example, a user had a Duration of 1.25 (1 day, 6 hours) set up on the template 
and the workflow is activated on December 11th, the Required Date will calculate 
December 12th at 6 AM. If a user wishes to have the element calculated from a 
different start time, the Required Date time stamp can be overridden when the 
‘Active’ checkbox is unchecked. After the time is modified, users can right click within 
the Elements section and ‘Update Subsequent Required Dates’. 

Sequence The Sequence number information will fill in automatically with the next number as 
you add elements, or can be overridden by the user. Duplicate sequence numbers are 
allowed which will indicate in the workflow that the elements can be done 
simultaneously (emails will be sent for all elements with the same sequence number 
at the same time). The required dates for elements with the same sequence number 
will calculated for each element’s duration. Elements having subsequent sequence 
numbers will have their required dates calculated from the longest duration required 
date from the previous element sequence group. 

Workflow Type  A Workflow Type can be associated with each Element. This workflow type refers to 
the Team Members. The information will be sent either for one team member at a 
time (Sequential) or for all team members associated to the element (Broadcast). 
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Other Element Options: 

▪ Moving Elements - Once Elements are entered, the order they are in can be changed using the up and 
down arrow buttons. The element number will automatically change as it is moved. 

▪ Copy and Paste Elements - Elements can be copied and pasted from one template to another 
template or to the same template as a time saving feature. When copying from one template to 
another the template must be of the same kind, i.e. ENGQUOTE to ENGQUOTE, PO to PO, etc. 
Highlight the element to copy and select 'Copy Element'. Go to the template where it is to be pasted 
to, right click and select 'Paste Element'. All of the Element information will copy over. The 
Description will be the same, but a new sequence number will be generated. 

Response: 

The bottom section is where the Response (Lookup List, Checklist, and Team Member) information 
associated with a specific element is entered. 

Checklist The Checklist is the list of steps involved in completing the corresponding element. To 
create checklist items, click on the 'Add' (+) button on the Checklist tab and type in 
the text. This information will appear on the Workflow form in the Problem Report 
section, and on the web based approval page. The checklist items can also be marked 
Critical by placing a check in the Critical box.  A 'Y' will appear for the corresponding 
checklist item on the Workflow form, and signifies that the checklist item(s) is a 
critical step in the Workflow process. An element cannot be marked as completed 
unless team members affirm and respond to a critical checklist item. If a user 
attempts to approve an element without affirming the critical checklist items an error 
will occur stating “All critical checklist items must be affirmed in order to approve this 
element”. User defined Notes can be associated to a checklist item. The notes can be 
typed manually or selected from a user defined list. To create the list, right click on 
the field and select 'Edit User Defined List'. The notes will appear on the Checklist tab 
of web approval page and in the Checklist section on the main module. 
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Team Members The Team Members is the list of personnel responsible for the specific element.  
The Approvers Team (Team Member) list can be accessed from the Engineering 
Quote File menu. (This is the same list used in Quality). 

When a new Workflow is created using the template, the team members added at 
the template level will automatically be added for the new Workflow. This is a time 
saving feature if the same team members typically perform a specific element for all 
Workflow's that utilize the template.  

Select the + button and select the team members from the pick list to add them to 
the template element. 

Set the Type to authorize or review. 

▪ Authorize team members are required to sign off on the approval process. 

▪ Review team members will receive an email notification through the workflow 
process, but are not required to sign off. 

If the Type is not selected at the template level it will default to Authorize on the 
Workflow form. If all team members are set to Review the element will not be 
completed. Team members set to review will appear in italics to distinguish them 
from authorize members.  Enter notes if desired.  The notes will display on the 
responsible tab of the Workflow form and on the web based approval page. 

Delegate To - A Delegate can be associated to a team member with a Days Threshold 
value.  The 'delegate days threshold' will control when a second email is sent to the 
delegate if the original team member did not respond within that time. This will help 
prevent a workflow from stalling because someone is too busy or out of the office for 
an extended period of time without the initiators knowledge. Once the ‘Days 
Threshold’ has passed and the workflow is evaluated, the Delegate is sent an email 
and can log in to approve/deny the workflow. Both the delegate and the 'days 
threshold' can be edited for a specific workflow on the Responsible tab. 

Note: There is also the 'Pending Authorization Expired' number of days 
feature that can be setup on the IQAlert that processes workflows.  The 
number of days should be greater than the delegate days threshold. 

Copy and Paste Team Members - Team Members can also be copied and pasted from 
one element to another as a time saving feature. Highlight the element whose team 
members you want to copy, right click and select 'Copy Team Members'. Highlight 
the element the team members are to be pasted to, right click and select 'Paste Team 
Members'. All of the team members, their Type, and Notes will copy over. This same 
feature is available from the Elements section on the main form. 
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External Documents 

External documents can be associated to a template. This can be used to provide documentation for 
requirements for the specific template and the quality records it is associated to. Any external 
documents attached to a template will carry over to the Ext Docs tab for new records that utilize the 
template. 

Create Additional Templates 

To create additional templates, click on the 'Add' (+) button on the Template form and complete the 
above steps. 

Creating a Workflow 

Once the Workflow Approval parameter is activated and templates have been created, a new Workflow 
can be started.  

1 Click on the ellipsis button in the 'Quote Type' field on the General Quote Values tab in Engineering 
Quotes. 

2 Select a Quote Type from the pick list.   

3 Select the post edit button to save the change. The system will automatically create a workflow. 

4 The Workflow number will display in the Workflow # field and will have a status of 'Inactive'. 
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5 Click the ellipsis button in the Workflow # field, then click on 'Jump to Workflow' to open the 
workflow. 

 

The list below describes the fields in the top left section: 

Quote Workflow # This is the Workflow # for reference purposes. This number is assigned by the system 
in sequential order. If you are using EPlant this number will have the EPlant suffix 
after the number. This field can be overridden by typing over the existing number. 

Initiator The Initiator field displays the user login for the person who created the Workflow. 
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Active This marks the Workflow as active. If Durations are entered for the elements the 
Required Dates will automatically be calculated based on the date the Workflow is 
marked Active. 

This field can be expanded to view the Start Date. This is the date the workflow was 
marked Active. 

Note: The evaluate workflow process cannot be started until this is checked. 

Note: Microsoft Excel must be installed in order to use this feature. When 
activating the workflow, the system automatically creates the RFQ report to 
be displayed on the approval page. If Excel is not installed, the user will 
receive an error stating: "Microsoft Excel is required when setting to active", 
when marking the workflow 'Active' and posting the change.  

Open Date This date defaults to the date and time the Workflow was created but can be 
changed using the drop down calendar. 

This field can be expanded by clicking on the + next to the field name to display two 
additional date fields, Completed Date and Close Date. The Completed date will 
automatically populate when all of the Elements have been completed. 

The Close date can be edited using the drop down calendar and selecting a date. 
Once a close date is added to the Workflow the status of the Workflow will be closed. 
The status is used for filtering purposes. 

Customer #  

Company Name 

This is the Customer associated with the Workflow. It is populated based on the 
Customer associated to the Quote, and cannot be changed. Click the + button to 
expand the field to see the Company Name. 

Quote # 

 

This is the Quote# associated to the quote record the workflow was created for. Click 
the + button to expand this field to see the Quote RFQ #, Description, Expiration date, 
Due Date, and Sales Engineer fields. 

Workflow Type This information will fill in automatically if a workflow type is associated to the 
selected template. It can be changed by selecting the workflow type from the drop 
down menu. There are two options: 

▪ Sequential Workflow - An email will be sent to all team members in the first element. 
Workflow cannot continue until the team members have responded to the element.  

▪ Broadcast - This option will send an email notification to all team members for all 
elements. 

Template Type This displays the Template Name associated with the Workflow. 

EPlant ID This is the ID for the EPlant associated with the Workflow. This field will automatically 
populate with the ID based on the EPlant the user is logged into. 
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Archived  This box will be checked if the workflow is archived. 

Select Archive from the File menu to archive a workflow record. Select Yes to confirm 
the status change. The Archived box will be checked. 

Archived records can be restored by selecting Restore from Archive from the File 
menu. The box will be un-checked. 

From the Options menu users can choose to view workflow records based on 
whether they are open or archived. Select View All, Open Only, or Archived Only to 
filter what is displayed based on this status. 
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Elements 

This section contains the elements associated with the template that was chosen when the Workflow 
was created. Elements can be added, deleted, and the order rearranged as long as the active box is not 
checked and the element does not have a complete date. Use the +, - and up and down arrow buttons to 
perform these functions.  

If a duration was entered for the elements on the template the 'Required Date' and 'Baseline Date' will 
automatically populate once the Active box is checked. If no duration was entered for the elements, the 
'Required Date' and 'Baseline Date' will populate with the date the record was marked active. The 
required dates cannot be changed once an element is completed. If the 'Required Date' for a non-
complete element need to be changed, un-check the Active box and select a new date from the drop 
down calendar. To change the 'Required Date' on the subsequent elements, right click and select 
'Update Subsequent Required Dates'. This will update the subsequent Elements' required dates based on 
the last 'Required Date' plus the 'Duration'. 

The 'Baseline Date' does not change with edits to 'Required Dates' unless the 'Populate Baseline Date(s)' 
button is pressed, in which case the Baseline Date column is populated with the current Required Date 
for elements that have not been completed.  Security can be applied to the 'Populate Baseline Date(s)' 
button to restrict access. 

Once an element has been approved by all Authorize type team members, the completion date will fill in 
automatically after the workflow is evaluated again.  

Workflow Gantt Chart - This button will bring up a Gantt chart for the Elements. 

 



Quoting Page 149 of 220 

 

 Rewind/Reset Element workflow approval process - This process resets an element's complete date 
as well as its workflow approval records so it can be re-evaluated again. 

Once selected a confirm box will appear to select Yes or No. If Yes is selected, the system will reset the 
element and a box will display stating the number of processed workflow records that were reset. The 
line item(s) in the Responsible section will revert to black allowing the workflow for the element to be 
reevaluated. 

User Defined Form 

A User Defined Form with additional fields can be created for workflows. These fields can then be used in 
customized reports. The User Defined Form can be accessed from the speed button, the User Defined 
Form tab or from the Options menu. See the User Defined Forms portion in the Using EnterpriseIQ' 
section of the help files for more information on creating a user defined form. 

Summary 

The Summary tab displays summary information for each element. It includes the Element Description, 
Complete Date, Duration, Required Date, Workflow Type, and Response information. The user can select 
the number of panels to view (up to 15) from the # Panels drop down. This defaults to 'Auto' which will 
display a panel for each Element associated to the workflow. 

History 

From the History tab users can view the history related to the workflow. This tab includes the following 
information: 

▪ Date - Event Date and Time 

▪ Event - This will describe the event, such as Signoff, Checklist, or Reset One 

▪ Signoff - Y or N 

▪ Signoff Date and Time - The date and time the element was signed off 

▪ Response - Response notes entered by team member. Double click this field to access the response 
text at the time of the history record. This field will say (Memo) if there are no notes. If it is in all caps 
(MEMO) it indicates there are notes that can be viewed by double clicking. 

▪ Notes - These are the notes entered in the 'Note' field on the workflow. Double click this field to 
access the notes at the time of the history record. This field will say (Memo) if there are no notes. If it 
is in all caps (MEMO) it indicates there are notes. 

▪ Checklist Text - The description of the Checklist item 

▪ Checklist Status Old - The old Checklist status (Y, N, N/A) 

▪ Checklist Status New - The new Checklist status (Y, N, N/A) 

▪ Username - The Username that reset the rejected record 

▪ Element Description 

▪ Responsible Name - The name of the Team Member responsible for the entry 

▪ Responsible Type - Review or Authorize based on the responsible type associated to the responsible 
team member within the responsible tab 

Documents 
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In this section the user can attach internal or external documents, or Email Correspondence associated 
with the workflow.   

Internal Documents 

The screen acts like a word processor. The user can add, edit, delete, or print documents from here. 
Graphic images may also be imported into the document or text area. EnterpriseIQ supports .BMP or 
.WMF graphic files only. 

External Documents 

To attach a document, click on the (+) button and select the Document Library and document from the 
screens that appear. To OPEN the document, double-click on the file name, or select the document and 
right click. Select [Execute] from the submenu. The program will open both the application the document 
was created in as well as the document itself.  

Color Coding for External Documents: 

Each document will display in a color to indicate its status. 

▪ Yellow - The document is checked out or new. 

▪ Blue - The document is pending authorization and/or review. 

▪ Green - The document is released. 

▪ Olive Green - The document has expired. If a document is expired when a user attempts to open it or 
print it from a module a warning will appear stating, “The document is not available - it is expired 
and requires review.” 

▪ Red - File does not exist 

▪ Gray - Inactive document 

Search - The External Documents tab in all modules includes the Search button to access the pick list for 
easier navigation through multiple documents. 

Show Revisions - Select this option from the right click menu to view all the revisions of a document. 
Double clicking (or right click and select Execute) on the revision will allow the user to view the 
highlighted revision. 

Print with Work order - When the print with work order option is selected, when a work order for the 
item(s) attached to the workflow is printed, the document(s) set to print with Work Order will also print. 

The user can also jump to the Document Control module by clicking on the Launch Document Control 
speed button. 

Email Correspondence 

This section allows the user to attach Email correspondence related to the Engineering Quote. To add an 
Email simply drag and drop it from Outlook or other email programs into the form. 

The 'Received Date' will fill in based on the email's received date and time. A Received Date box surfaces 
if the system is unable to determine the date (such as: The Received and Sent dates differ, unclear binary 
data, or older data, etc.). Users are asked to provide the Received Date by selecting the correct date 
from the calendar.  
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The 'From' and 'Subject' fields will also automatically populate with the information from the email. The 
date, from, and subject fields cannot be edited. 

Comment - A comment can be entered by double clicking the field. Enter the comment in the pop up box 
to further describe the email correspondence. 

There are three ways to access the Email once associated to the Quote: 

▪ Double click on either the Received, From, or Subject fields. 

▪ Right click and select View email. 

▪ Or select the View email button. 

Note: If the email has attachments, or multiple attachments, the total attachment size cannot be more 
than 4GB. The size allowance might further be limited by the chosen email program used. In order to 
view emails that have attachments, special formatting (e.g. stationary), or images embedded in the body 
of the email, the user must go into BDE Administrator and set the BLOB SIZE to 1000 for the database 
they are using (i.e. IQORA). 

Notes 

To add notes, type directly in the notes field, or click on the 'Edit Memo' button and type conclusion 
notes in the screen that appears. This field can contain up to 2000 characters. 
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Selecting the Print button at the bottom of the form will print notes. 

Images 

Multiple images can be added to the workflow record on the Images tab. The images will be visible in the 
module only (not the web approval page). 
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Select the insert record button and select the image from the open form. An image can be marked as the 
default by checking the Default box, this will make that image the first to display. A description can be 
added to be displayed below the image. Select the 'Edit Description' button, or right click and select 'Edit 
Description'. A note editing screen will appear to enter up to 255 characters. In cases where the text is 
longer than the display area below the image, the user will need to open the editing window. The image 

can be viewed in full screen mode by selecting the  button , or select Full Screen from the right 
click menu. Press the Esc key to exit the full screen mode. Images can be deleted by clicking on the 
delete record button or from the right click menu. Select Replace from the right click menu to replace 
the current image with another one. An image can also be Saved to a File by selecting that option from 
the right click menu. Use the search button to access a pick list of images associated to the workflow 
record. 

Problem Report tab 
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CheckList - This section displays the Checklist information associated with the highlighted Element.  If 
the checklist item has been marked critical on the template, a 'Y' will be displayed in the Critical field.  
Each checklist item is given a status by clicking on the drop down arrow and selecting No, Yes, or N/A. 
'Yes' indicates the checklist item is done, 'No' indicates it is not done, and 'N/A' indicates it is not 
applicable to this specific Workflow.  The status can also be filled in from the web approval page. 
Checklist items can be added on the fly to any element. 

Response - The Response information also appears on this tab. This information is input based on lists 
created at the template level or typed in manually. To select a response from the pick list created on the 
template click on the Lookup Response List button, and a pick list of responses associated with the 
Element will display. 

Responsible tab 

 

The responsible tab contains the team members responsible for authorization/review of the selected 
element of the Workflow.  To add team members responsible for the element, click on the Add (+) 
button and select them from the Team Member list.  All team members will be in the pick list. Multiple 
team members can be selected at once using the toggle buttons on the pick list or the Shift and Ctrl 
keyboard buttons. Team Members can also be copied from one element and pasted into another by 
right clicking in the Element section and selecting Copy Responsible and Paste Responsible. There is no 
specific check box in the Team Member module for Workflow. Continue this process until all required 
team members have been added.  New team members can be added to the Team Member pick list by 
clicking on Team Members under Options on the tool bar. 

The fields in the Responsible section of the form are described below: 

# This is the sequential number the team members were added in.  If the sequence 
needs to be adjusted, this number can be changed manually. 

Name This is the Name of the team member. 

Email sent This field populates with the date and time the email was sent notifying the team 
member a workflow needs reviewed/authorized. 
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Type If the type was set up on the template it will fill in automatically. If the type is not 
specified on the template it defaults to Authorize on the Workflow form. If no Type 
is specified on the Workflow form, a message will display stating it is a required 
field. To change it, select from the drop down list and choose either Authorize or 
Review. 

▪ Authorize team members are required to sign off on the approval process. 

▪ Review team members will receive an email notification through the workflow 
process, but are not required to sign off.  

Note: If all team members are Review, the element will not be completed. 

Plan Date This is the plan date associated with the Workflow Element and team member, and 
can be used as a due date for the element. Select the date from the drop down 
calendar. 

Sign Off If the team member approves the element and selects Authorize on the web based 
approval page, a 'Y' will automatically be put in this box.  If the team member 
rejects the element, an 'N' will be displayed.  This cannot be filled in manually. 

Sign Off Date This field will automatically fill in with the date the team member accepted or 
rejected the element. 

Email The email address for the team member.  This information comes from the Team 
Member module. 

Title The title of the team member. This information comes from the Team Member 
module. 

Note Users can enter notes in this field under the Responsible tab, or on the web approval 
page.  The notes entered in this field can be unique to each team member. 

Delegate To A Delegate can be associated to a team member with a Days Threshold value. The 
delegate days threshold will control when a second email is sent to the delegate if 
the original team member did not respond within that time. This will help prevent a 
workflow from stalling because someone is too busy or out of the office for an 
extended period of time without the initiators knowledge. Once the ‘Days 
Threshold’ has passed and the workflow is evaluated, the Delegate is sent an email 
and can log in to approve/deny the workflow. 

Pending 
Authorization Expired 

This will populate with the date/time the pending authorization/review expired 
based on the 'Expire Pending' days set in the Contingency Plan section of the Alert 
action. 

This function will also send an email to the 'Email To' address established on the 
Alert action indicating the pending authorization/review has expired. 

Once the responsible team member approves their element; the line turns green to 
go forward with the next element. The Pending Authorization Expired field remains 
populated. 

Receive Notification If this option is checked, the team member will receive an email when the element is 
completed.  
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Ext Docs Element 

 

In this section the user can attach external documents associated with a specific element.  To attach a 
document, click on the ADD (+) button and select the Document Library and document from the screens 
that appear. If the document is released it will be accessible in read only format from the web based 
approval screen. 

The user can also jump to the Document Control module by clicking on the Launch Document Control 

speed button . 

Workflow Filter  

To change the filter, click on the 'Filter' button at the top of the Workflow form . A box will appear 
from which the user can select All Customers or One Customer, as well as Open Workflows, Closed 
Workflows, or both. 

The Filter feature can also be used to filter the pick list when searching for a specific Workflow. 
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Access Workflows 

Select the 'Workflow' speed button to access your pending approvals relevant to the module currently 

opened . For example, when selecting the workflow speed button from the Engineering Quote 
Workflow module the user will be asked to log in and their pending quote workflow approvals will 
display. Select the record number to access the specific approval summary. 

Limitations in Other Areas when using Engineering Quote Workflows 

When using the workflow functionality for Engineering Quotes the system will prevent users from 
performing certain functions such as converting to a BOM or printing quote letters when a workflow is 
not approved for an item or its component quotes (this includes quotes for attached main materials). 
The system will restrict actions if the same level or lower level quote workflow is not approved. 

Printing the quote letter from the calculations tab or RFQ Log 

Printing the quote letter for an engineering quote with an associated workflow that is not approved is 
not allowed without security to select 'Continue'.  

Printing the quote letter from Project Manager for unapproved workflows 

When an RFQ is associated to a Project Manager record (General tab->Part RFQ field) and the 'Include 
QLETTER_RPT output' box is checked on the Quote Letter form users may not be able to print the letter. 
When a user selects the 'New' button from the Quote Letter form the system will prevent users without 
security to select 'Continue' from printing the quote letter when a workflow associated to the 
engineering quote is not approved.  

System Rules: 

A Quote letter cannot be printed under following conditions:  

▪ If workflow mandatory is checked and workflow has not been approved.  

▪ If workflow mandatory is checked and active workflow. 

▪ If workflow mandatory is unchecked and active workflow. 

If the quote letter cannot be printed a form will appear showing the items with unapproved workflows, 
or ones that require a workflow be created. This form will state the status of the workflow which will be 
'Inactive', 'Pending', or 'Required'. If it is 'Required' the Workflow # and the Workflow Status columns will 
display in red. Users can right click and jump to the Engineering Quote or the Workflow associated to the 
highlighted record. Security is available on this form for the Jump To options and the Continue button. If 
security is not enabled on the Continue button users will not be able to perform the action. This button 
can also be made not visible so users will only see the Cancel button. The quote letter will print if 
Continue is selected. 
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Quote letter can be printed under following conditions:  

▪ If workflow mandatory is unchecked and no active workflow 

▪ If workflow mandatory is checked and workflow is approved  

Convert Quote to BOM 

The system will restrict a quote from being converted to a BOM for unapproved workflows at its current 
level or any level lower in the quote hierarchy.  This applies to converting from the Quote module, RFQ 
Log and Sales Quotations. 

When using the workflow functionality for Engineering Quotes the system will prevent users from 
converting to a BOM when a workflow is not approved for an item or its component quotes (this 
includes quotes for attached main materials). The system will restrict actions if the same level or lower 
level quote workflow is not approved. 

A Quote Item cannot be converted to BOM or BOM/Sales Order under following conditions:  

▪ If workflow mandatory is checked and workflow has not been approved.  

▪ If workflow mandatory is checked and active workflow. 

▪ If workflow mandatory is unchecked and active workflow. 

If the quote cannot be converted to a BOM, or BOM/Sales Order a form will appear showing the items 
with unapproved workflows, or ones that require a workflow be created. Users can right click and jump 
to the Engineering Quote or the Workflow associated to the highlighted record.  
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A Quote Item can be converted to BOM or BOM/Sales Order under following conditions:  

▪ If workflow mandatory is unchecked and no active workflow 

▪ If workflow mandatory is checked and workflow is approved  

CRM Sales Quote Limitations 

If a specific engineering quote or component engineering quotes have not been approved they cannot 
be added to a sales quote.  

A Quote Item cannot be added to a sales quote under following conditions:  

▪ If workflow mandatory is checked and workflow has not been approved.  

▪ If workflow mandatory is checked and active workflow. 

▪ If workflow mandatory is unchecked and active workflow. 

Also, if a workflow is associated to an Engineering Quote item after it has been added to a Sales Quote, 
and it is not approved, the sales quote cannot be converted to a sales order.  

If these situations apply a message similar to the following will display indicating the quote number that 
has not been approved.  
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A sales quote can be converted to a sales order if prior approval of an inactive workflow exists. When 
attempted, the 'Engineering Quote Unapproved Workflows' form will appear with a 'Continue' button. 
Users with security to select 'Continue' can convert a sales quote to a sales order.  If security is not 
enabled on the 'Continue' button users will not be able to perform the action. This button can also be 
made not visible so users will only see the 'Cancel' button. 

Note: Selecting 'Continue' will bypass the approval of the workflow. 

 

A Quote Item can be added to sales quote under following conditions:  

▪ If workflow mandatory is unchecked and no active workflow 

▪ If workflow mandatory is checked and workflow is approved  

Evaluate Workflows 

Evaluate Workflow automatically analyzes the status of the element in relation to each team member, 
and determines the action to take.  This is the process that will send email notifications to team 
members that a Workflow element needs to be reviewed/authorized, and through which the element is 
approved or rejected based on the responses of the team members. 

To start the workflow process: 

1 Assign responsible team members.  Be sure to post after adding team members, or workflow will 
not function properly. 

2 Ensure that the Active Box in the Workflow main section is checked. 

3 Use IQAlert to initiate the evaluation. 

4 The team members will be marked in pending status and emails will be sent, according to the 
Workflow type selected, notifying the members that a Workflow Element needs to be 
reviewed/authorized. 
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Note: The Evaluate Workflow and Re-Evaluate Workflow functionality can be set up in IQAlert to occur 
automatically based on a defined schedule. Select the QUOTE control system. (See the IQAlert 
documentation for details). 

When using IQAlert, the emails sent depend on whether the workflow and elements are set to Broadcast 
or Sequential. The workflow type selected in the main section of a module refers to the Elements. The 
information will be sent either for one element at a time (Sequential) or for all elements (Broadcast). A 
Workflow Type can be associated with each Element. This workflow type refers to the Team Members. 
The information will be sent either for one team member at a time (Sequential) or for all team members 
associated to the element (Broadcast). If the Workflow Type field is left blank it will default to Broadcast. 
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Additional Options: 

Contingency Plan - A Contingency Plan can be set up on the Alert action to indicate the number of days 
when a pending authorization/review is considered expired. The 'Pending Authorization Expired' field in 
the Responsible section of the module will populate with the date and time it was marked expired. An 
email will be sent to the email address set up on the IQAlert action indicating the workflow authorization 
is expired and the responsible team member. 

Delegate To - A Delegate can be associated to a team member on a template with a 'Days Threshold' 
value. The delegate days threshold will control when a second email is sent to the delegate if the original 
team member did not respond within that time. This will help prevent a workflow from stalling because 
someone is too busy or out of the office for an extended period of time without the initiators knowledge. 
Once the 'Days Threshold' has passed and the workflow is evaluated, the Delegate is sent an email and 
can log in to approve/deny the workflow.  

Both the delegate and the 'days threshold' can be edited for a specific workflow on the Responsible tab. 

Note: If both the Contingency Plan and Delegate options are used, the number of days on the 
Contingency Plan should be greater than the delegate days threshold. 
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Another IQAlert option is to create an SQL to re-evaluate workflow through an 'SQL statement' which 
can specify the number of days after which team members with pending workflows will be reset.  Then 
subsequent SQL statements to evaluate workflow will send new emails.  The combination of these 
SQL's for Reset and Evaluate Workflow is the equivalent of doing 'Reset for Re-Evaluation' and 'Evaluate 
Workflow' under the Responsible tab in modules that have workflow.  After the Reset SQL statement is 
processed, and before the Evaluate Workflow SQL, if a team member attempts to get to the web 
approval page from an older email, they will receive a message that the approval link is no longer valid. 
Users may pick up the new SQL statement from MyDELMIAworks in the IQMS Alerts section in Support-
>Files. The file is 'Reset Workflow.zip'. For more information on setting up these alerts please refer to the 
Alert help file. 

Notes:  

Invalid emails (for employees where they no longer are active email addresses in the system) will be 
passed over and the workflow process will continue to the next responsible person or if no responsible 
person is indicated for the remainder of the elements, it will add a completed date to those elements. 
The system records any exceptions in the Event Log under the WORKFLOW ERROR class. 

Evaluating workflow through IQAlert ensures workflow emails are sent to the correct team members in 
the correct order. If the 'Evaluate Workflow' button on the Workflow Approver tab is used instead, 
workflow emails may not be sent to the correct team members and potentially in non-sequential order. 

Duplicate sequence numbers on Elements are allowed which will indicate in the workflow that the 
elements can be done simultaneously (emails will be sent for all elements with the same sequence 
number at the same time). 

If any email is not being sent as expected for evaluate workflow and no error occurs, check to see 
whether the spam filter may be preventing the email from being sent. 

Workflow Emails 

The subject line of the email states the Quote Workflow number, the Workflow Element description, and 
the team member type (Authorize or Review). 
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The email provides a link to the browser.  The browser form is where the Workflow Element is 
reviewed and either accepted or rejected by the team member.  After clicking on the link, the user will 
be required to log into the network in order to access the Workflow review form. 

Once logged in, the user will see the Workflow Summary form: 
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Note: Password Expiration Warning - If the user's password will expire within 30 days or less a message 
will appear stating, 'Warning Your password expires in x day(s). You need to change the password before 
the expire date. Would you like to change your password now?' Select ‘Continue’ to go to the workflow 
without changing the password, or select the ‘Change Password’ option to change the password. Users 
do have the option to change their password at any time via the 'Change Password' button at the bottom 
of the workflow web page.  

Workflow Page 

The left side of the Workflow Summary form displays the general information from the Workflow form in 
EnterpriseIQ including the RFQ #, Description, Company and Sales Engineer.  This form shows the Notes 
entered in the Notes field on the main form.  If the notes are larger than the display field, they can be 
viewed in their entirety by clicking on the + button. The Response notes entered on the response tab of 
the Workflow form will also display in the lower Note field.  

Team members can select the EIQ icon next to the Quote Workflow # to jump to the quote in 
EnterpriseIQ. A confirmation message will appear stating, "About to jump to EnterpriseIQ. Please 
confirm to continue". Select OK to continue or Cancel to return to the summary. (Note: A second login 
will occur even though EIQ is already open if the shortcut to EIQ has “_multi_” added to the shortcut 
properties). 

Note: This option is only available when using Internet Explorer (IE) with proper security levels set. When 
using another browser or if IE security is not established a message will appear stating, 'Unable to 
continue. Please check Internet Explorer security level. Error message = ActiveX object not defined. Note: 
Other browsers do not support this feature'. The settings for IE require that the server URL is added to 
Internet Explorer Trusted Sites, security must also be set to 'Low' for Trusted Sites to enable ActiveX 
controls, and set security to 'Low' for local intranet, and 'medium-hig'h for Internet security. 

Note: When accessing a workflow through Smart Page, the system will jump to the EnterpriseIQ record 
with no message surfacing. 

The right side of the summary form has six tabs: 

▪ Response - Users can input a response by manually typing in the response section or select a 
predefined response from the response lookup list. To select from the Response Lookup list, select 
the response button and the Select Response form will appear. Enter the response information in the 
'Search for' field, or leave it blank to return all responses, and select the Search button. The results 
will display. Select the desired response by clicking on the Code. The Response text is submitted by 
either clicking on Submit button, saying ‘yes’ the confirmation message, when clicking on another tab 
within the web approval page, or when logging out of the web approval page.  All responses are 
available to other team members from their respective approval pages. The responses entered here 
will also transfer to the main form in EnterpriseIQ. 

▪ RFQ Summary - This tab displays a PDF of all calculations. This is the same file that gets generated 
when using the 'Print RFQ' option. The RFQ Summary can be downloaded or printed by selecting the 
corresponding button on the form. There are also buttons to zoom in/out, or fit the document to the 
page. 
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▪ Checklist - Select the Checklist tab to view the checklist information along with the status of each 
checklist item in the Value column. To change the status of a checklist item, the user can select a 
value (Y, N, N/A) from the drop down list. If changes are made to the status the user must select the 
Submit Checklist Items button in the Checklist section to process the changes. 

▪ Responsible - Select the Responsible tab to view the list of team members that are also responsible 
for the element. Users can send email to a team member directly from this tab by clicking on the 
team member's email address. 

▪ Documents - Select this tab to view any attached external documents associated with the workflow, 
attached external documents associated to the specific element, or reports. The reports available are 
the same as what is in the Engineering Quotes module reports menu. If a team member is a 
customer or vendor, they are limited to viewing the current record only on a report. If the team 
member is not a customer or vendor, the selection criteria form will appear allowing the team 
member to enter the criteria desired for the report. 

▪ Email Correspondence - If Email Correspondence is associated to the record it can be viewed from 
this tab. The tab will list all linked emails with the date received, who it's from, the subject, and the 
comment entered on the Email Correspondence tab in the module. The team member can click on 
the subject and the email will open in a separate pop up window. 

▪ Summary - The Summary tab displays the Element summary information including responses. 

Authorize, Reject, or Review: 

Once the team member reviews/edits the checklist and responses, if they are an Authorize type team 
member, they will choose to authorize or reject the Workflow element. Review type team members will 
only be able to 'Submit Review'. If the team member rejects the element, a note must be entered in the 
Note field. Notes may also be added if the element is accepted. These notes will display on the Workflow 
form in the Note field on the line item associated with the team member. 

Note: If the user hits the back button on the browser and attempts to resubmit a workflow that has 
already been denied or approved, the user will receive an error: "There was an error processing your 
request. This element was already denied/approved on mm/dd/yy". 

Once a team member has authorized/reviewed the Workflow element and submitted their response, the 
fields in the Response section of the Workflow form will populate with the new information such as 
Signoff (Y or N), Signoff Date, and Notes.  

The text will also be color coded to visually show the status of the team member.  The color codes are 
as follows: 

▪ Green - The team member has approved the element. 

▪ Red - The team member has rejected the element. 

▪ Blue - A response is pending. The team member has been notified that an element needs to be 
reviewed, but has not yet replied. 

▪ Black - The workflow has not been processed for the team member. 

If the Electronic Signature option is selected when the team member clicks on the Submit button, the 
team member will be asked to enter their user name and password for the electronic signature. 
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To enable this feature, check the 'Enable electronic signature sign off' in System Setup->System 
Parameters->Company File Information->Application tab. This is a global setting. 

Completing a Workflow 

Once an element has been approved by all Authorize type team members, the completion date will fill in 
automatically after the workflow is evaluated again. The team member ID that approved the element is 
stored in the WF_RESPONSIBILITY table (in SIGNOFF_TEAM_MEMBER_ID). This will populate with the 
team member ID of the user actually approving or rejecting the workflow element, including a delegate 
team member. If an element is re-wound and approved or rejected again, the value is re-written in the 
new column. An email will be sent to the Initiator and to team members that have the Receive 
Notification option checked when an element is completed. This check box is on the Responsible tab of 
each module. 

Note: Review type team members can still access the workflow and submit their review after the 
element has been approved. The workflow will display this message "This element is closed, but has not 
been reviewed". 

Rejected Elements 

When an element is rejected, all users on the Responsible tab for the element set as 'Authorizer' will 
receive notification of the rejection, in addition to the user in the Initiator field. The email will include the 
record, element information, reason for rejection, and the authorizer that rejected the element.  

 My Pending Approvals - This button will appear in the blue bar at the top of the web approval page. 
When the user mouses over the button, the hint will display the number of pending approvals they have. 
Click on the button to view the Pending Approval List. 
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From this screen the user can select an item to review by clicking on the link. 

Access Workflow from Responsible tab - The Responsible tab on the workflow form has an Approve 
Workflow speed button which enables team members to access the web based approval page for that 
specific record. Once the evaluate workflow process has begun this button will be enabled. Highlight 

your team member name and select the Approve speed button . The web based approval page for 
the specific element will appear to authorize/review or reject. 

Reset Element for Re-Evaluation 

If an element has been rejected, the user can select the Reset for Re-Evaluation option to reset the 

workflow for the element .  Once reset, the element can be evaluated again using the Workflow 
function. The email notification that the team members receive has a submission counter to indicate the 
number of times an element has been evaluated. 

Clicking directly on the Reset for Re-Evaluation button will reset the workflow only for the selected team 
member that rejected the element. This can also be done by clicking on the drop down arrow next to the 
Reset for Re-Evaluation speed button, and choosing Reset This Rejected for Re-Evaluation. 

Note: Archived quotes will retain the associated workflow record. 

To reset the workflow for all team members for the element, click on the drop down arrow next to the 
Reset for Re-Evaluation speed button, and choose Reset All Records for Re-Evaluation. 

Reset Workflows 

A confirmation message will appear if changes are made to the quote. The pop up message will only 
display once for the first field a user changes. 
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The message includes Yes and No buttons: 

▪ Yes - Select this to proceed with change and reset workflow to 'Inactive'. The Status field on the 
quote will be updated. 

▪ No - Select this to cancel the change and not reset the workflow. 

Security is available on this form to prevent users from selecting Yes. 

Note: If changes have been made to the quote and a user attempts to mark the workflow active prior to 
recalculating the quote a message will appear stating: "Quote 'xxx' needs to be recalculated before 
activating the workflow". 

Note:  If a user attempts to delete a workflow when the 'Workflow Mandatory' parameter is enabled, 
an error will display stating: "Workflow cannot be deleted while "Workflow Mandatory" parameter is 
enabled." 

 

 
 



Quoting Page 174 of 220 

 

Graphs in Quotations 

Click on the Graphs button to view the quote calculations in a pie chart format. The pie charts are 
based on a percentage breakdown of the calculations for this quote. After selecting Graphs, the 
following screen will appear: 

 

The pie charts display the Material Cost %, Production Cost %,  Other Cost % (Operation Costs), and 
Profit % for each quantity entered under the Rates and Parameters section. 

 To rotate each graph, click on the “red” rotate arrow located in the upper left hand portion of this 
screen. This information is stored with the quote and is available for viewing at any time. 
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Print RFQ 

This option will print a two page print out of the general quote information including labor, material, 
blend details, part information, and the calculation information for the quote currently open. This report 
is hard coded into the system, it is not a Crystal Report and therefore cannot be edited. However, it will 
also create an Excel spreadsheet which is saved in the local home folder in a sub-folder named rfq_print. 
The location where these are saved can be changed by setting the location from the RFQ Print -.xls 

Destination option available from the Miscellaneous menu. Once this option is selected the user will see 
the spreadsheet briefly appear then a Print box will come up to choose the printer to send the report to 
or cancel if a hard copy is not desired. 

Note: If the Control # Format field in System Parameters has been changed (and no longer matches the 
format of the RFQ Control # in the quote), the user will be prompted to recalculate the quote when 
attempting to print the RFQ. 

Note: This feature requires that Microsoft Excel is installed on the computer. If it is not installed when the 
RFQ button is clicked a pop message will display stating "Microsoft Excel is required". 

Note: If there are nine or more calculation quantities the additional quote quantities will spill over to 
additional pages and will not be aligned. To avoid this, you can calculate and print for calculation 
quantities 1 - 8, then do a separate calculate and print for any additional quantities. 

Example RFQ spreadsheet: 
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Quote  Inventory 

The Quote module supports both a Master Inventory file, which is used by the full system, and a Quote 
Inventory file, used only in the quote module. The Quote Inventory file can be based on the Master 
Inventory or it can contain items that are not a part of the Master Inventory. Changes made to items in 
the Quote Inventory will not be mirrored in the Master Inventory. 

New items can be added to the Quote Inventory. These items will not show up in the Master Inventory 
unless you convert a quote that is using one of these items over to a BOM. When a quote is converted to 
a BOM, EnterpriseIQ adds any new item(s) to the Master Inventory. 

To access the Quote Inventory screen, select Miscellaneous|Quote Inventory from the main menu. 

The following functions are available in the Quote Inventory maintenance screen. 

▪ Add- Two options will be available for you to select from--Material and Blend. 

▪ Edit - Select the item from the list that you wish to make changes to and then select File|Edit to bring 
up the following screen. 

▪ Delete - Selecting Delete will bring up a confirmation box with a prompt asking the user to confirm 
the deletion. Click [OK] to remove the item from the Quote Inventory List. 

▪ Search - The user can search for an item using the following methods: Use the pick list, or place your 
cursor in the “Search Quote Inventory” (hyperbrowse search method) field at the top of the Quote 
Inventory Maintenance screen. Type in the Class and the item number and the hyperbrowse will find 
the item. 

Adding Items to the Quote Inventory 

Selecting Material will bring up the following screen: 
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➢ Select the class by clicking on the arrow down button. 

➢ Enter the Item #, Rev, Description, and Extended Description. 

➢ Select the Unit of measurement (i.e. LBS, GAL, KG) from the arrow down list. 

➢ Enter the SPG (specific gravity) and Gauge if desired (class PL items only). 

➢ Click on [OK] and the item will appear in the Quote Inventory List. 

➢ Enter in the Quantity and Price Break information for the item in the fields to the right. 

Note: Items in the quote inventory are not unique. It is possible to have the same item listed multiple 
times in the quote inventory, this is because it has been added to multiple RFQ's. 

Edit Items 

Select the Edit option from the File menu to make changes to an item. Quote Inventory can be marked 
Inactive which will hide it from the lists. Users can use the Show/Hide Inactive toggle button on the 
Quote Inventory screen to show or hide the inactive quote inventory. There is also a toggle button on 
the pick list. If an item in Master Inventory is marked inactive a confirm message will appear asking if the 
user would like to inactivate Quote Inventory as well. If Yes is selected the quote inventory item will be 
marked inactive as well as the master inventory item. If a master inventory item is toggled back to active, 
the quote item is not automatically marked active. If the quote item should be active again users must 
uncheck the box from the Modify Quote Inventory Item form.  

Options 

Under Options on the Quote Inventory Menu Bar, the following options are available: 

▪ Confirm Every Transfer - If checked, when making transfers from Master Inventory to Quote 
Inventory, the user will receive the following prompt “Update Quote Inventory List?” If unchecked, 
the items are moved without the prompt. 

▪ Include Prices with Transfer - If checked, when making transfers from Master Inventory to Quote 
Inventory, the quantity and price break information will transfer with the item. 

▪ Reset Screen - Resets the screen to the default settings. 

Where Used - Right click from the middle section and select Where Used to view a list of RFQ's where the 
highlighted item is used. Right click jump option is available on this form to jump to the highlighted RFQ. 
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Both active and inactive pricing from the Buy/Sell tab in inventory will appear in the Master Inventory 
section, and active and inactive pricing will appear in the Quote Inventory List. To only see active pricing 

select the Hide/Show Inactive button  available in both sections. 

Note: If the 'Use Master Inventory Std Cost for Component Pricing instead of Price Breaks' quote 
parameter is checked the standard cost will be displayed instead of the price breaks. 
 

Adding Blends to the Quote Inventory 

If Blend is selected, the following screen will appear: 
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➢ The class will default to PL and cannot be changed. 

➢ Enter the Item #, Rev, and Description. 

➢ Select the Unit of measurement (i.e. LBS, KG). 

➢ Click on [OK] and the following screen will appear: 
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➢ The system will assign an Operation number and Description to the blend operation and the 

Operation Info tab will be filled in with the Item #, Rev, and Description and Unit entered above. 

➢ Click on the Blended at Work Center check box if the item is to be blended at the work center. 

➢ The user may choose to define the blend based on a Let Down Ratio versus percentages. 

➢ Define the blend operation by clicking on the Materials tab and entering the additives and/or 

raw materials (along with percentages or Let Down ratios) that make up the blend. 

NOTE: The total of the blend percentages for the individual components of the blend must equal 100. 

➢ To calculate pricing for the blend from the individual prices of the components, go to the 
Operation Info tab, click on the Calculate Blend Price Breaks button, and select the component to 

be used as the basis for the price. The price breaks for the blend will then be calculated and 
displayed. 

➢ When finished creating the blend, click on File|Exit. 

 
 

Editing Items in the Quote Inventory 

Select the item from the list that you wish to make changes to and then select File|Edit to bring up the 
following screen. 

 



Quoting Page 182 of 220 

 

Make your changes and press [OK] when finished. 

NOTE: The user can only Edit items in the Quote Inventory list--not in the Master Inventory list. The same 
applies to deleting items. 

 
 

Mass Update Pricing for Quote Inventory 

Users can update Quote Inventory pricing based on a percentage increase or decrease or a flat amount 
with an effective date for specific items. Select Mass Update Pricing from the Options menu. The system 
will calculate the new unit price and update the Quantity Price Breaks in the Quote Inventory 
Maintenance with the new prices. The Price Date field will populate with the current system date/time. 
The Inactive Date for the old pricing will populate with the system date. 
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To update pricing find the item(s) in the list that you would like to change the price breaks on. To find a 
specific item, enter information in the white box at the top of the form based on the sort criteria chosen 
(Item #, Rev, Description, Class, Ext Description). Advanced filtering is also available. Multiple items may 
be selected using the toggle buttons or the Ctrl and Shift buttons on your keyboard. Once the item(s) are 
selected the prices can be changed based on a Percentage or Flat Amount. Select the option and then 
enter the corresponding value. (To enter a decrease put in a negative number). Enter the effective date 
from the drop down calendar and the decimal precision level required (up to six decimals).  

Click on the OK button and the system will calculate the new pricing and update the Quantity Price 
Breaks in the Quote Inventory Maintenance with the new prices.  

 
 

Attached Items Maintenance in Quotes 

Allows the user to create new packaging items, components (inserts), and/or raw material blend 
operations or edit any of the existing operations. This screen defines the operation, shows the materials 
(or components) that will be consumed, and allows the entry of Standard Labor Rates (located under 
Misc). Access this screen from Misc|Attached Items Maintenance and switch between the different types 
of items by selecting View from the menu. Examples of Attached Items Maintenance include: 

▪ Attached Packaging - Review and/or change packaging operations. 

▪ Attached Components - Change the details of attached components operations. 

▪ Blends - Edit blend operations by changing blend percentages, blend components or pricing. 

▪ Process /Std Operation - Edit attached processes or operations by changing the labor rate, the cost 
element or the materials involved. 

 



Quoting Page 184 of 220 

 

Auxiliary Equipment 

Allows the user to set up auxiliary equipment used in the production process, such as dryers, conveyors, 
etc. The auxiliary equipment can have hourly charge rates that will be used in calculating the overhead cost. 
Create Auxiliary Equipment 

Prior to assigning Auxiliary Equipment to a quote, the equipment must be added to the Auxiliary 
Equipment list. To add equipment to the list: 

➢ Select Misc|Auxiliary Equipment from the main menu: 

➢ Place the cursor in the Description column, and enter the description of the equipment. 

➢ Move to the Rate column and enter the hourly charge rate for the equipment. This rate will 
be added to the machine rate and included in production costs. 

➢ Move to the How Many column and enter a number showing how many of these particular 

items are available on the floor. 

➢ To add Additional equipment, click on the Add [+] and enter the details. 

Please see Assigning Auxiliary Equipment for additional information. 

 
 

Work Centers - Access from the Estimating Module 

➢ Select Misc/Work Centers from the main menu: 

➢ Work centers are used to describe the type of equipment used to manufacture the items. 
Examples of work centers may include injection or blow molding machines, extruders, 
assembly tables, pad printers, heat stamping centers, etc. 

NOTE: EnterpriseIQ recommends that work center information be entered into the Work Center module 
prior to creating a quote. 

The user can Add, Edit, Delete, assign RealTime information or assign Cells by selecting this option. 

Entering work centers is discussed in more detail in the work center section. 
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Cloning a Quote 

The cloning feature allows the user to create a duplicate of the quote and then make desired changes. 
This will create a new quote with either the new RFQ# or new revision using the system date as the RFQ 
date. This is excellent for tracking quote revisions, changing cavitation without having to enter all the 
data in again, or for doing “What If?” calculations. All of the information is cloned except the created by 
field does not populate on cloned quotes. 

To CLONE an existing quote: 

➢ From within the Quote module, select File|Clone from the main menu. The following screen 

will appear: 

 

➢ The user can choose to enter a new RFQ# or keep the same RFQ # and create a new 
revision of that quote. The screen will default to display the same RFQ # with the revision 
incremented by one. Either field can be overwritten. Once entered press OK 

➢ When cloning users can choose to include the User Defined Form, Internal Documents, 
External Documents, Notes and Additional Notes by checking the box. 

 
 

Multi-Currency 

If Multi-Currency is enabled, click on the FxRate button  on the Calculations screen to see what the 
values would be in the available currencies. 
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EIQ Bookmark for RFQ 

This option allows the user to drag and drop the icon onto the desktop or a folder in order to open the 

exact RFQ up again with one click. Select the  EIQ Bookmark button then drag it to the desktop or 
folder and drop it. The shortcut will be named QUOTE_id#.eiq by default. 
 

Trace Quote 

Users can utilize the trace option from the General Quote Values tab and the Item Details tab. 

For more information on Trace please see IQTrace Tables for more information. 

 
 

Weight Work Sheet 

To have the system calculate the volume of an item, follow the steps below. 

➢ Click on the Weight Work Sheet button  next to the Item Weight field located on the Item 

Details screen. The following screen will appear: 
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➢ Enter the Specific Gravity (SPG) of the item. The SPG should be available from the 

manufacturing specification sheet for the material. If the item is in master inventory and the 
SPG has been entered on the Additional tab it will fill in automatically with that value. 

➢ Enter in the volume of the item or click on the Volume Work Sheet button next to the Volume 

field to calculate the volume. The following screen will appear: 
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➢ From this form users can build the item using the various shapes within the system and 

specifying each shapes dimensions. 

➢ Select the UOM that the volume will be calculated in by clicking on the arrow down list 
within the UOM field. Select in for cubic inches, cm for cubic centimeters, or mm cubic 
millimeters. 

Adding Shapes 

To add a shape: 

➢ Click on the Add [+] button on the Navigator bar. 

➢ Select a geometric Shape from the arrow down list of shapes. The Custom Volume Value 

option allows the user to add volume values for unknown shapes. 

➢ Select an Operation. Selecting Solid will add a positive value to the total volume and selecting 

Vacuum will subtract a negative value from the total volume. 

➢ Enter the Quantity to calculate how many of the selected shapes to be added to the list. The 

default is one. 

➢ Enter the Shape Dimensions. Depending on the shape of the item, this will include the radius, 

height, wall thickness, width, depth, and/or length. 

➢ Click on the Post/Edit button (the check mark) to add the shape to the list at the bottom of 

the page. 

➢ Type a Description (optional) for the shape in Description field in the table. 

➢ To add additional shapes, click on the Add [+] button on the Navigator bar and repeat the 

above steps. 

➢ Once all entries have been made, click [OK] to exit the Volume Calculator to the Weight 

Worksheet screen and click [OK] again to apply the amount to the Weight field within the 

quote. 

Note: The system remembers the detail data within the Volume Calculator for a given RFQ number. This 
allows the user to view and edit how an item’s volume calculation at any time. 

Editing Shapes 

To edit an existing entry in the volume calculator table: 

➢ Select the record from the list at the bottom of the page. 

➢ Change the values to the new entries and click the Post/Edit button (the check mark). To 

apply the total item volume to the Weight Work Sheet, click on [OK]. 
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➢ Once all changes have been made, click [OK] to exit the Volume Calculator to the Weight 

Worksheet screen and click [OK] again to apply the amount to the Weight field within the 

quote. 

Formulas Used in the Volume Calculator 

The following table defines the formulas used by the EnterpriseIQ Volume Calculator. 

Cone - Hollow R = Radius of Larger Cone 
R2 = Radius of Smaller Cone = R - T 
S = Diameter = R * 2 
S2 = Diameter = R2 * 2 
T = Wall Thickness 
LB = Base area of larger cone = (S * S) * 0.785 
SB = Base area of smaller cone = (S2 * S2) * 0.785 
VolConeL = Volume of larger cone = ((LB / 3) * H)  
VolConeS = Volume of smaller cone = ((SB / 3) * (H-T)) 
H = Height 

Cone - Hollow = (VolConeL - VolConeS) [Difference between two volumes.] 

Cone - Partial D1 = Base Width 
D2 = Top Width 
H = Height 

Cone - Partial = (0.2619 * H) * ((D1 * D1) + (D1 * D2) + (D2 * D2)) 

Cone - Solid H = Height 
R = Radius 
S = Diameter = R * 2 
AB = Area of Base = (S * S) * 0.785 

Cone - Solid = (AB / 3) * H 

Cylinder - Solid R = Radius 
H = Height 
S = Diameter = R * 2 

Cylinder - Solid = ((S * S) * 0.785) * H 

Cylinder - Thru H = Height 
R = Radius 
T = Wall Thickness  
OD = Outside Diameter = R * 2  
ID = Inside Diameter = (R - T) * 2 
OC = Outside Cylinder = ((OD * OD) * 0.785) * H 
IC = Inside Cylinder = ((ID * ID) *0.785) * (H -T) 

Cylinder - Thru = OC - IC [Subtract the volume of the smaller cylinder from the larger 
cylinder.] 
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Cylinder - with Base H = Height 
R = Radius 
T = Thickness 
OD = Outside Diameter = R * 2  
ID = Inside Diameter = (R - T) * 2 
OC = Outside Cylinder  = ((OD * OD) * 0.785) * H 
IC = Inside Cylinder = ((ID * ID) *0.785) * (H -T) 

Cylinder - with Base = OC - IC [Subtract the volume of the smaller cylinder from the larger 
cylinder.] 

Pyramid L = Base Length 
W = Base Width 
H = Height 

Pyramid = = ((L * W) / 3) * H 

Rectangle - Open 
Ended 

L = Length 
W = Width 
D = Depth 
L2 = Inside Length 
W2 = Inside Width 
Rectangle - Open Ended = (L * W * D) - (L2 * W2 * D) 

Rectangle - Solid L = Length 
W = Width 
D = Depth 
Solid Rectangle = (L * W * D) 

Rectangle - Thru L = Length 
W = Width 
D = Depth 
L2 = Inside Length 
W2 = Inside Width 

Rectangle Thru = (L * W * D) - (L2 * W2 * D) 

Rectangle - with 
Base 

L = Length 
W = Width 
D = Depth 
T = Wall Thickness 
T2 = Wall Thickness, Doubled = T * 2 

Rectangle with Base = (L * W * D) - ((L-T2) * (W-T2) * (D-T)) 

Sphere - Hollow R = Radius 
T = Wall Thickness 
S = Diameter of larger sphere = R * 2 
S2 = Diameter of smaller sphere = (R - T) * 2 
VolSphereL = (S * S * S) * 0.524 
VolSphereS = (S2 * S2 * S2) * 0.524 

Sphere - Hollow = (VolSphereL - VolSphereS) [Difference between two volumes.] 

Sphere - Solid R = Radius 
S = Diameter = R * 2 

Sphere - Solid = (S * S * S) * 0.524 
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Torus L = Length (outer radius R) 

R = Radius (inside radius) 

Torus = 2 × 2 × R × r2 

Note: The Volume Calculator is also available from the Options menu. When accessed from the Options 
menu it is used as a volume calculator only and the values are not saved to the current open quote. 
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Main Menu Bar Functions and Speed Buttons 

Menu functions are available across the top of the Quote module. These functions are discussed in the 
following pages. 

File 

Under Quote on the main menu, the following functions are available: 

▪ New - Create a New quote. Clicking on the Add [+] key on the Navigator bar will also perform the 
same function. From New menu item in Quoting users can also convert a quote from a BOM. select 
New->Convert from BOM. There are two options: 'Convert to Quote (Single Level' and 'Convert to 
Quote (Multi Level)'. 

▪ Delete - Delete a quote. Clicking on the Delete [-] key on the Navigator bar will also perform the same 
function. 

▪ Search - “Search” for a particular quote using a pick list. The pick list can be sorted by RFQ#, RFQ 
Description, Date, Rev #, Item Description, Item # or Customer Name. 

▪ Archive - Select this option to Archive the quote. This will allow the user to filter the quotes based on 
Open or Archived. From the Options menu the user can select which type of quotes to view: View All, 
View Open, or View Archived. 

▪ Restore from Archive - This will restore an archived quote back to open status. 

▪ Clone... - This function will create a new quote with the same RFQ # and a new revision or a new 
RFQ#. This can be used for changing cavitation or material without having to reenter all the data, or 
for doing “What If?” calculations. 

▪ Convert to BOM - This function allows the user to convert a quote to a BOM without having to go 
through the Edit Quote section. Please see Converting a  Quote to a BOM for Additional 
information. 

▪ Exit - Closes the Quote Module. 

Options 

Selecting Options, provides the following functions: 

▪ View/Edit Operations - Allows you to view/edit packaging operations, component operations, blends, 
or standard operations/routing.  To choose which view, click on View from the menu and select the 
type of operations you want to see.  Then choose from the pick list the specific operation to 
view/edit. See Attached Items Maintenance in Quotes for more information. 

▪ Display Production Summary - Allows the user to view a Production Summary Report of the quote 
that is currently being viewed. In addition to the RFQ # and Manufacturing #, the fields on the 
Production Summary screen are described below. 

Description Quote Description. 

Revision Quote revision. 

Date Quote date. 
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Expires Quote expiration date. 

Company Customer associated to the quote. 

Commission 
% 

Commission rate percentage. 

Manufacturin
g Type 

Manufacturing Type associated to the quote. 

Manufacturin
g Cell 

Manufacturing Cell associated to the quote. 

Start/Cycles The number of shots required to “dial in” a tool or get an operation up and 
running. 

Lbs/Hr Extrusion MFG Type only.  

Cycle Time The time, measured in seconds, that it takes to make one unit. 

Set Up Hours The number of hours that it will take to prepare work station. 

Wkly Dry Hrs The number of hours that a press will be down due to material drying at the 
press. 

Center Type The work center type that the item is made on. 

For Extrusion MFG Type: Line Size 

Center Rate The cost to operate the work center plus profit and/or markup. 

Operators The number of operators required to run the operation. 

Scrap % The estimated amount of scrap the process will generate. 

Units/Cycle The number of units per cycle. 

Hours/K-
cycles 

The number of hours to complete 1000 cycles. 

Calculation: 

1000 / Cycles per Hour 

Hours/K-
units 

The number of hours to complete 1000 units. 

Calculation:  

(1000 / Units per Cycle) / Cycles per Hour 

Cycle/Hr The number of cycles completed per Hour. 

Calculation: 

3600 / Cycle Time 

Feet/Lb Extrusion MFG Type only. 

Feet/Hr Extrusion MFG Type only. Feet/Lb x Lbs/hr 

Length (ft) Extrusion MFG Type only. (Pt. Length) 
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Inch/Min Extrusion MFG Type only. [((Feet/Lb * 12) * Lbs/Hr)/60] 

Shot Wt(lbs) The shot weight in pounds. 

Calculation: 

((Cav. x Cavity Wt.) + Runner/Sprue). (divide by 453.6 if the weights are in 
grams) 

Lbs/K-cycles The amount of material required to complete 1000 cycles. Used in material 
planning. 

Regrind % Estimated amount of regrind that the process will generate. 
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 Click on the [x] in the upper right hand corner of this screen to exit back to the General Quote 
Value screen. 

▪ Display Calc Parameters - Allows the user to view (from the Calculations screen) the calculation 
parameter information in addition to the calculated values. 

▪ Volume Calculator - The user can estimate the volume of an item using the Volume Calculator. When 
accessed from the Options menu it is used as a volume calculator only and the values are not saved 
to the current open quote. This function can also be accessed from the Item Details screen by clicking 
on the icon next to the Weight field. When accessed from the Item Details tab the information will 
be saved and populate the Volume field on the weight worksheet. Refer to the Weight Work Sheet 
topic for details. 

▪ Engineering Quote Types - This is a list of Quote Types for use in the Workflow module associated to 
Engineering Quotes. 

▪ Do not filter out CRM Customers - This is an option to have the CRM customers appear in the pick list 
when choosing a customer for the quote. If the CRM customer quote is converted to a BOM, the 
CRM customer becomes an active customer and is included in the EnterpriseIQ Customer 
Maintenance module. Note: If this option is not checked a quote for a prospect will appear in the 
pick list but cannot be opened. 

▪ Views - The user can select which types of quotes to view: View All, View Open, or View Archived. 
Based on the selection the pick list and the navigator buttons will only display those quotes 
associated to the type selected. 

▪ User Defined Form - Allows the user to add new fields to a blank, user defined table. A maximum of 
30 new descriptive fields can be established. These fields can then be used in customized reports. 
This is also available from the User Defined Form tab at the bottom of the General Quote Values 
(main form). For information on setting up the user defined form please see User Defined Forms in 
the Setup manual. 

Reports 

Selecting Reports provides the following functions: 

▪ Print - Shows the different reports available for printing. 

▪ Quote Letter - Note: This feature is currently unavailable in this version of WebIQ.  In the desktop 
version this allows the user to create a quote letter using Microsoft Word and save it as a template. 
In order to use this feature, Word must be installed on the workstation you will be printing or 
creating the quote letter from. Please see Printing the Quote Letter for additional information. 

Help Menu 

Contents launches the Help Files. 

About displays version number and date of the EnterpriseIQ system. 
 

Visual Quote Routing 
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The EnterpriseIQ Visual Quote Routing module is a tool which enables the user to create a routing of 
quotes in a more visual way or view existing Quotes visually. This option is very similar to the Routing 
Diagram option available from the items details tab of a BOM except the Visual Quote Routing module 
has add and edit capabilities. 

From this screen the user can create the Quotes for the entire routing process. To create a Quote 
Routing diagram, you start at the end of the process and work your way to the beginning routing steps 
required to make the final item. Once it is created it can be viewed in the original Quote format. 

Overview 

The basis of the EnterpriseIQ Visual Quote Routing module involves creating a routing structure for 
products to be quoted. This module is used to create routing diagrams for repetitive type manufacturing 
processes. 

Below is an example of a Visual Quote Routing diagram: 
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Creating a New Visual Quote Routing 

To create a new Quote Routing diagram go to the Visual Quote Routing speed button on the main 

launcher bar . Click on the New button on the pick list and the following screen will appear: 

                       

From this screen you may choose a Mfg Type and cell you want the Quote assigned to. 

Once a Mfg type (and optionally a cell) has been selected the Quote screen will appear. The work centers 
available will be based on the on the manufacturing type selected. Enter in the Quote information as 
described earlier in this document. 

Once the information is entered, click on the OK button and the Visual Quote Routing screen will appear 
showing a blue box with the basic information regarding the step. Below is an example: 
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This box shows the work center type, RFQ #, a calculated rate per hour based on the cycle time in 
seconds (The calculation is 3600/cycle time in seconds), and the Item #. 

Adding Routing Quote 

To continue creating associated Quote Routing operations, right click and choose Add Routing Quote. 
Choose the Mfg Type and cell (optional) then fill in the fields on the form with the information for the 
step. An unlimited number of Quote Routing steps can be created. 

Other Right Click Options 

▪ New Routing Quote - This options starts the process from the beginning by creating a new top level 
quote. 

▪ Edit Routing Quote- This function brings up the Quote for editing purposes. 

▪ Delete Routing Quote- This function will delete the Quote Routing step you right clicked on and all of 
its attached steps. This only removes the routing step(s) from the diagram it does not delete the 
Quote(s). A pop up screen asking if you are sure will appear. To delete the step, click on the Yes 
button. 

▪ Expand - This right click function opens up the colored box that was right clicked on to show 
additional information about the routing step. In addition to the four fields shown on the non 
expanded box, you will see the Item Description, Parts Per, and Required. 

Under 'Options', Toggle Expanded allows the user the choice to be able to expand multiple windows or 
only one at a time. With this option checked, only one box may be expanded at a time. With this option 
not checked, multiple boxes may be expanded and open at one time. 

▪ Jump to Quote - This function will take you to the Quote screen for the item that was right clicked on. 

Color Coding 

Each type of attached operation/component has a corresponding color associated with the information 
box. 

▪ Blue - represents a BOM / Routing. 

▪ Purple - is the Primary raw material. 

▪ Green - is a Purchased Component. 

▪ Yellow - is a packaging item. 

▪ White - is a purchased component used in a sub-operation. A sub-operation is an operation attached 
to an existing BOM which has been attached to the BOM Routing. If components are attached to this 
sub-operation they will show in white. 

▪ Medium Blue - is an Outsourced BOM. 

▪ Gray - is a Process 

▪ Light Blue - is an Assy Process 

Once a Visual Quote Routing diagram is created, all of the steps are treated like traditional Quotes. All 
additional quoting functions can be done from the traditional quote form. 

Note: When searching in the pick list, if a user is assigned CRM Customer Access in security inspector, 
when accessing the Visual Quote Routing pick list, the customer name field will be blank for records that 
have customers that are NOT assigned to the user. 
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Vendor RFQ 

The Vendor RFQ module allows users to track quote requests to vendors for specific items or equipment. 
A Vendor RFQ can be created/accessed from several areas in the software: Quote Inventory, the 
Attached Materials tab on the Item Details tab of an engineering quote, the AKA Buying tab, the Buying 
section on the Buy/Sell Pricing tab in master inventory, the Projected Exceptions tab in Material 
Exceptions, Maintenance, Repair and Overhaul, and it is an icon the PO/Receiving tab. In all these areas 

the Vendor RFQ form is accessed by selecting the Vendor RFQ speed button .  

When creating a new Vendor RFQ from the PO/Receiving tab the user will first be asked to select the 
Source from the drop down list: 

▪ Master Inventory 

▪ AKA 

▪ Quote  

▪ Quote Inventory 

▪ Material Exception 

▪ Asset Management 

▪ Capital Equipment 

Once the Source is selected the Item or Equipment to be quoted must be selected. For sources except 
Capital Equipment, the item/equipment is chosen from the corresponding pick list accessed by selecting 
the ellipsis button in the Item #/Equipment # field. The pick list is filtered based on the EPlant the user is 
logged into. The Capital Equipment source is used to request RFQ's for new equipment so the Equipment 
and Equipment Description information is manually entered in the pop up form that appears after 
clicking the ellipsis button. 

Upon launching Vendor RFQ for an item from Maintenance, Repair and Overhaul, inventory pricing, AKA 
pricing, or quote inventory, if the item is associated to a vendor RFQ with the same source the system 
will jump to the existing Vendor RFQ. If the item is not already associated to a Vendor RFQ the system 
will display this message: “Unable to find corresponding Vendor RFQ record. Would you like to add a 
new Vendor RFQ?” Select Yes and the Vendor RFQ form will appear with the item information filled in. 
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Vendor RFQ - Main Section Field Listing 

ID  

 

 

This is the Vendor RFQ ID. This will automatically populate with the next sequential ID number. 
This cannot be changed. 

Description This populates with the text ‘Vendor RFQ # ID’ but the user can manually type up to 50 
characters to describe the RFQ. 



Quoting Page 202 of 220 

 

Source This is the source of the Vendor RFQ. This will fill in based on where the Vendor RFQ was 
created from, or if a new Vendor RFQ is created from the main module accessed on the 
PO/Receiving tab, the user will select the source from the drop down list. The Source options 
are: 

▪ Master Inventory 

▪ AKA 

▪ Quote  

▪ Quote Inventory 

▪ Material Exception 

▪ Asset Management 

▪ Capital Equipment 

Note: If a Vendor RFQ is created from within a specific quote from the Attached Materials tab 
or the ‘Currently Attached Materials’ (top section of the Attached Materials, Packaging form), 
the ‘Quote’ source is assigned, and the RFQ will only be visible from that quote. If the Vendor 
RFQ is created from the Quote Inventory List section, or directly from Quote Inventory 
(Miscellaneous menu) it uses ‘Quote Inventory’ as the source, and can be viewed from other 
quotes. 

Note: When a RFQ is created from a Quote the user can expand this field to display the 
Description field which will show the Quote number. For all other sources this field will be 
blank. 

Item or 
Equipment 

This is the Item # or Equipment # associated to the vendor RFQ. When expanded this field will 
also show the item’s Description, Class and Rev, or the Equipment's Description and Class. 

Created On This is the date and time the RFQ was created. This will default to the system date but can be 
changed using the drop down calendar. 

Template A Vendor RFQ Template can be associated to the RFQ. Templates are created from the File 
menu. See below for more details. 

EPlant ID This populates with the EPlant ID the user was logged into when the quote was created. It 
cannot be edited. 

Comment Select the Edit Memo button to enter up to 4000 characters of information related to the 
Vendor RFQ. This information can be printed by selecting the Print speed button on the pop up 
form. 

 

Vendor RFQ Details Section 

Below lists the field information on the Details tab: 

Vendor # This is the vendor number associated to the vendor RFQ. 

If the RFQ is created from the AKA Buying tab in Inventory, all of the vendors on the AKA Buying 
tab will automatically populate this section. 
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Company Vendor Name. 

Date Sent Select the date the Vendor RFQ was sent to the vendor using the drop down calendar. 

 

Date Received Select the date the Vendor RFQ was received from the vendor using the drop down calendar. 

 

Comment Double click on this field to enter up to 4000 characters of information related to the Vendor 
RFQ. This information can be printed by selecting the Print speed button on the pop up form. 

 

Primary/Default This check box is automatically checked for the first Vendor added to the RFQ. It can be 
manually checked to mark a different vendor as the Primary/Default vendor. Only one vendor 
can be marked as the default. This will be checked automatically if the vendor is marked as the 
default in AKA Buying when the vendor RFQ is created from there. 

Vendor Status This is the Vendor Status from the Vendor Maintenance Rating tab. 
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Vendor Distributors 

OEM Vendor distributors can be added to the list of vendors for an item. Select the Distributors button 

 to access a list of OEM vendors and their distributors. A form will appear listing all vendors that 
have been marked as an OEM in Vendor Maintenance. The bottom section will list all of the distributors 
associated to the highlighted OEM vendor. If the OEM vendor is listed in the item's AKA Buying section, 
they will be highlighted in blue.  

 

To add distributors to the Vendor RFQ, highlight the desired vendor and select OK. That vendor's 
distributors will then be listed in the vendor section of the vendor RFQ. 

Price Breaks section 

The lower section displays the prices breaks associated to the highlighted vendor: 

Quantity The quantity associated with the price. 

Price The price of the item at that quantity.  
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Price Date The date the price was created or revised. 

Effective Date The date that this price will be in effect. 

Inactive Date The date when this price will no longer be in effect. 
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Applying Qty/Price Breaks 

The pricing information in this section can be applied to the source by selecting the Apply button . 
This button is only available for the vendor marked as the Primary/Default vendor.  

If the source is Master Inventory or Material Exception when the apply button is selected the price 
breaks from the Vendor RFQ will populate in the Buying section of the Buy/Sell Pricing tab. When the 
source is AKA the prices as well as the vendor information will populate in the AKA Buying tab in master 
inventory. 

If the source is Quote the Apply function will update the quantity price breaks for the attached material 
on the specific quote. When the source is Quote Inventory the pricing will be updated in the Quote 
Inventory List. 

Note: In all cases described above this will overwrite any existing price break information. 

Note: When converting a quote to a BOM if the item is associated to a Vendor RFQ the AKA Buying tab 
will be automatically populated with the vendor(s) and price break(s) from its Vendor RFQ. 

Note: The 'Apply Price Breaks' option does not apply to Asset Management and Capital Equipment source 
RFQs. 

Vendor RFQ Document Tab 

Internal or External documents can be associated to the Vendor RFQ. Select the Add button to attach an 
internal document and then choose Create New or Pick Existing. To attach an external document, click 
on the ADD (+) button and select the Document Library and document from the screens that appear. If 
the document is released it will be accessible from this tab. The user can also jump to the Document 
Control module by clicking on the Launch Document Control speed button. 

Both internal and external documents can be set to print with the Vendor RFQ. This will default to None. 

Email Correspondence 

In addition to documents there is an Email Correspondence tab. From this tab users can to attach Email 
correspondence related to the Vendor RFQ. To add an Email simply drag and drop it from Outlook or 
other email programs into the form. The Received Date will fill in based on the email’s received date and 
time. A Received Date box surfaces if the system is unable to determine the date (such as: The Received 
and Sent dates differ, unclear binary data, or older data, etc.). Users are asked to provide the Received 
Date by selecting the correct date from the calendar. The From and Subject fields will also automatically 
populate with the information from the email. The date, from, and subject fields cannot be edited. A 
comment can be entered by double clicking the field. Enter the comment in the pop up box to further 
describe the email correspondence.  

There are three ways to access the Email once associated to the vendor RFQ:  

▪ Double click on either the Received, From, or Subject fields.  
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▪ Right click and select View email.  

▪ Or select the View email button.  

Note: If the email has attachments, or multiple attachments, the total attachment size cannot be more 
than 4GB. The size allowance might further be limited by the chosen email program used. In order to 
view emails that have attachments, special formatting (e.g. stationary), or images embedded in the body 
of the email, the user must go into BDE Administrator and set the BLOB SIZE to 1000 for the database 
they are using (i.e. IQORA). 

Print Vendor RFQ 

A Vendor RFQ can be printed for all listed vendors or for a specific vendor. The printer speed button in 
the main section on the left will print the RFQ for all vendors. The From and To drop down lists will show 
RFQs from the EPlant the user is logged into and RFQs with no EPlant designation. To print the RFQ for a 
specific vendor, highlight a Vendor, then select the printer speed button in the details section on the 
right side of the form. When printing for a single vendor, the print form will populate the 
vendor_rfq_dtl.id in the From and To fields, and the vendor #. These are read only fields and cannot be 
changed. From either option the user can choose the destination (Printer, Screen, File, Email, or Fax). 
This report is set up in System Parameters->Reports and Forms tab. The default report is called 
VEND_RFQ_REPORT.rpt.  

Add to PO 

From both the vendor and price sections users can right click and select 'Add to PO' to add to an existing 
purchase order based on item/vendor combination or create a new requisition. When a new requisition 
is created from the upper section for a vendor, the line item section will populate with the item details 
but no quantity. Only Vendor RFQs with a source of Inventory or AKA can add items to the PO upon 
conversion.  All other source types will not automatically populate line item information on the PO on 
conversion, items can be added manually after the PO has been created.  

If the new requisition is created from the lower price section, the blanket quantity will fill in based on the 
highlighted quantity and a release will be created for that quantity with the next day as the promise 
date. The Unit Price field will only be populated if the pricing was applied and added to AKA Buying or 
the Buying section of the Buy/Sell Pricing tab. If the System Parameter 'Auto Populate Request & 
Promise Date based on Lead Time' is checked (Purchase Order & Sales Order Setup tab), the system will 
add the item's lead days from the next day's date to determine the promise date. The system looks first 
at AKA lead days when applicable, and if none uses the main item’s lead days. For example, if the lead 
days is 10, when the new PO is created on 9/23 the promise date will be 10/4. 

When adding to an existing PO from the lower section right click option, no additional releases will be 
added. The user will be taken to the PO to manually update it. 
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Vendor RFQ Templates 

Vendor RFQ Templates can be created and then associated to specific Vendor RFQs. The templates 
contain specific quantity break details. When a template is assigned to a vendor RFQ the template’s 
prices breaks can be applied to the vendor RFQ with a button click rather than having to manually enter 
required quantity breaks for each quote. 

To access the Template form, select Templates from the File menu on the Vendor RFQ form. The first 
time this form is accessed it will be blank. 
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Select the insert record (+) button and enter the Name and Description of the template and save the 
record.  

Next enter the quantity breaks and prices in the lower section. An unlimited number of quantity 
breaks/prices can be entered. 

Once templates are created they can be assigned to a Vendor RFQ. 

Assign a Template to a Vendor RFQ 

To assign a template to a Vendor RFQ select the template from the drop down list in the Template field.  

Next click on the 'Apply Template Qtys' button   to populate the quantity section of the form with 
the quantity breaks and prices from the selected template. Select Yes on the confirm message to 
continue. 

(Note: A vendor must be assigned to the Vendor RFQ before a templates quantity breaks can be applied). 
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RFQ Log 

 The RFQ Log module allows the user to maintain the status of all RFQ’s and view them in a 
visually informative manner. The log displays the status details for the tool, primary material, 
components, and packaging using color codes. The log also provides easy maintenance of the In and Out 
Dates as well as due dates for RFQ’s, again shown using color codes to alert the user of quoting 
requirements. 

To access the RFQ Log select the RFQ Log button from the Estimating tab on the main launcher bar. 

 

The form will contain all existing quotes, both open and archived. Below is an alphabetical field listing for 
this module: 

Component 
Status 

This is the current status of the component if applicable. Select the appropriate status from 
the drop down list: 

OK 

Purchasing 

Estimating 

Sales 

This field can also be entered from the RFQ module. 

Customer Name The name of the customer associated to the RFQ. 

Date Due This is the date the quote is due to the customer. This is entered manually using the drop 
down calendar from the RFQ module or the RFQ Log. 
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Date IN This is the In date of the RFQ. This will populate with the Quote date from the RFQ which fills 
in automatically with the date the quote was created. This can be changed by choosing a 
different date from the drop down calendar. 

Date OUT This is the date the quote was sent out. This is entered manually using the drop down 
calendar from the RFQ module or the RFQ Log. 

Follow Up Date This is a manually entered date used to set a follow up date. This is entered using the drop 
down calendar from the RFQ module or the RFQ Log. 

Item # The Item number associated to the RFQ. If the RFQ has more than one item it will be listed in 
the RFQ Log for each item number that is associated to it. 

Item Description The Item description associated to the RFQ. 

Item Type Select the appropriate type for the item from the drop down list next to the field: 

New 

Existing 

Requote 

This field can also be entered from the RFQ module. 

Mfg Type The manufacturing type associated to the quote. 

Note This is the Note field from the quote. Select the ellipsis button in this field to view or edit the 
note. Changes made from the RFQ Log will be visible in the quote module as well. 

Packaging 
Status 

This is the current status of the packaging if applicable. Select the appropriate status from the 
drop down list: 

OK 

Purchasing 

Estimating 

Sales 

This field can also be entered from the RFQ module. 

Primary Material 
Status 

This is the current status of the primary material if applicable. Select the appropriate status 
from the drop down list: 

OK 

Purchasing 

Estimating 

Sales 

This field can also be entered from the RFQ module. 
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Quote Status The status of the quote in regards to acceptance by the customer. Select the quote status 
from the drop down list: 

Pending 

Won 

Lost 

This field can also be entered from the RFQ module. 

Rev This is the revision level of the quote. 

RFQ # The RFQ # is the unique quote tracking number for the quote. 

RFQ Description The RFQ description from the quote. 

Sales Engineer This is the Sales Engineer associated to the RFQ. This is only entered from the RFQ. 

Tool Status This is the current status of the tool. Select the appropriate status from the drop down list: 

OK 

Purchasing 

Estimating 

Engineering 

This field can also be entered from the RFQ module. 

Tool Type Select the appropriate type for the tool from the drop down list next to the field: 

New 

Existing 

Requote 

This field can also be entered from the RFQ module. 

User Quote 
Status 

This is an additional user defined status field. The information is only entered from the Quote.  

Workflow # This field will contain the Workflow # if an Engineering Quote has a workflow associated to it. 

Workflow Quote 
Type 

This is the Quote Type associated to the Quote Workflow. 

Workflow Status This is the status of the quote workflow. The text in the status field is color coded: 

▪ Red - Not Approved 

▪ Blue - Pending 

▪ Green - Approved 

▪ Purple - Inactive 
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Color Codes 

There are color codes associated with the status’ and dates. 

Status Color Codes - The current status can be set for the Tool, Primary Material, Component, and 
Packaging. Each specific status field will be color coded based on the selected status: 

▪ Pink - Estimating 

▪ Green - Sales 

▪ Orange - Engineering & Purchasing 

Date Color Codes - All non status fields will be color coded based on the due date or completion date of 
the RFQ: 

▪ Yellow - The RFQ is due within the next four days. 

▪ Red - The RFQ is due within the next two days or it is overdue. 

▪ Light Blue - The RFQ is due within five days or more. 

▪ Gray - The RFQ has been completed. (The date out field has been filled in). 

Quote Status Color Codes - The quote status field will be color coded based on the selected status: 

▪ Light Green - The quote status is Pending. 

▪ Medium Blue - The quote status is Won. 

▪ Olive Green - The quote status is Lost. 

Workflow Status - This field will be color coded to indicate the status of the workflow: 

▪ Red - Not Approved 

▪ Blue - Pending 

▪ Green - Approved 

▪ Purple - Inactive 

Search 

To search for a specific RFQ select the Search button to access the pick list. Or, first select the desired 
sort column by clicking on the header or by right clicking and selecting the column from the list. Next, 
type the known information corresponding to the sort field in the white box at the top of the form. The 
list will jump to the first record matching the typed information. 

Filter 

The RFQ Log can be filtered based on the Estimating, Engineering, Sales, and Purchasing status’ and/or 
the Quote Status of Pending, Won, Lost, or In Process. To filter the log, right click on the form and select 
the desired filter option. The RFQ Log will only display the quotes that are associated to the selected 
statuses. 

To clear the status, the user must exit the RFQ Log and re-enter it. 

In addition to the right click filter options the Advance Search function is also available by selecting the 
Filter Dataset speed button at the top of the form. (Please see the Advanced Search section for more 
information). 
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Jump to Options 

▪ Jump to Quote - The user can right click or double click a RFQ to jump to the quote. 

▪ Jump to Workflow - Select this right click option to jump to the workflow associated to the 
highlighted record. 

File Menu 

The following options are available from the File menu: 

▪ New - Select this to create a new RFQ. 

▪ Edit - Select this to edit the highlighted RFQ. 

▪ Delete - Select this option to delete the highlighted RFQ. A confirm box will appear for the user to 
confirm or cancel the deletion of the quote. 

▪ Clone - Select this option to clone the highlighted RFQ. This is the same clone functionality described 
earlier in this document. 

▪ Archive - Select this option to archive the highlighted RFQ. A confirm box will appear for the user to 
select Yes or No to continue archiving the quote. 

▪ Convert to BOM - Select this option to convert the highlighted RFQ to a BOM. Please see Converting a 
Quote to a BOM for more information. 

▪ Exit - This will exit the RFQ Log. 
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RFQ Batch Print 

Print Batch 

Select the Batch Print button  to print a hard copy report for a batch of quotes. A form will 
appear to select the quotes to be printed on the batch report. Highlight the quote(s) on the left. Use the 
right arrow button to add them to the Selected Quotes section. Use the left arrow button to remove any 
quotes from the batch. 
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Select the Properties button to associate the batch report and an execute before print option if desired. 
The default report is called Qletter_multi.rpt and can be linked by clicking on the 'reset to default' arrow 
button. A note (up to 4000 characters) can be added using Edit Note button. The note can be printed on 
the report. Once all quotes are selected and a note entered (if desired), select the Print button to print 
the report to the printer. (The report can also be assigned in System Parameters->Reports and Forms to 
‘RFQ Batch’). 

Printing When Workflow is Enabled for Quotes 

Printing the quote letter for an engineering quote with an associated workflow that is not approved is 
not allowed if the user does not have security to select the 'Continue' button.  

A Quote letter cannot be printed under following conditions:  

▪ If workflow mandatory is checked and workflow has not been approved.  

▪ If workflow mandatory is checked and active workflow. 

▪ If workflow mandatory is unchecked and active workflow. 

If the quote letter cannot be printed a form will appear showing the items with unapproved workflows, 
or ones that require a workflow be created. This form will state the status of the workflow which will be 
'Inactive', 'Pending', or 'Required'. If it is 'Required' the Workflow # and the Workflow Status columns will 
display in red. Users can right click and jump to the Engineering Quote or the Workflow associated to the 
highlighted record. Security is available on this form for the Jump To options and the Continue Button. If 
security is not enabled on the Continue button users will not be able to perform the action. This button 
can also be made not visible so users will only see the Cancel button. If Continue is selected, the action 
will be performed, such as printing the quote letter. 

 

Quote letter can be printed under following conditions:  

▪ If workflow mandatory is unchecked and no active workflow 

▪ If workflow mandatory is checked and workflow is approved  
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RFQ Comparison 

Select the drop down arrow next to the Batch Print speed button and select RFQ Comparison. A form will 
appear to select the quotes to be compared on the report. Highlight the quote(s) on the left. Use the 
right arrow button to add them to the Selected Quotes section. Use the left arrow button to remove any 
quotes from the batch.  

 

Select the Properties button to associate the comparison report and an execute before print option if 
desired. The default report is called Quote_Compare.rpt and can be linked by clicking on the 'reset to 
default' arrow button on the properties pop up box. 

A note (up to 4000 characters) can be added using Edit Note button. The note is printed on the default 
report. Once all quotes are selected and a note entered (if desired), select the Print button to print the 
report to the printer.  

(The report can also be assigned in System Parameters->Reports and Forms to ‘RFQ Batch’). 
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